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Revision History

	[bookmark: _Hlk177547550]GUI User Manual
	Below are the development phases and dates of this Prosthetics VistA Suite User Manual.



	Date
	[bookmark: _Hlk177547551]Version
	Description

	10/2024
	RMPR*3.0*216
	Removed the following options from the Utilities Menu:

   PGE  Purge Obsolete Data
        **> Out of order:  (per patch RMPR*3.0*216)

   PCL    Purge Closed Purchasing Transactions
        **> Out of order:  (per patch RMPR*3.0*216)

   PCX    Purge Cancelled Transactions
        **> Out of order:  (per patch RMPR*3.0*216)

   PSU    Purge Suspense Records
        **> Out of order:  (per patch RMPR*3.0*216)

The Purge Obsolete Data [RMPR PURGE MENU] Main Menu will be placed "OUT OF ORDER" and the Purge Aged Purchasing Transactions [RMPR PURGE AGED] will remain as a standalone option under the Utilities [RMPR UTLITIES] menu.


	11/07
	RMPR*3.0*136
	Updated GUI for Excel report saves

	5/07
	RMPR*3.0*75
	RMPR*3.0*75 release

	4/07
	RMPR*3.0*75
	Fixes per EVS
Sections 5 & 6

	3/07
	RMPR*3.0*75
	Fixes per EVS and release of patch 75
Sections 5 & 6

	8/06
	RMPR*3.0*75
	Added OWL Lab section
Section 6: Orthotic Lab & Work Order

	2/06
	RMPR*3.0*75
	Added OWL creation section
Section 5: Creating a Lab Work Order

	1/06
	RMPR*3.0*90
	Updated GUI screens

	9/05
	RMPR*3.0*90
	Minor fixes per EVS

	4/05
	RMPR*3.0*90
	Purchase Card Purchasing

	4/05
	RMPR*3.0*109
	Added a new “Display Custom Data field” feature
NPPD Detail Display User Manual

	1/05
	RMPR*3.0*96
	View Prosthetic Billing Information

	6/03
	RMPR*3.0*59
	Automated Delayed Order Report

	1/03
	RMPR*3.0*71
	NPPD Detail Display User Manual 
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[bookmark: _Toc172537284][bookmark: _Toc177550875]Introduction to Prosthetics Application Suite User Manual
[bookmark: _Toc172537285][bookmark: _Toc177550876]User Manual Overview
	[bookmark: _Hlk177547562]Introduction
	This Prosthetics Application Suite User Manual encompasses past GUI (graphical user interface) patches that provided new and enhanced GUI features for Prosthetics. This user manual will be the main user manual for all future GUI updates.



	[bookmark: _Hlk177547563]In this manual
	This user manual contains the following topics and their corresponding sections:



	[bookmark: _Hlk177547564]Topic
	Section

	Purchase Card Purchasing
	Section 1

	NPPD Detail Display
	Section 2

	Delayed Order Report
	Section 3

	View Billing Information
	Section 4

	Creating a Lab Work Order (OWL)
	Section 5

	Orthotic Lab & Work Order
	Section 6



[bookmark: _Toc172537286]

[bookmark: _Toc177550877][bookmark: _Toc172537287]Section 1: GUI Purchase Card Purchasing
[bookmark: _Toc172537288][bookmark: _Toc177550878]Overview

	[bookmark: _Hlk177547567]Introduction to GUI Purchasing
	Patch RMPR*3*90 is a large Prosthetics patch affecting the Purchase Card Purchasing features. There is a whole new module using GUI (graphical user interface) windows features to create a Purchase Card purchase order. You will no longer be able to use the roll and scroll Purchase Card Menu option.

IMPORTANT: A new feature in GUI Purchasing is that a purchase order cannot be created if the consult (or manual entry in Suspense) is not in an Open or Pending status. 

Note: Reconciling a 1358 purchase order continues as a roll and scroll selection.



	[bookmark: _Hlk177547568]PSAS Menu options
	There are several PSAS Menu options addressed with Patch 90. Here are the current roll and scroll VistA Prosthetics menu options that have been enhanced:

· Purchasing – Purchase Cards Menu Option
· Utilities Menu – Site Parameters option
· Display/Print Menu – Display/Print Patient 2319 (23) option (Appliance Transactions – Screen 4)

Three new roll and scroll menu options include:

· Purchasing Menu – Enter Waiver or Excluded Notice (EW)
· Purchasing Menu – Enter Contract Number (EC)
· Utilities Menu – Display Pros PO Information (WD)



	[bookmark: _Hlk177547569]Transaction Type
	In this GUI Purchase Card Purchasing module with Patch RMPR*3*90, there are no longer four Transaction Types as they have been consolidated into two Types: The four Types were: S – Spare, X – Repair, I – Initial Issue, and R – Replace. This change has consolidated many steps into fewer keystrokes for users. 

The two (2) consolidated Transaction Types are: 

· I – New/Replace
· X – Service/Repair

Note: The Inventory, Home Oxygen and Lab modules still have four (4) Transaction Types.



Continued on next page

Overview, Continued

	[bookmark: _Hlk177547570]SC and NSC Patient Categories
	Also, there used to be four Patient Category options, and this has been consolidated into two options with this patch. The four options were:

1) Service Connected/In-Patient
2) Service Connected/Outpatient
3) Non-Service Connected/In-patient
4) Non-Service Connected/Outpatient

The two NEW Patient Categories are:

1) Service Connected 
2) Non-Service Connected

Note: With this consolidation, there is no need for a Special Category which had four options for you to choose when you selected the Patient Category of Non-Service Connected/Outpatient option.



	[bookmark: _Hlk177547571]Printed Purchase Order
	The full social security number is not displayed on the printed purchase order; only the last four numbers on Form 2421. The purchase order number now appears on the top of this form. Also, the Lot number, Serial number, Make and Model appear on the purchase order (as appropriate).



	[bookmark: _Hlk177547572]The Purchase Order Control Window
	The Purchase Order Control window shown below displays consults from the Suspense module that have been entered through CPRS or entered manually. Open and Pending consults display here for one site or “All Sites” as well as a Purchasing Agent’s responsible SSN range for patients.

[image: Purchase Order Control window]



[bookmark: _Toc172537289]

[bookmark: _Toc177550879]Chapter 1 – Roll and Scroll Features
[bookmark: _Toc172537290][bookmark: _Toc177550880]Patch RMPR*3*90 Overview

	[bookmark: _Hlk177547573]New and deleted features
	There are new Roll and Scroll features with Patch RMPR*3*96 as well as updated features and features no longer needed.



	[bookmark: _Hlk177547574]Purchasing Menu - Purchase Cards
	The Purchase Cards option (under the Purchasing Menu (PU) and the Enter New Request (EN) option) are no longer needed in roll and scroll and cannot be used any longer. 

The new GUI Purchase Order process is outlined in this user manual and has been developed to replace the roll and scroll process. There have been many features added within this process as well.



	[bookmark: _Hlk177547575]Purchasing Menu
	The new menu options in the Purchasing Menu include:

· Enter Waiver or Excluded Notice (EW)
· Enter/Edit Contract Number (EC)



	[bookmark: Link_216_1][bookmark: _Hlk177547576]Utilities Menu
	The Site Parameters file has been updated in the Utilities Menu with several new features and prompts. The enhanced option is the Enter/Edit Site Parameters (SP) option. You will then select the Enter/Edit Station Site Parameters (SS) option.

Also, there is a new menu option, Display Pros PO Information (WD) for display purposes only.

The VHA Business office for Prosthetics requested that the following menu options have been placed "OUT OF ORDER" with the release of RMPR*3.0*216:

[bookmark: PGE_216]   PGE  Purge Obsolete Data
             **> Out of order:  (per patch RMPR*3.0*216)
[bookmark: PCL_216]   PCL    Purge Closed Purchasing Transactions
             **> Out of order:  (per patch RMPR*3.0*216)
[bookmark: PCX_216]   PCX    Purge Cancelled Transactions
             **> Out of order:  (per patch RMPR*3.0*216)
[bookmark: PSU_216]   PSU    Purge Suspense Records
             **> Out of order:  (per patch RMPR*3.0*216)

The Purge Obsolete Data [RMPR PURGE MENU] Main Menu will be placed "OUT OF ORDER" and the Purge Aged Purchasing Transactions [RMPR PURGE AGED] option will remain as a standalone option under the Utilities [RMPR UTILITIES] menu.

Annual purging of the Prosthetics 1358 File #664 where an order will be deleted if previously purged from the IFCAP Procurement & Accounting Transactions File #442. The purge criteria will be guided by the same purge criteria used for IFCAP Annual Purging where the order information is kept for the previous 8 years.

For further guidelines, please visit PROSTHETIC & SENSORY AIDS SERVICE (10P4RK) - Business Practice Guidelines (BPGs) and Standard Operating Procedures (SOPs) - All Documents (sharepoint.com)




	[bookmark: _Hlk177547577]Display/Print 2319
	There are two new display fields on the Display/Print Patient 2319 (in the Appliance Transaction – Screen 4) as follows:

· Contract Number
· Excluded Waiver


[bookmark: _Utilities_Menu_–][bookmark: _Toc172537291][bookmark: _Toc177550881]
Utilities Menu – Site Parameters File

	[bookmark: _Hlk177547578]Site Parameters file
	You must first set up the Site Parameters file to set up your Purchasing Agent information including their name and SSN range of responsibilities before they can begin to use the GUI Purchase Order feature. This is also where the Common Numbering Series (number that is created for the PO process) and the new Manager Comment is updated.

To access this file, select the Utilities Menu (UT) and the Enter/Edit Site Parameters (SP) option.

Note: This file can be updated when a Purchasing Agent is on vacation, sick or for any temporary purposes to transfer the SSN range of responsibilities to another Purchasing Agent.



	[bookmark: _Hlk177547579]Prosthetic Official’s Menu
	  PU   Purchasing ...
  DD   Display/Print ...
  UT   Utilities ...
  AM   AMIS ...
  SU   Suspense ...
  CO   Correspondence ...
  SC   Scheduled Meetings and Home/Liaison Visits ...
  PS   Process Form 2529-3 ...
  EL   Eligibility Inquiry
  ET   PSC/Entitlement Records ...
  HO   Home Oxygen Main Menu ...
  INV  Pros Inventory Main ...
  ND   NPPD Tools ...
  VR   VERIFY/REPAIR PURCHASE CARD NUMBER

Select Prosthetic Official's Menu Option: UT Utilities



	[bookmark: Utilities_Menu][bookmark: _Hlk177547580]Utilities Menu
	  AP   Add/Edit Patient to Prosthetics
  DIS  Enter Prosthetic Disability Code to 2319
  REM  Delete Prosthetic Disability Code from 2319
  EN   Enter/Edit Prosthetic Item Master
  IF   IFCAP Utilities ...
  RC   Flag Item as Returned/Condemned
  RE   Edit Returned/Condemned Item
[bookmark: PAG_Link][bookmark: SaveExcel]  PAG  Purge Aged Purchasing Transactions
  FCLN  RMPR file cleansing for field lengths
  SP   Enter/Edit Site Parameters ...
  WD   Display Prosthetic PO Information
[bookmark: PGE_LINK25][bookmark: OLE_LINK25]  PGE  Purge Obsolete Data
   **> Out of Order: (per patch RMPR*3.0*216)


Select Utilities Option: SP <Enter> Enter/Edit Site Parameters



Utilities Menu – Site Parameters File, Continued

	[bookmark: _Hlk177547581]Next step
	Select the Enter/Edit Station Site Parameters (SS) option as shown below. 



	[bookmark: _Hlk177547582]Enter/Edit Site Parameters option
	  SS   Enter/Edit Station Site Parameters
  RF   Set CPT Modifier Rental Flag

Select Enter/Edit Site Parameters Option: SS <Enter> Enter/Edit Station Site Parameters

Select PROSTHETICS SITE PARAMETER SITE NAME: 

   ATLANTA VAMC                 508
   CORKWELL VAMC                500
   HINESTEST                  999
   Hines Development System2          ST. NUM. 578
   SAN ANTONIO VAMC               671
   ZZOJ VAMC VAMC                991
 Answer with INSTITUTION NAME, or STATUS, or STATION NUMBER, or OFFICIAL VA NAME, or CURRENT LOCATION, or CODING SYSTEM/ID PAIR, or NAME (CHANGED FROM), or CODING SYSTEM


 Do you want the entire INSTITUTION List? Y <Enter> (Yes)
  Choose from:
  ALBANY, NY                500 
  ALBUQUERQUE, NM              501 
  ALBUQUERQUE-RO       NM      340 
  ALEXANDRIA, LA              502 
  ALLEN PARK, MI       MI      553 
  ALTOONA, PA                503 
        ^

Select PROSTHETICS SITE PARAMETER SITE NAME: 500 <Enter> ALBANY, NY



	[bookmark: _Hlk177547583]Printer
	You also need to know the name of your printer to set it up in the Site Parameters file. This must be defined and cannot be entered as “null” as it must be a Prosthetic printer.



Continued on next page

Utilities Menu – Site Parameters File, Continued

	[bookmark: _Hlk177547584]Manager Comment (NEW FEATURE)
	Notice the new Manager Comment prompt below. You can enter a free-text comment that will display on the GUI Purchase Order Control window at the bottom of the display. This can be used by Supervisors to make announcements or specific messages to their responsible groups.



	[bookmark: _Hlk177547585]Site Parameters file

NEW Prompt
	VAMC 500  COR
KWELL VAMC
SITE NAME: CORKWELL VAMC// 
VISN: 17// 
PHONE NUMBER: 
STREET ADD1: // 
CITY: SAN ANTONIO// 
STATE: TEXAS// 
ZIP CODE: 78249// 
MANAGER COMMENT: "Please enter your time today." <Enter>

CHIEF SIG BLOCK: PROSmanager,one,ACTING CHIEF,PROSTHETICS SERVICE
      Replace Y <Enter> ?? Replace 
Select PURCHASING AGENT: PROSpurchagent,one // 
 PURCHASING AGENT: PROSpurchagent,one// 
 START RANGE: 0// 
 STOP RANGE: 99// 




[bookmark: _Utilities_Menu_–_1][bookmark: _Hlk177553210][bookmark: OLE_LINK26][bookmark: _Toc172537292][bookmark: _Toc177550882]
Utilities Menu – Display Prosthetic PO Information (WD)

	[bookmark: _Hlk177547586]Display PO Information (WD)
	With Patch RMPR*3*90, you can display purchase order information with the new option from the Utilities Menu called Display Prosthetic PO Information (WD). This will display purchase order information that does not contain patient name or sensitive information.



	[bookmark: _Hlk177547587]Display Prosthetic PO Information (WD)
	[bookmark: _Hlk177553216]  PU   Purchasing ...
[bookmark: _Hlk177553217]  DD   Display/Print ...
[bookmark: _Hlk177553218]  UT   Utilities ...
[bookmark: _Hlk177553219]  AM   AMIS ...
[bookmark: _Hlk177553220]  SU   Suspense ...
[bookmark: _Hlk177553221]  CO   Correspondence ...
[bookmark: _Hlk177553222]  SC   Scheduled Meetings and Home/Liaison Visits ...
[bookmark: _Hlk177553223]  PS   Process Form 2529-3 ...
[bookmark: _Hlk177553224]  EL   Eligibility Inquiry
[bookmark: _Hlk177553225]  ET   PSC/Entitlement Records ...
[bookmark: _Hlk177553226]  HO   Home Oxygen Main Menu ...
[bookmark: _Hlk177553227]  INV  Pros Inventory Main ...
[bookmark: _Hlk177553228]  ND   NPPD Tools ...
[bookmark: _Hlk177553229]  VR   VERIFY/REPAIR PURCHASE CARD NUMBER

[bookmark: _Hlk177553230]Select Prosthetic Official's Menu Option: UT <Enter> Utilities

[bookmark: _Hlk177553231]  AP   Add/Edit Patient to Prosthetics
[bookmark: _Hlk177553232]  DIS  Enter Prosthetic Disability Code to 2319
[bookmark: _Hlk177553233]  REM  Delete Prosthetic Disability Code from 2319
[bookmark: _Hlk177553234]  EN   Enter/Edit Prosthetic Item Master
[bookmark: _Hlk177553235]  IF   IFCAP Utilities ...
[bookmark: _Hlk177553236]  RC   Flag Item as Returned/Condemned
[bookmark: _Hlk177553237]  RE   Edit Returned/Condemned Item
[bookmark: Link_216]  PAG  Purge Aged Purchasing Transactions
[bookmark: _Hlk177553238][bookmark: _Hlk177553239]  FCLN  RMPR file cleansing for field lengths
[bookmark: _Hlk177553240]  SP   Enter/Edit Site Parameters ...
[bookmark: _Hlk177553241]  WD   Display Prosthetic PO Information
      Purge Obsolete Data
        **> Out of Order: (per patch RMPR*3.0*216)

[bookmark: _Hlk177553242]Select Utilities Option: WD <Enter> Display Prosthetic PO Information

[bookmark: _Hlk177553243]Select PROSTHETICS 1358 DATE:  2-15-2005          EYEGLASSES-PRES

[bookmark: _Hlk177553244]DEVICE: <Enter> INCOMING TELNET  Right Margin: 80// <Enter>
[bookmark: _Hlk177553245]Prosthetics Display              MAR 10,2005 09:18  PAGE 1
[bookmark: _Hlk177553246]------------------------------------------------------------------------------

[bookmark: _Hlk177553247]Deliver To: OTHER LOCATION AT THIS SITE   IFCAP Order: 516-0U7820

[bookmark: _Hlk177553248]Vendor: INVACARE

[bookmark: _Hlk177553249]Initiator: PROSDEVELOPER,ONE

[bookmark: _Hlk177553250]Station Name: BAY PINES VAMC

[bookmark: _Hlk177553251]Item: EYEGLASSES-PRESCRIPTION

[bookmark: _Hlk177553252]Brief Description: EYEGLASSES

[bookmark: _Hlk177553253]Unit Cost: 25.00   Qty: 1   Unit of Issue: EA
[bookmark: _Hlk177553254]Eyeglasses, Prescription 

Select PROSTHETICS 1358 DATE:


[bookmark: _Hlk177553255][bookmark: _Toc172537293][bookmark: _Toc177550883]
Purchasing Menu – Enter Waiver or Excluded Notice (EW)

	[bookmark: _Hlk177547588]Definitions
	[bookmark: _Hlk177553256]The Enter Waiver or Excluded Notice (EW) option is from the Purchasing (PU) Menu. You can use this menu option if you forget to enter this information during the creation of the purchase order. 

A Waiver is a device/vendor that is not on a National Prosthetics Mandatory BPA/Contract and is prescribed because it meets the needs of an individual patient. (The prescribing physician requests in writing to the Chief of Staff and if approved, a copy is forwarded to the VPR.) Excluded means that an Item (HCPCS) issued is not covered by a National Prosthetics Mandatory BPA/Contract.



	[bookmark: _Hlk177547589]Prosthetic Official’s Menu
	[bookmark: _Hlk177553257]  PU   Purchasing ...
[bookmark: _Hlk177553258]  DD   Display/Print ...
[bookmark: _Hlk177553259]  UT   Utilities ...
[bookmark: _Hlk177553260]  AM   AMIS ...
[bookmark: _Hlk177553261]  SU   Suspense ...
[bookmark: _Hlk177553262]  CO   Correspondence ...
[bookmark: _Hlk177553263]  SC   Scheduled Meetings and Home/Liaison Visits ...
[bookmark: _Hlk177553264]  PS   Process Form 2529-3 ...
[bookmark: _Hlk177553265]  EL   Eligibility Inquiry
[bookmark: _Hlk177553266]  ET   PSC/Entitlement Records ...
[bookmark: _Hlk177553267]  HO   Home Oxygen Main Menu ...
[bookmark: _Hlk177553268]  INV  Pros Inventory Main ...
[bookmark: _Hlk177553269]  ND   NPPD Tools ...
[bookmark: _Hlk177553270]  VR   VERIFY/REPAIR PURCHASE CARD NUMBER

Select Prosthetic Official's Menu Option: PU <Enter> Purchasing



	[bookmark: _Hlk177547590]Purchasing Menu
	[bookmark: _Hlk177553271]  EN   Enter New Request ...
[bookmark: _Hlk177553272]  SI   Stock Issues ...
[bookmark: _Hlk177553273]  RP   Reprints ...
[bookmark: _Hlk177553274]  RE   Record 2237 Purchase to 2319
[bookmark: _Hlk177553275]  ED   Edit/Delete 2237 from 10-2319
[bookmark: _Hlk177553276]  EC   Enter Contract # and FPDS
[bookmark: _Hlk177553277]  CA   Cancel a Transaction
[bookmark: _Hlk177553278]  CO   Close Out
[bookmark: _Hlk177553279]  CPC  Cancel Purchase Card Transaction
[bookmark: _Hlk177553280]  CPO  Reconcile/Close Out Purchase Card Transaction
[bookmark: _Hlk177553281]  ED2  Edit 2319
[bookmark: _Hlk177553282]  EDPC  Edit Purchase Card Transaction
[bookmark: _Hlk177553283]  ER   Enter Product Information for Recall
[bookmark: _Hlk177553284]  EW   Enter Waiver or Excluded Notice
[bookmark: _Hlk177553285]  HI   Add Historical Data
[bookmark: _Hlk177553286]  HID  Delete Historical Data Entry
[bookmark: _Hlk177553287]  LI   List Open 1358 Prosthetic Transactions
[bookmark: _Hlk177553288]  LII  List Open 1358 Transactions By Initiator
[bookmark: _Hlk177553289]  LPC  List Open Purchase Card Transactions
[bookmark: _Hlk177553290]  LPCI  List Open Purchase Card Transactions By Initiator
[bookmark: _Hlk177553291]  LPS  Purchase Card Summary Sheet
Select Purchasing Option: EW <Enter> Enter Waiver or Excluded Notice


[bookmark: _Hlk177553293][bookmark: _Hlk177553292]
Purchasing Menu – Enter Waiver or Excluded Notice (EW), Continued

	[bookmark: _Hlk177547591]The 2319
	[bookmark: _Hlk177553294]The Waiver or Excluded information appears on the 2319. 

Note: This new feature works for any Inventory/Stock Issues items as well. 



	Enter Waiver or Excluded Notice
	[bookmark: _Hlk177553295]Enter Patient Name or PO Number  1-27-2005 ITEM DES
[bookmark: _Hlk177553296]     ...OK? Yes// <Enter> (Yes)

[bookmark: _Hlk177553297]Patient Name: PROSpatient,one  <Enter>
[bookmark: _Hlk177553298]Form: VISA
[bookmark: _Hlk177553299]Transaction #: 0U7748
[bookmark: _Hlk177553300]Brief Desc: ITEM DES
[bookmark: _Hlk177553301]PSAS HCPCS: E2100
[bookmark: _Hlk177553302]Item: WHEELCHAIR-H2000-18IN-ELEV
[bookmark: _Hlk177553303]Vendor: SUN BRAND
[bookmark: _Hlk177553304]Initiator: PROSdeveloper,one

[bookmark: _Hlk177553305]EXCLUDE/WAIVER: ? <Enter>
[bookmark: _Hlk177553306]   Choose from: 
[bookmark: _Hlk177553307]    E    EXCLUDED
[bookmark: _Hlk177553308]    W    WAIVER
[bookmark: _Hlk177553309]EXCLUDE/WAIVER: E <Enter> EXCLUDED

Enter Patient Name or PO Number <Enter>



[bookmark: _Hlk177553310][bookmark: _Toc172537294][bookmark: _Toc177550884]
Purchasing Menu – Enter/Edit Contract # (EC)

	[bookmark: _Hlk177547593]Enter/Edit Contract Number
	[bookmark: _Hlk177553311]The Enter/Edit Contract Number (EC) option allows you to enter a new Contract number on the 2319 or edit an existing one. This menu option is a free-text field and you can enter any free-text. 

Note: The Contract # has a maximum of 30 characters allowed in this prompt.



	[bookmark: _Hlk177547594]Purchasing Menu
	[bookmark: _Hlk177553312]  EN   Enter New Request ...
[bookmark: _Hlk177553313]  SI   Stock Issues ...
[bookmark: _Hlk177553314]  RP   Reprints ...
[bookmark: _Hlk177553315]  RE   Record 2237 Purchase to 2319
[bookmark: _Hlk177553316]  ED   Edit/Delete 2237 from 10-2319
[bookmark: _Hlk177553317]  EC   Enter/Edit Contract #
[bookmark: _Hlk177553318]  CA   Cancel a Transaction
[bookmark: _Hlk177553319]  CO   Close Out
[bookmark: _Hlk177553320]  CPC  Cancel Purchase Card Transaction
[bookmark: _Hlk177553321]  CPO  Reconcile/Close Out Purchase Card Transaction
[bookmark: _Hlk177553322]  ED2  Edit 2319
[bookmark: _Hlk177553323]  EDPC  Edit Purchase Card Transaction
[bookmark: _Hlk177553324]  ER   Enter Product Information for Recall
[bookmark: _Hlk177553325]  EW   Enter Wavier or Excluded Notice
[bookmark: _Hlk177553326]  HI   Add Historical Data
[bookmark: _Hlk177553327]  HID  Delete Historical Data Entry
[bookmark: _Hlk177553328]  LI   List Open 1358 Prosthetic Transactions
[bookmark: _Hlk177553329]  LII  List Open 1358 Transactions By Initiator
[bookmark: _Hlk177553330]  LPC  List Open Purchase Card Transactions
[bookmark: _Hlk177553331]  LPCI  List Open Purchase Card Transactions By Initiator
[bookmark: _Hlk177553332]  LPS  Purchase Card Summary Sheet

Select Purchasing Option: EC <Enter> Enter/Edit Contract # on 2319



	Enter Contract # 
	[bookmark: _Hlk177553333]Enter Patient Name or PO Number  1-27-2005 ITEM DES
[bookmark: _Hlk177553334]     ...OK? Yes// <Enter>  (Yes)

[bookmark: _Hlk177553335]Patient Name: PROSpatient,one  <Enter>
[bookmark: _Hlk177553336]Form: VISA
[bookmark: _Hlk177553337]Transaction #: 0U7748
[bookmark: _Hlk177553338]Brief Desc: ITEM DES
[bookmark: _Hlk177553339]PSAS HCPCS: E2100
[bookmark: _Hlk177553340]Item: WHEELCHAIR-H2000-18IN-ELEV
[bookmark: _Hlk177553341]Vendor: SUN BRAND
[bookmark: _Hlk177553342]Initiator: PROSdeveloper,one

[bookmark: _Hlk177553343]CONTRACT #: ? <Enter>
[bookmark: _Hlk177553344]   Answer must be 1-30 characters in length.

[bookmark: _Hlk177553345]CONTRACT #: 123ABC  <Enter>

Enter Patient Name or PO Number 


[bookmark: _Hlk177553346][bookmark: _Toc172537295][bookmark: _Toc177550885]
Display/Print Patient 2319 (23) – Excluded and Waiver

	[bookmark: _Hlk177547596]Excluded and Waiver prompts
	With Patch RMPR*3*90, there are two new prompts on the 2319: Excluded and Waiver. You can display and print the 2319 from the Display/Print (DD) Menu (accessed from the Prosthetics Official’s Menu) to update the Excluded or Waiver prompts on the 2319. Follow the sequence of prompts below to display or print the 2319.



	[bookmark: _Hlk177547597]Display/Print Patient 2319
	[bookmark: _Hlk177553347]Select Display/Print Option: 23 <Enter> Display/Print Patient 2319

[bookmark: _Hlk177553348]SITE: DVAMC BAY PINES 516/121//     <Enter>     516

[bookmark: _Hlk177553349]Select PROSTHETIC PATIENT: PROSpatient,one <Enter>    5-28-
[bookmark: _Hlk177553350]25  000277955   NO   NSC VETERAN      B    B   PC NORTH PINELLAS
[bookmark: _Hlk177553351] Enrollment Priority: GROUP 8c  Category: IN PROCESS  End Date: 
[bookmark: _Hlk177553352]     BAY PINES VAMC   
[bookmark: _Hlk177553353]DEVICE: HOME//<Enter>  INCOMING TELNET  Right Margin: 80// <Enter>

[bookmark: _Hlk177553354]Current Disability Codes are: 

[bookmark: _Hlk177553355]AO/DIS     OTHERS ELIG  NSC  PL-104-262 (ELIG. REFORM
AO/ELAS    OTHERS ELIG  NSC  PL-104-262 (ELIG. REFORM



	[bookmark: _Hlk177547598]Appliance Transactions (Screen 4)
	[bookmark: _Hlk177553356]   Select one of the following:

[bookmark: _Hlk177553357]     1     PATIENT DEMOGRAPHICS
[bookmark: _Hlk177553358]     2     CLINIC ENROLLMENTS/CORRESPONDENCE
[bookmark: _Hlk177553359]     3     ENTITLEMENT INFORMATION
[bookmark: _Hlk177553360]     4     APPLIANCE TRANSACTIONS
[bookmark: _Hlk177553361]     5     AUTO ADAPTIVE INFORMATION
[bookmark: _Hlk177553362]     6     CRITICAL COMMENTS
[bookmark: _Hlk177553363]     7     ADD/EDIT DISABILITY CODE
[bookmark: _Hlk177553364]     8     HOME OXYGEN ITEMS

Enter 10-2319 screen to VIEW (1-8),'^' to EXIT, or 'return' to continue : 4 <Enter> APPLIANCE TRANSACTIONS



[bookmark: _Hlk177553365]Continued on next page
[bookmark: _Hlk177553367][bookmark: _Hlk177553366]
Display/Print Patient 2319 (23) – Excluded and Waiver, Continued

	[bookmark: _Hlk177547599]New Display fields
	[bookmark: _Hlk177553368]Below you can see the two new display fields on the Display/Print Patient 2319: 

· [bookmark: _Hlk177553369]Contract Number
· Excluded Waiver



	[bookmark: _Hlk177553370][bookmark: _Hlk177547600]Appliance/ Repair Record for a Veteran



New display fields here:
	[bookmark: _Hlk177553371]PROSpatient,one     SSN: 000-27-7955  DOB: MAY 28,1925  CLAIM# 
[bookmark: _Hlk177553372] Date  Qty  HCPCS  Type Vendor   Sta Serial Delivery Date Tot Cost

[bookmark: _Hlk177553373]1. 01/27/05 2  BLOOD GLUC  R SUN BRAND  516            24.00 
[bookmark: _Hlk177553374]2. 01/24/05 2  PLNR BACK  I INVACARE  516            20.00 
[bookmark: _Hlk177553375]  REMARK
[bookmark: _Hlk177553376]3. 02/06/04 1  WHO, WRIST  I EBI MEDICA 516 2022-14  02/06/04   7.73 
[bookmark: _Hlk177553377]  RIGHT MEDIUM ISSUED 12-16-04
[bookmark: _Hlk177553378]4. 02/06/04 1  WHO, WRIST  I EBI MEDICA 516 2022-24  02/06/04   7.73 
[bookmark: _Hlk177553379]  LEFT MEDIUM ISSUED 12-16-04
[bookmark: _Hlk177553380]5. 03/10/03 2  ELASTIC SU  I SURGICAL A 516 8868LG  03/10/03  19.78 
[bookmark: _Hlk177553381]  ISS 2-21-03 1PR TRUFORM AK 8868 LG
[bookmark: _Hlk177553382]6. 02/19/03 1  AUTO BLOOD  I MEDICAL PL 516      02/19/03  29.70 
[bookmark: _Hlk177553383]  MAILED BP KIT

[bookmark: _Hlk177553384]End of Appliance/Repair records for this veteran!
[bookmark: _Hlk177553385]+=Turned-In *=Historical Data I=Initial X=Repair S=Spare R=Replacement
[bookmark: _Hlk177553386]Enter 1-6 to show full entry, '^' to exit or `return` to continue. 1 <Enter>


[bookmark: _Hlk177553387]PROSpatient,one    SSN: 000-27-7955  BAY PINES VAMC   DOB: 05-28-1925
[bookmark: _Hlk177553388]          APPLIANCE/REPAIR LINE ITEM DETAIL         <4-1>

[bookmark: _Hlk177553389]TYPE OF FORM: VISA    INITIATOR: PROSdeveloper,one DATE: JAN 27, 2005
[bookmark: _Hlk177553390]DELIVER TO: VETERAN
[bookmark: _Hlk177553391]TYPE TRANS: REPAIR      QTY: 2  SOURCE: COMMERCIAL
[bookmark: _Hlk177553392]VENDOR TRACKING:           BANK AUTHORIZATION: 
[bookmark: _Hlk177553393]VENDOR:    SUN BRAND
[bookmark: _Hlk177553394]VENDOR PHONE: 404-455-0664
[bookmark: _Hlk177553395]        3900 GREEN INDUSTRIAL WAY
[bookmark: _Hlk177553396]        ATLANTA,  GEORGIA   30341
[bookmark: _Hlk177553397]DELIVERY DATE: 
[bookmark: _Hlk177553398]TOTAL COST: $24.00      OBL: 0U7748
[bookmark: _Hlk177553399]REMARKS:    
[bookmark: _Hlk177553400]DISABILITY SERVED: NSC
[bookmark: _Hlk177553401]ITEM DESCRIPTION: WHEELCHAIR-H2000-18IN-ELEV
[bookmark: _Hlk177553402]APPLIANCE: WHEELCHAIR-H2000-18IN-ELEV
[bookmark: _Hlk177553403]CONTRACT #: 123ABC
[bookmark: _Hlk177553404]EXCLUDED/WAIVER: EXCLUDED
[bookmark: _Hlk177553405]PSAS HCPCS: E2100   BLOOD GLUCOSE MONITOR W VOICE
[bookmark: _Hlk177553406]ICD-9 Code: 
[bookmark: _Hlk177553407]CPT MODIFIER: 
[bookmark: _Hlk177553408]DESCRIPTION: ITEM DES
[bookmark: _Hlk177553409]EXTENDED DESCRIPTION: 

Enter RETURN to continue or '^' to exit: <Enter>



[bookmark: _Hlk177553410]
[bookmark: _Toc172537296][bookmark: _Hlk177553411]Chapter 2 – Access/Sign-on Instructions to GUI
[bookmark: _Toc42397894][bookmark: _Toc163546929][bookmark: _Toc177550886][bookmark: _Hlk177553412]Open the Prosthetics Main Menu

	[bookmark: _Hlk177547601]Introduction
	[bookmark: _Hlk177553413]Introducing the Prosthetics Main Menu window, as shown below. This feature was first included in Patch RMPR*3*90. It will grow as more features are developed in the GUI suite of Prosthetics programs as part of an entire VistA suite of Prosthetics programs. It will remain the main point of access for future Prosthetics applications. This window allows you to access the current GUI features including the following:

· [bookmark: _Hlk177553414]VistA Sign-On
· [bookmark: _Hlk177553415]Processing (formerly Purchasing)
· [bookmark: _Hlk177553416]View Prosthetic Billing Information
· [bookmark: _Hlk177553417]Delayed Order Report 
· [bookmark: _Hlk177553418]NPPD Detail Display Report
· [bookmark: _Hlk177553419]Orthotic Lab & Work Order (OWL)
· [bookmark: _Hlk177553420]Help
· About (provides the version number of the application)



	[bookmark: _Hlk177547602]Prosthetics Main Menu
	[image: Prosthetics Main Menu]



[bookmark: _Hlk177553422][bookmark: _Hlk177553421]
Open the Prosthetics Main Menu, Continued

	[bookmark: _Hlk177547603]Steps
	To sign on to VistA and access the Prosthetics applications, follow these steps:



	[bookmark: _Hlk177553423][bookmark: _Hlk177547604]Step
	Action

	[bookmark: _Hlk177553424]1
	[bookmark: _Hlk177553425]For Prosthetics users: Double-click the Prosthetics Vista Suite which is the medicine bag icon on your desktop.

(For Billing Users: Double-click the Prosthetics View Billing Menu which is the green dollar sign icon on your desktop.)

	[bookmark: _Hlk177553426][bookmark: _Hlk163549052]2
	[bookmark: _Hlk177553427]Click the VISTA Sign-On button. 

[bookmark: _Hlk177553428]Shortcut: Press the <Alt> key + <S> key.

A confirmation window displays to alert you that opening this application may expose you to individually-identifiable information which must be kept confidential.

	[bookmark: _Hlk177553429]3
	Click Yes if you agree to follow appropriate security and privacy policies. The Connect To dialog displays.



	[bookmark: _Hlk177547605]Confirm window
	[image: Screenshot of confirm window]



	[bookmark: _Hlk177547606]Help and About Buttons
	If you require online help, you can click the Help button WITHOUT signing on. You can also access the About option WITHOUT signing on.



[bookmark: _Hlk177553431][bookmark: _Hlk177553430]
Open the Prosthetics Main Menu, Continued

	[bookmark: _Hlk177547607]About window (Version number may be different)
	[image: Screenshot of about window]



	[bookmark: _Hlk177547608]Single Sign-on
	The Prosthetics Main Menu window is a location for a single sign-on to all the Prosthetics GUI applications. Using this main menu requires you to sign-on using the VISTA Sign-on button. Then you can decide if you want the Purchasing option, the View Prosthetic Billing Information option, the Delayed Order Report option, or the NPPD Detail Display Report option (until future applications are available). 



	[bookmark: _Hlk177547609]Title Bar
	After you sign on, all Prosthetics programs will display the server information that you are logged into in the Title bar of the application window.



	[bookmark: _Hlk177547610]Multiple Windows Open
	After you log on, you can access multiple applications, and you can switch between open applications without having to relog on and without losing displayed data. If you change servers that you are logged into, then you will lose the data displayed in all open windows.



	[bookmark: _Hlk177547611]Exit the VistA Suite
	You can logoff the Prosthetics Main Menu window by clicking the Close button. This exits you out of the VistA suite of Prosthetics applications. If you have any open Prosthetics applications when you exit, you will lose data in these open applications. A confirmation message will display as shown below. 



	[bookmark: _Hlk177547612]Confirmation message
	[image: Exit confirmation message]



[bookmark: _Hlk177553432][bookmark: _Toc42397895][bookmark: _Toc163546930][bookmark: _Toc177550887]
Connect to the System (Only necessary for multiple sites)

	[bookmark: _Hlk177547613]Prosthetics Main Menu window
	[bookmark: _Hlk177553433]After you click the VISTA Sign-on button and click Yes at the Confirm window (as described above), the Connect To dialog box displays as shown below ONLY if you are connected to multiple sites/systems.

Workstations are typically configured to sign-on to a single system. However, if your workstation is configured to sign-on to more than one system (see example below), you will see the Connect To window whenever you try to establish a connection. 



	[bookmark: _Hlk177547614]Connect To window
	[image: Connect To window]



	[bookmark: _Hlk177547615]Steps 
	To continue to access the VistA system, follow these steps:



	[bookmark: _Hlk177553434][bookmark: _Hlk177547616]Step
	Action

	[bookmark: _Hlk177553435]1
	Click the drop-down arrow in the Connect To dialog box to display the list of systems or press <Enter> for the default system (displayed). 

	[bookmark: _Hlk177553436]2
	In that list, click the connection you need. 

	[bookmark: _Hlk177553437]3
	Then click OK or press <Enter> to sign-on to that system.



	[bookmark: _Hlk177547617]Cancel Button
	[bookmark: _Hlk177553438]You can click the Cancel button to exit the Connect To dialog box. 
Shortcut: Press the <Alt> key + <C> key to cancel.



	[bookmark: _Hlk177547618]Help Button
	The Help button displays online help regarding the dialog box that is currently displayed. You can also press the <F1> key to display online help.



[bookmark: _Hlk177553439][bookmark: _Toc42397896][bookmark: _Toc163546931]
Sign-On to VistA

	[bookmark: _Hlk177547619]Introduction
	[bookmark: _Hlk177553440]The VISTA Sign-on window is the main sign-on window for all VistA GUI applications. It displays the current system introductory messages, and lets you sign on to the system using your Access and Verify codes. 

Note: This is the first window if you have only one system to sign-on to; otherwise, see the previous page.



	[bookmark: _Hlk177547620]VISTA Sign-on
	To continue to sign on to the VistA system, follow these steps:



	[bookmark: _Hlk177553441][bookmark: _Hlk177547621]Step
	Action

	[bookmark: _Hlk177553442]1
	In the Access Code box on the VISTA Sign-on window, enter your access code.

	[bookmark: _Hlk177553443]2
	Press the <Tab> key to jump to the Verify Code box.

	[bookmark: _Hlk177553444]3
	In the Verify Code box, enter your verify code.

	[bookmark: _Hlk177553445]4
	Press <Enter> or click OK to sign on.



	[bookmark: _Hlk177547622]VistA Sign-on window
	[image: VistA Sign-on window]



	[bookmark: _Hlk177547623]Time-saving Tip
	Alternatively, in the access code box you can enter your access code, a semicolon, and your verify code all at once. Then press <Enter> or click OK to sign on.




[bookmark: _Hlk177553447][bookmark: _Hlk177553446]
Sign-On to VistA, Continued

	[bookmark: _Hlk177547624]Menu Button
	Once you have accessed the DOR window, the NPPD Detail Display window, or the View Prosthetic Billing Information window, you can return to the Prosthetics Main Menu by clicking the Menu button. 



	[bookmark: _Hlk177547625]Multiple Windows Open
	[bookmark: _Hlk177553448]After you log on, you can access multiple applications, and you can switch between open applications without having to re-log on and without losing displayed data. 

[bookmark: _Hlk177553449]You can keep a window open (any Prosthetics GUI application) by clicking the Menu button, returning to the Prosthetics Main Menu window and opening another application. Once you have multiple programs open, you can switch back and forth between them and not lose any data.

Warning: If you change servers that you are logged into, then you will lose the data displayed in all open windows.



[bookmark: _Toc177550888][bookmark: _Hlk177553450]Logging Off

	[bookmark: _Hlk177547626]Log Off
	You can also sign off the Prosthetics VistA Suite screen by clicking the Close Menu. The following message displays for you to click OK to continue or Cancel to cancel the log off procedure.



	[bookmark: _Hlk177547627]Confirmation Message
	[image: Are you sure you want to EXIT the Prosthetics Application Suite?]



[bookmark: _Hlk177553451][bookmark: _Toc24938076][bookmark: _Toc172537297][bookmark: _Toc177550889]
Sign-On Properties (Optional)

	[bookmark: _Hlk177547628]Sign-on Properties
	[bookmark: _Hlk177553452]From the Sign-on window, you can also set Sign-on Properties as shown below.

Recommendation: Do not change the settings. Use this option only if necessary.



	[bookmark: _Hlk177547629]Steps
	To set sign-on properties, follow these steps:



	[bookmark: _Hlk177553453][bookmark: _Hlk177547630]Step
	Action

	[bookmark: _Hlk177553454]1
	[bookmark: _Hlk177553455]From the VistA Sign-on window, click the [image: Medicine Bag title bar icon] icon at the top left corner (to the left of the window title name).

	[bookmark: _Hlk177553456]2
	[bookmark: _Hlk177553457]From the VistA Sign-on window menu, choose the Properties option. 
[image: VistA Sign-on window menu]

	[bookmark: _Hlk177553458]3
	Set any individual properties you want to change on the Sign-on Properties dialog box, and click OK to save those changes.

	[bookmark: _Hlk177553459]4
	To return the properties to their default values, click the Defaults button, and then click OK to save that change.



	[bookmark: _Hlk177547631]Sign-on Properties window
	[image: Sign-on Properties window]



	[bookmark: _Hlk177547632]Note
	Sign-on properties that you save will be used for subsequent sign-ons using this workstation.



[bookmark: _Hlk177553460]Continued on next page
[bookmark: _Hlk177553462][bookmark: _Hlk177553461]
Sign-On Properties (Optional), Continued

	[bookmark: _Hlk177547633]Window Position
	Below are the window positions as they appear on your desktop.



	[bookmark: _Hlk177553463][bookmark: _Hlk177547634]Part
	Function

	[bookmark: _Hlk177553464]Center (default)
	The window will always appear in the center of the screen.

	[bookmark: _Hlk177553465]Current
	The current position of the window will be saved and used in the future.

	[bookmark: _Hlk177553466]Remember
	Each time the window is used and closed, it will record its position and open in that same place the next time it is used.



	[bookmark: _Hlk177547635]Window Size
	Below are the window sizes as they appear on your desktop.



	[bookmark: _Hlk177553467][bookmark: _Hlk177547636]Part
	Function

	[bookmark: _Hlk177553468]Normal (default)
	The size of the window as it was designed. Typically, this is 500 pixels wide by 300 pixels high.

	[bookmark: _Hlk177553469]Current
	The current size of the window will be saved and used in the future.

	[bookmark: _Hlk177553470]Remember
	Each time the window is used and closed, it will record its size and open with the same size the next time it is used.



	[bookmark: _Hlk177547638]Color and Font
	Below are the text background colors and fonts.



	[bookmark: _Hlk177553471][bookmark: _Hlk177547639]Part
	Function

	[bookmark: _Hlk177553472]Background Color
	You can set the background color to Cream or White.

	[bookmark: _Hlk177553473]Font
	You can choose any font on your system to use for the Introductory Text.
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[bookmark: _Toc172537298][bookmark: _Toc177550890][bookmark: _Hlk177553474]Chapter 3 – Purchase Ordering
[bookmark: _Toc172537299][bookmark: _Toc177550891][bookmark: _Hlk177553475]The Purchase Order Control Window

	[bookmark: _Hlk177547641]Display data
	[bookmark: _Hlk177553476]The Purchase Order Control window shown below will display consults from the Suspense module that have been entered through CPRS or entered manually. Open and Pending consults display here for one site or “All Sites” as well as a Purchasing Agent’s responsible SSN range for patients.

To access the Purchase Order Control window, click the Processing button on the Main Menu. 



	[bookmark: _Hlk177547642]Purchase Order Control window
	[image: Purchase Order Control Window]



	[bookmark: _Hlk177547643]Manager Notes
	The new feature, Manager Notes window, displays text-entered notes from a manager that can be displayed to all Purchasing Agents in their group.



	[bookmark: _Hlk177547644]Create P.O.
	You will create a PO from this window for a specific patient. 



[bookmark: _Hlk177553477][bookmark: _Toc172537300][bookmark: _Toc177550892]
Select a Site and Status
	[bookmark: _Hlk177547645]Site field
	[bookmark: _Hlk177553478]The first step to view purchasing transactions is to select a Site. There is a drop down list to select a specific site or you can select the All Sites checkbox (which is the default setting). The Site drop-down arrow may display a list of multiple sites for you to select one. When you click the drop down arrow, the checkmark from the All Sites checkbox disappears automatically.

Recommendation: It is strongly recommended that you always select All Sites so a consult does not get overlooked.



	[bookmark: _Hlk177553479][bookmark: _Hlk177547646]Purchase Order Control window
	[image: Purchase Order Control Window]

	[bookmark: _Hlk177553480]CBOC data
	If you want to view all available suspense entries/electronic consult orders including Community Based Outpatient Clinics (CBOC) data, click the All Sites checkbox instead of selecting your specific site from the Site drop-down list box. This ensures that the display will include all sites. For example, the Kenosha, Wisconsin CBOC will not display when the Milwaukee site is selected only. These records display when the All Sites checkbox is selected.



	[bookmark: _Hlk177547647]Status options
	The status selections are Open transactions and Pending transactions. They are both checked by default, but you can deselect one by clicking on it.


[bookmark: _Hlk177553481][bookmark: _Toc172537301][bookmark: _Toc177550893]
Select an SSN Range

	[bookmark: _Hlk177547648]SSN Range
	[bookmark: _Hlk177553482]This is a range of patient Social Security Numbers by the last two digits entered in the Starting SSN field and the Ending SSN field. When you enter a range, it will display electronic consults or manual suspense entries within that range.

[bookmark: _Hlk177553483]A Purchasing Agent has two choices when entering SSN ranges:

1. [bookmark: _Hlk177553484]Enter a specific SSN range within your responsible range by entering the Starting SSN and Ending SSN, or 

2. [bookmark: _Hlk177553485]Keep the “Or…your assigned SSN range” checkbox checked (which is the default setting).

[bookmark: _Hlk177553486]The SSN range has been entered in the Site Parameters file by employee name. (See Chapter 1: Utilities Menu - Site Parameters File for more information.)

[bookmark: _Hlk177553487]If your workload is categorized by the SSN for a specific Purchasing Agent, then you can display entries that are assigned by one Purchasing Agent at a time.

Note: Enter a range of 00 to 99 to view all Purchasing Agents’ SSNs for all patients.



	[bookmark: _Hlk177547649]SSN Range or Assigned SSN Range checkboxes
	[image: SSN Range or Assigned SSN Range checkboxes]





[bookmark: _Hlk177553488]
	[bookmark: _Hlk177547650]Display button
	Click the Display/Refresh button once you have selected a Site(s), Status and an SSN range. The transactions displayed depend upon what site was selected, whether you have selected Open or Pending or both statuses as well as the SSN range for the Purchasing Agent.



	[bookmark: _Hlk177547651]Data
	[bookmark: _Hlk177553489]The data that is displayed includes the following:

· [bookmark: _Hlk177553490]Done
· [bookmark: _Hlk177553491]Type (Routine, Eyeglass, Manual, Contact Lens and Clone)
· [bookmark: _Hlk177553492]Station
· [bookmark: _Hlk177553493]Date (Create date of Suspense entry)
· [bookmark: _Hlk177553494]Days (Number of days the transaction has remained in Open or Pending status)
· [bookmark: _Hlk177553495]Patient
· [bookmark: _Hlk177553496]SSN
· [bookmark: _Hlk177553497]Description (of the transaction)
· [bookmark: _Hlk177553498]Status (Open or Pending)
· [bookmark: _Hlk177553499]IEN 668
· Pt IEN


 
	[bookmark: _Hlk177547652]Purchase Order Control list
	[image: Purchase Order Control window]



[bookmark: _Hlk177553500][bookmark: _Toc89754782][bookmark: _Toc172537302][bookmark: _Toc177550894]
Change Data Display

	[bookmark: _Hlk177547653]Sizing columns
	Columns are sizable on this window, but not movable. To resize a column, you can place the cursor on the column header borderline until you can view the double-headed arrow. Then click and drag the column until it is the size you want. 



	[bookmark: _Hlk177547654]Column sorting
	[bookmark: _Hlk177553501]You can manipulate the layout of the view in the Purchase Order Control window for display purposes. The following can be done for column sorting features: 

· [bookmark: _Hlk177553502]To enlarge a column, click and drag a cell border.
· [bookmark: _Hlk177553503]To sort on any column, click on the header to sort it in ascending order. 
· If you click on the same column again, it will sort it in descending order.



	[bookmark: _Hlk177547655]Refresh data
	[bookmark: _Hlk177553504]You can click the Display/Refresh button to update your window with any new transactions that may have been added into Suspense.

[bookmark: _Hlk177553505]If you have changed the sort order, you can refresh your data by clicking the Display/Refresh button again. 

Note: Refresh does not reset any column resizing that has been done.



	[bookmark: _Hlk177547656]Clear button
	You can use the Clear button to blank out the window and start over with new display criteria. 



	[bookmark: _Hlk177547657]Menu button
	The Menu button returns you to the Prosthetics Main Menu window where you can open additional applications at the same time.



	[bookmark: _Hlk177547658]2319 button
	You can display all eight tabs of 2319 data for a patient from this button. 



	[bookmark: _Hlk177547659]CPRS button
	You can view a CPRS record for a patient from this button.  



	[bookmark: _Hlk177547660]Request button
	You can view a Request (if information is available for that patient) from this button.


[bookmark: _Hlk177553506][bookmark: _Toc89754783][bookmark: _Toc172537303][bookmark: _Toc177550895]
View Column Descriptions

	[bookmark: _Hlk177547661]Done
	The Done column displays a Yes after you have created a purchase order with one or more items on it. 



	[bookmark: _Hlk177547662]Type
	The Type column displays one of the following record types for the Purchase Order transaction: Manual Suspense entry or Routine Consult (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders). Clone is also a type of record that may display. 



	[bookmark: _Hlk177547663]Station
	The Station column displays the Station Number of the selected Purchasing Agent.



	[bookmark: _Hlk177547664]Date
	The Date column displays the date the consult was entered into Suspense or the manual entry was created in Suspense.



	[bookmark: _Hlk177547665]Days
	The Days column displays the number of days the transaction has remained in Open or Pending status.



	[bookmark: _Hlk177547666]Patient
	The Patient column contains the veteran’s name, last name first. All patient transactions for the requested date range appear for Non-Service Connected (NSC) veterans. 



	[bookmark: _Hlk177547667]SSN
	The SSN column displays the patient’s Social Security Number (SSN).



	[bookmark: _Hlk177547668]Description
	The Description column displays the prescription that was entered on the consult or during the manual suspense entry. 



	[bookmark: _Hlk177547669]Status
	The status displays either Open or Pending. Records with an Open status are shown in blue. Pending status transactions are shown in red.




[bookmark: _Toc172537304][bookmark: _Toc177550896][bookmark: _Hlk177553507]Chapter 4 - Display the 2319
[bookmark: _Toc172537305][bookmark: _Toc177550897][bookmark: _Hlk177553508]2319 Button

	[bookmark: _Hlk177547670]2319 Button
	[bookmark: _Hlk177553509]You can click the 2319 button on the Purchase Order Control window to display the View 2319 window with the following eight tabs:

1. [bookmark: _Hlk177553510]Patient Demographics
2. [bookmark: _Hlk177553511]Clinic Enrollments/Correspondence
3. [bookmark: _Hlk177553512]Entitlement Info (not available)
4. [bookmark: _Hlk177553513]Appliance Transaction
5. [bookmark: _Hlk177553514]Auto Adaptive Info (not available)
6. [bookmark: _Hlk177553515]Critical Comments
7. [bookmark: _Hlk177553516]HISA Information
8. Home Oxygen



	2319 button
	[image: Screenshot displaying 2319 button]



	[bookmark: _Hlk177547672]View 2319 window
	[image: Screenshot of 2319 window]



	[bookmark: _Hlk177547673]Exit
	[bookmark: _Hlk177553517]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177553518][bookmark: _Toc172537306][bookmark: _Toc177550898]
View 2319 – Patient Demographics (Tab 1)

	[bookmark: _Hlk177547674]Tab 1
	You can view the Patient Demographics tab that includes a patient’s benefits, eligibility, next of kin, emergency contact info (if available), and disabilities.



	[bookmark: _Hlk177547675]Patient Demographics tab
	[image: Patient Demographics tab]



	[bookmark: _Hlk177547676]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.



	[bookmark: _Hlk177547677]Demographics data
	[bookmark: _Hlk177553519]You can view the patient demographics for the veteran. 

This includes: Name (in red if deceased, with Date of Death listed above the Date of Birth and a blank age field), address, next of kin, emergency contact information, veteran benefits and eligibility (former Prisoner of War (highlighted in blue if “Yes”), Aid & Attendance, service connected, non-service connected, etc.).



[bookmark: _Hlk177553520][bookmark: _Toc172537307][bookmark: _Toc177550899]
View 2319 – Clinic Enrollments/Correspondence (Tab 2)

	[bookmark: _Hlk177547678]Tab 2
	You can view the Clinic Enrollments/Correspondence tab that includes last movement actions, clinic enrollments, pending appointments, and letters on file



	[bookmark: _Hlk177547679]Clinic Enrollments/ Correspondence
	[image: View of 2319 tab 2]



	[bookmark: _Hlk177547680]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.



	[bookmark: _Hlk177547681]Description
	This second tab details clinic enrollments and correspondence for the veteran. This includes the following: the last movement actions (i.e., hospital admissions and discharges), clinic enrollments, pending appointments and correspondence letters. 



[bookmark: _Hlk177553521][bookmark: _Toc172537308][bookmark: _Toc177550900]
View 2319 – Entitlement Info (Tab 3)

	[bookmark: _Hlk177547682]Tab 3
	The Entitlement Info tab is not available in this version of the Prosthetics application. This tab details entitlement and loan information for the veteran. This includes the following: PSC Issue Card, clothing allowance, items on loan, and items returned.



	[bookmark: _Hlk177547683]Entitlement Info
	[image: Entitlement Info tab]



	[bookmark: _Hlk177547684]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.



[bookmark: _Hlk177553522][bookmark: _Toc172537309][bookmark: _Toc177550901]
View 2319 – Appliance Transactions (Tab 4)

	[bookmark: _Hlk177547685]Tab 4
	[bookmark: _Hlk177553523]The Appliance Transactions tab displays the following information:

· [bookmark: _Hlk177553524]Date (this is the date of the PO)
· [bookmark: _Hlk177553525]Quantity
· [bookmark: _Hlk177553526]HCPC Item
· [bookmark: _Hlk177553527]Type
· [bookmark: _Hlk177553528]Vendor
· [bookmark: _Hlk177553529]Station
· [bookmark: _Hlk177553530]Serial
· [bookmark: _Hlk177553531]HCPC
· [bookmark: _Hlk177553532]Total Cost
· [bookmark: _Hlk177553533]IEN 660

[bookmark: _Hlk177553534]The total number of records found displays at the bottom.

[bookmark: _Hlk177553535]You can click the View Detail button to display the Appliance Transaction Detail window, which includes Appliance Item detail, IFCAP vendor, costs, lab info, historical data, and an extended description. (See the next page for more info about this window.) 

Note: Columns are resizable on this window (not movable). 



	[bookmark: _Hlk177547686]Appliance Transactions
	[image: Appliance Transactions tab]


[bookmark: _Hlk177553536]Continued on next page
[bookmark: _Hlk177553538][bookmark: _Hlk177553537]
View 2319 – Appliance Transactions (Tab 4), Continued

	[bookmark: _Hlk177547687]View Detail
	When you select a record and click the View Detail button, the Appliance Transaction Detail window displays as shown below.



	[bookmark: _Hlk177553539][bookmark: _Hlk177547688]Appliance Transaction Detail

	[image: Appliance Transaction Detail window]



	[bookmark: _Hlk177547689]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.




[bookmark: _Hlk177553540][bookmark: _Toc172537310][bookmark: _Toc177550902]
View 2319 – Auto Adaptive Info (Tab 5)

	[bookmark: _Hlk177547690]Tab 5
	The Auto Adaptive Info tab is not available in this version of the Prosthetics application.



	[bookmark: _Hlk177547691]Auto Adaptive Info
	[image: Auto Adaptive Info tab]



	[bookmark: _Hlk177547692]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.




[bookmark: _Hlk177553541][bookmark: _Toc172537311][bookmark: _Toc177550903]
View 2319 – Critical Comments (Tab 6)

	[bookmark: _Hlk177547693]Tab 6
	You can view comments in the Critical Comments tab as shown below.



	[bookmark: _Hlk177547694]Critical Comments window
	[image: View of 2319 tab 6]



	[bookmark: _Hlk177547695]Close button
	Click the Close button to exit the Critical Comments window return to the main Purchase Order Control window.



[bookmark: _Hlk177553542][bookmark: _Toc172537312][bookmark: _Toc177550904]
View 2319 – HISA Information (Tab 7)

	[bookmark: _Hlk177547696]Tab 7
	[bookmark: _Hlk177553543]On the HISA Information tab, if there is no data for a specific patient, it will state “NOTHING TO REPORT.”

This tab details the HISA (Home Improvement Structural Alteration) information including the date, quantity, HCPC item, type, vendor, station number, serial, HCPCS Code, total cost of the item ordered, and IEN 660.



	[bookmark: _Hlk177547697]HISA Information
	[image: HISA Information tab]



[bookmark: _Hlk177553544]Continued on next page
[bookmark: _Hlk177553546][bookmark: _Hlk177553545]
View 2319 – HISA Information (Tab 7), Continued

	[bookmark: _Hlk177547698]View Detail
	When you select a record and click the View Detail button, the Appliance Transaction Detail window displays as shown below.



	[bookmark: _Hlk177553547][bookmark: _Hlk177547699]Appliance Transaction Detail

	[image: Appliance Transaction Detail window]



	[bookmark: _Hlk177547700]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.



[bookmark: _Hlk177553548][bookmark: _Toc172537313][bookmark: _Toc177550905]
View 2319 – Home Oxygen (Tab 8)

	[bookmark: _Hlk177547701]Tab 8
	[bookmark: _Hlk177553549]The Home Oxygen tab displays the following information:

· [bookmark: _Hlk177553550]Date
· [bookmark: _Hlk177553551]Quantity
· [bookmark: _Hlk177553552]HCPC Item
· [bookmark: _Hlk177553553]Type
· [bookmark: _Hlk177553554]Vendor
· [bookmark: _Hlk177553555]Station
· [bookmark: _Hlk177553556]Serial
· [bookmark: _Hlk177553557]HCPC
· [bookmark: _Hlk177553558]Total Cost
· [bookmark: _Hlk177553559]IEN 660




	[bookmark: _Hlk177547702]Home Oxygen
	[image: Home Oxygen tab]


[bookmark: _Hlk177553560]Continued on next page
[bookmark: _Hlk177553562][bookmark: _Hlk177553561]
View 2319 – Home Oxygen (Tab 8), Continued

	[bookmark: _Hlk177547703]View Detail
	When you select a record and click the View Detail button, the Appliance Transaction Detail window displays as shown below.



	[bookmark: _Hlk177553563][bookmark: _Hlk177547704]Appliance Transaction Detail

	[image: Appliance Transaction Detail window]



	[bookmark: _Hlk177547705]Close button
	To close this window and return to the main Purchase Order Control window, click the Close button.





[bookmark: _Toc172537314][bookmark: _Toc177550906][bookmark: _Hlk177553564]Chapter 5 - View a CPRS Record
[bookmark: _Toc172537315][bookmark: _Toc177550907][bookmark: _Hlk177553565]CPRS Button

	[bookmark: _Hlk177547706]CPRS
	Click the CPRS button on the main Purchase Order Control window to display the View CPRS window if information is available.



	CPRS button
	[image: Screenshot showing the CPRS button]



	[bookmark: _Hlk177547708]CPRS Record
	[image: Screenshot of View CPRS record]



	[bookmark: _Hlk177547709]Close button
	To exit the View CPRS window, click the Close button to return to the Purchase Order Control window.





[bookmark: _Toc172537316][bookmark: _Toc177550908][bookmark: _Hlk177553566]Chapter 6 - View a Request
[bookmark: _Toc172537317][bookmark: _Toc177550909][bookmark: _Hlk177553567]Request Button

	[bookmark: _Hlk177547710]Request button
	Click the Request button on the main Purchase Order Control window to display the View Request window (if information is available) including a description of the item/services, Order/Suspense date, Initial Action and/or Completion date if applicable, and Initial Action or Completion note if available.



	Request button
	[image: Screenshot showing the request button]



	[bookmark: _Hlk177547712]View Request window
	[image: View Request window]



	[bookmark: _Hlk177547713]Close button
	To exit the View Request window, click the Close button to return to the Purchase Order Control window.





[bookmark: _Toc172537318][bookmark: _Toc177550910][bookmark: _Hlk177553568]Chapter 7 - Purchase Order Creation
[bookmark: _Toc172537319][bookmark: _Toc177550911][bookmark: _Hlk177553569]Create a P.O.

	[bookmark: _Hlk177547714]First step
	Select a patient from the Purchase Order Control window. Check Eligibility for the patient on the 2319 Patient Demographics tab, and check to see if there are any duplicate orders on the 2319 Appliance Transactions tab. Then proceed to click the Create P.O. button.



	[bookmark: _Hlk177547715]Create P.O. button
	[image: Create P.O. button]



	[bookmark: _Hlk177547716]Purchase Order window
	[bookmark: _Hlk177553570]The Purchase Order window displays a two-panel window as shown below. It contains the patient name and SSN in the title bar.

· [bookmark: _Hlk177553571]The left-side panel is the Policy Panel. This panel has buttons that display pop-up windows for you to enter and display additional purchase order information.
· The right-side is the Purchase Order window. Its information fields display data as you complete the information in the Policy Panel pop-up windows. 



	Two-panel Purchase Order window

Policy Panel
	[image: Purchase Order window]



[bookmark: _Hlk177553573]Continued on next page
[bookmark: _Hlk177553575][bookmark: _Hlk177553574]
Create a P.O., Continued

	[bookmark: _Hlk177547718]CPRS and Request
	You can also review the CPRS and the Request buttons for a patient before creating a PO to update yourself on the patient.



	[bookmark: _Hlk177547719]More about the Policy Panel
	[bookmark: _Hlk177553577]You begin the PO process by clicking each button on the Policy Panel in order. If a button has green text, it is not required to click it (i.e., Due Date button and possibly the Site button) but you can click it to change the default data. If a button has red text, then it is a required button, and you must click it or you will not be able to proceed to the next button on the list in the Policy Panel.

[bookmark: _Hlk177553578]Note: The Site button already has a check in the checkbox in this example because a Site was selected before displaying transactions on the previous window. You can change the default Site by clicking the button. The Due Date does not have a checkbox and has a default setting of 30 days from the current date. You only need to check it if you want to change the Due Date setting.

[bookmark: _Hlk177553579]As you click each button on the Policy Panel and fill in information in the pop-up window that displays, the fields in the Purchase Order window will automatically populate with the data you entered in the corresponding pop-up window.

Once you select a button on the Policy Panel, notice the checkbox in the Policy Panel next to a button is automatically checked. This tracks which buttons you have completed in the PO creation process.



	[bookmark: _Hlk177547720]Purchasing Order window fields
	The fields within the Purchase Order window are populated in the order of the buttons on the Policy Panel. As you click each button, a pop-up window displays allowing you to enter data that will automatically fill in the fields on the Purchase Order window.



[bookmark: _Hlk177553580][bookmark: _Toc172537320][bookmark: _Toc177550912]
Select a Due Date

	[bookmark: _Hlk177547721]First Step on Policy Panel
	Click the Due Date button on the Policy Panel if you want to change the default of 30 days from the current date. You do not need to click this button if you want to keep the 30 day default. If you click the Due Date button, a four-month calendar displays for you to select a due date. 



	[bookmark: _Hlk177547722]Selecting a due date
	The calendars display with the current date circled in red and the due date marked with a blue ellipse. You can accept the current date by clicking OK. You can also change the date by the following methods:



	[bookmark: _Hlk177553584][bookmark: _Hlk177547723]Change the…
	Description

	[bookmark: _Hlk177553585]Day
	Click on the actual day of the week in the calendar. You must select the current date or a date in the future.

	[bookmark: _Hlk177553586]Month
	Click on the month at the top of the calendar to display a list of all months and select one from there. You can decrease or increase one month at a time by clicking the left or right arrows.

	[bookmark: _Hlk177553587]Year
	Click on the year and an up and down arrow button displays for you to increase or decrease the year.



	[bookmark: _Hlk177547724]Calendars
	[image: Select a Due Date Calendars]



[bookmark: _Hlk177553589][bookmark: _Toc172537321][bookmark: _Toc177550913]
Select a Site

	[bookmark: _Hlk177547725]Select a Site
	[bookmark: _Hlk177553590]Click the Site button on the Policy Panel. You can click the drop-down arrow to select a site. Click OK to display the data on the Purchase Order Control window. Notice that a green checkmark displays next to the Site button once you have selected an option.

Note: The number in the Common Numbering Series field comes from the Site Parameters file and automatically displays when you select a Site. You can now select a different numbering series, if that is how your site is organized.



	[bookmark: _Hlk177547726]Site
	[image: Please Select a Site window]



	[bookmark: _Hlk177547727]Site ID and Common Numbering Series fields
	[image: Site ID and Common Numbering Series fields]



	[bookmark: _Hlk177547728]Checkmarks
	Checkmarks display next to the buttons on the Policy Panel to track which steps you have completed in the PO creation process.



	[bookmark: _Hlk177547729]Add/Edit Patient option
	[bookmark: _Hlk177553595]If you select a patient that is not in the Prosthetics Patient File, a message displays to inform you that you are unable to continue. Click OK to clear the message. Please use the Add/Edit Patient (AP) option to add the patient to Prosthetics.

[image: Screenshot of Information window]



[bookmark: _Hlk177553597][bookmark: _Toc172537322][bookmark: _Toc177550914]
Select a Purchase Card

	[bookmark: _Hlk177547730]Purchase Card button
	[bookmark: _Hlk177553599]Select a purchase card by clicking the Purchase Card button on the Policy Panel.

[bookmark: _Hlk177553600]The Please Select a Purchase Card pop-up window displays. Click the dropdown arrow to display a list and select one.

[bookmark: _Hlk177553601]To select a different Common Numbering Series, click the dropdown arrow. 

[bookmark: _Hlk177553602]Click Ok. The window disappears and the data displays in the Purchase Order Control window based on your selection for the Purchase Card number, Fund Control Point and Cost Center.

Note: Notice that a checkmark displays next to the Purchase Card button. 



	[bookmark: _Hlk177547731]Select a Purchase Card
	[image: Select a Purchase Card window]



	[bookmark: _Hlk177547732]Cost Center button
	[bookmark: _Hlk177553603]The Cost Center is already populated for you when you select a Purchase Card.

Cost Center is not editable.



	[bookmark: _Hlk177547733]P Card Name / Cost Center / Fund Control Point
	[image: P Card Name/Cost Center/Fund Control Point]



[bookmark: _Hlk177553606][bookmark: _Toc172537323][bookmark: _Toc177550915]
Cost Center

	[bookmark: _Hlk177547734]Cost Center button
	[bookmark: _Hlk177553607]The Cost Center is already populated for you when you select a Site.

Cost Center is not editable. 



[bookmark: _Hlk177553609][bookmark: _Toc172537324][bookmark: _Toc177550916]
Select a Vendor

	[bookmark: _Hlk177547735]Vendor field
	[bookmark: _Hlk177553610]Click the Vendor button on the Policy Panel. Enter a partial spelling (minimum of three characters) of a Vendor and click the drop-down arrow to select one beginning with the criteria that you entered. Click OK to accept it. After the vendor is selected the following fields cannot be changed: Site, Purchase Card and Vendor.

[bookmark: _Hlk177553611]Note: If you do not enter at least three characters of a vendor before you click the dropdown arrow, the list will be empty. 

Warning Message: If you enter a partial spelling search that is not descriptive enough, a warning message dialog box will display.



	[bookmark: _Hlk177547736]Partial Spelling Search
	[image: Partial Spelling Search]



	[bookmark: _Hlk177547737]Vendor list 
	[image: Screenshot showing Vendor List]



	[bookmark: _Hlk177553614][bookmark: _Hlk177547738]Vendor field

	[image: Screenshot showing Vendor field]



[bookmark: _Hlk177553616][bookmark: _Toc172537325][bookmark: _Toc177550917]
Select the Delivery Method

	[bookmark: _Hlk177547739]Delivery locations
	[bookmark: _Hlk177553617]Click the Delivery button on the Policy Panel. There are three delivery location options including: Prosthetics, Veteran, and an Other Location - At This Site option, which is a new option with Patch RMPR*3*90. 

Note: If you choose the Other Location- At This Site option, another pop-up window displays as shown below.



	[bookmark: _Hlk177547740]Select a Delivery Location
	[image: Please Select a Delivery Location window]



	[bookmark: _Hlk177547741]Other Location
	[bookmark: _Hlk177553620]You can enter a free-text description in the blank field (with a maximum of 50 characters) on the Other Location – At This Site pop-up window which is a new feature with this patch. This helps warehouse employees to determine a delivery location.

Note: This information does not print on a hard copy printout.



	[bookmark: _Hlk177547742]Other Location
	[image: Other Location - At This Site window]



	[bookmark: _Hlk177547743]Next Step
	Click OK to return to the Purchase Order Control window and select the next button on the Policy Panel.





[bookmark: _Toc172537326][bookmark: _Toc177550918][bookmark: _Hlk177553623]Chapter 8 - Add Item(s) to the Purchase Order
[bookmark: _Toc172537327][bookmark: _Toc177550919][bookmark: _Hlk177553624]Add Items Button

	[bookmark: _Hlk177547744]Purchase Order Items
	When you click the Add Items button on the Policy Panel, the Purchase Order window displays as shown below. The Purchase Order number, patient’s name and SSN display at the top. This window provides multiple steps to add information when adding one or multiple items to the Purchase Order.



	[bookmark: _Hlk177547745]Add Items button
	[image: Screenshot of Policy panel showing Add Items button]



[bookmark: _Hlk177553627]Continued on next page
[bookmark: _Hlk177553629][bookmark: _Hlk177553628]
Add Items Button, Continued

	[bookmark: _Hlk177547746]First Step
	[bookmark: _Hlk177553630]On the Purchase Order window, you MUST select a Type of Transaction as either New/Replace, Service/Repair or Rental Item. 

Note: These three transactions types have been consolidated from four types with this patch. 



	[bookmark: _Hlk177547747]Second Step
	[bookmark: _Hlk177553631]The Patient Category (SC or NSC) radio buttons are displayed. This is an enhanced feature with this patch that has been consolidated into two options. You MUST select either: SC (Service Connected) or NSC (Non Service Connected).

Note: If there is a SC Disability, it will display in the box at the top. There is no longer any additional selection of eligibility for the Special Category.



	[bookmark: _Hlk177547748]Purchase Order window
	[image: Purchase Order window]

Note: You can use the Tab key to tab from one field to the next on this window. You can also use the spacebar to check a checkbox.



[bookmark: _Hlk177553633]Continued on next page
[bookmark: _Hlk177553635][bookmark: _Hlk177553634]
Add Items Button, Continued

	[bookmark: _Hlk177547749]Billing Item
	[bookmark: _Hlk177553636]You can select the Billing Item by entering partial spelling search criteria with a minimum of three characters. You MUST enter a partial spelling to begin your search. Once you type the initial search value, you can click on the drop-down arrow and a list will display. From this list, you can scroll to select an option. 

Note: This billing information does not display on the 2319 nor does it print on the Purchase Order. It is only for billing purposes.



	[bookmark: _Hlk177547750]Purchase Order window
	[image: Purchase Order window]



	[bookmark: _Hlk177547751]HCPCS Criteria Search
	[bookmark: _Hlk177553638]You MUST enter a partial spelling of the HCPCS Description (or HCPCS code or synonym) to begin your search. Once you type an initial search value, you can then click on the drop-down arrow and a list will display. From this list, you can scroll to select an option. If you know the code, you can enter the entire HCPCS code.

Note: The search criteria must be for a valid HCPCS code.



	[bookmark: _Hlk177547752]Number of Bids
	Click Number of Bids to enter a bid on this item. The maximum number of bids on an item is 3. For certain HCPCS (e.g., HISAS, HISAN), this window will automatically open for your selection. It should be used whenever you receive a bid for a prosthetic item.


[bookmark: _Hlk177553640]
	[bookmark: _Hlk177547753]Contract
	[bookmark: _Hlk177553641]You can select the Contract information by clicking the drop down arrow to begin your search. Once you type an initial search value, you can then click on the drop-down arrow and a list will display. From this list, you can scroll to select an option.

Note: The Contract information is tied to the Vendor in the Vendor file and will display according to the Vendor that was selected.


[bookmark: _Hlk177553642]Continued on next page
[bookmark: _Hlk177553644][bookmark: _Hlk177553643]
 Add Items Button, Continued

	[bookmark: _Hlk177547754]Brief Description
	You can enter a Brief Description in the free-text field (with a maximum of 60 characters) which prints on the purchase order.  You can also (optionally) add free-text Remarks. If you would like to enter an extended description, click the Extended Description button. See below for more information.



	[bookmark: _Hlk177547755]Extended Description
	Notice as the Extended Description window shows below that you can type in a free-text extended description (of unlimited maximum number of characters). This information appears on the printed PO.



	[bookmark: _Hlk177547756]Extended Description
	[image: Extended Description window]



	[bookmark: _Hlk177547757]Purchase Order
	[image: Screenshot of Purchase Order]



[bookmark: _Hlk177553648]Continued on next page
[bookmark: _Hlk177553650][bookmark: _Hlk177553649]
 Add Items Button, Continued

	[bookmark: _Hlk177547758]Remarks
	You can enter free-text information up to a maximum of 30 characters in the Remarks field.



	[bookmark: _Hlk177547759]Extended and Waiver
	[bookmark: _Hlk177553652]There are two NEW prompts shown below. You can click the checkboxes if the item is considered excluded or has a waiver. (You can also use the spacebar to select one of the checkboxes after using the Tab key.)

If you forget to select the Excluded or Waiver checkboxes in the creation of the PO, you can go into the Roll and Scroll Enter Waiver or Excluded Notice (EW) option and enter the information afterwards. 



	[bookmark: _Hlk177547760]Purchase Order
	[image: Screenshot of Purchase Order]



	[bookmark: _Hlk177547761]Optional fields
	[bookmark: _Hlk177553655]The following fields are optional:

· [bookmark: _Hlk177553656]Manufacturer (with a maximum of 30 characters)
· [bookmark: _Hlk177553657]Model (with a maximum of 30 characters)
· [bookmark: _Hlk177553658]Serial # (with a maximum of 15 characters)
· [bookmark: _Hlk177553659]Lot # (with a maximum of 30 characters)

This information prints on the Purchase Order. 



[bookmark: _Hlk177553660]Continued on next page
[bookmark: _Hlk177553662][bookmark: _Hlk177553661]
 Add Items Button, Continued

	[bookmark: _Hlk177547762]Unit of Issue
	You can select a Unit of Issue from a drop-down selection list. Enter a partial spelling search of one character minimum.



	[bookmark: _Hlk177547763]Qty and Cost
	You can enter the Quantity and Unit Cost of the item you are adding to the Purchase Order. Notice that the Total Cost will be calculated automatically for you when you click in that field. You can also use the Tab key to view the Total Cost.



	[bookmark: _Hlk177547764]Add Item to PO button – REQUIRED!!
	[bookmark: _Hlk177553663]REQUIRED: Once you have entered all the correct information for the Item, you MUST click the Add Item to P.O. button. This button will appear double lined or highlighted to remind you to click it. 

[bookmark: _Hlk177553664]The information disappears from this Purchase Order window to allow you to add more items if necessary.

WARNING: If you click the Return to P.O. button before you click the Add Item to P.O. button, you will LOSE all the data that you have entered for that specific item.



	[bookmark: _Hlk177547765]Purchase Order
	[image: Screenshot of Purchase Order]



[bookmark: _Hlk177553666][bookmark: _Toc172537328][bookmark: _Toc177550920]
Return to P.O. Button

	[bookmark: _Hlk177547766]Return to P.O. button
	[bookmark: _Hlk177553667]After you click the Add Item to P.O. button for all the items you want to add to this Purchase Order, then click the Return to P.O. button. The Purchase Order Control window displays where you can verify that the item(s) has been added to the Purchase Order. 

Warning: Do NOT click the Return to P.O. button before the Add Item to P.O. button as the data will disappear and you will have to re-enter it.



	[bookmark: _Hlk177547767]Return to P.O. button
	[image: Return to P.O. button]



[bookmark: _Hlk177553670][bookmark: _Toc172537329][bookmark: _Toc177550921]
Add Additional Items

	[bookmark: _Hlk177547768]Item List
	[bookmark: _Hlk177553672]Notice below the list with the item added in the display. It carries over the information that you selected from the Purchase Order window. 

You can add more items by clicking the Add Items button as many times as necessary.



	Add Items button
	[image: Add Items button]



[bookmark: _Hlk177553675][bookmark: _Toc172537330][bookmark: _Toc177550922]
Edit/Delete an Item

	[bookmark: _Hlk177547770]Item List
	You can edit a line item or delete a line item by clicking on it and clicking the Edit / Delete Item button. You are returned to the Purchase Order window to make your edit or deletion. 



	[bookmark: _Hlk177547771]Edit / Delete Item
	[image: Edit / Delete Item button]



[bookmark: _Hlk177553677]Continued on next page
[bookmark: _Hlk177553679][bookmark: _Hlk177553678]
Edit/Delete an Item, Continued

	[bookmark: _Hlk177547772]Delete or Edit an Item
	[bookmark: _Hlk177553680]Once you have made edits to the Item that you are adding, click the Update Item button.

· [bookmark: _Hlk177553681]OR – 

[bookmark: _Hlk177553682]Once you have verified the item you want to delete, click the Delete This Item button.

· [bookmark: _Hlk177553683]THEN – 

Click the Return to PO button. This will save the edits that you have made as well as the deletion. 



	[bookmark: _Hlk177547773]Purchase Order window
	[image: Purchase Order window]





[bookmark: _Toc172537331][bookmark: _Toc177550923][bookmark: _Hlk177553684]Chapter 9 - Purchase Order Creation Continued
[bookmark: _Toc172537332][bookmark: _Toc177550924][bookmark: _Hlk177553685]Enter Discount/Shipping

	[bookmark: _Hlk177547774]Discount/ Shipping (Optional)
	[bookmark: _Hlk177553686]Click the Discount/Shipping button on the Policy Panel. Enter the Discount percentage for the item you are ordering and the Shipping amount (if applicable).

Click the OK button to add the Discount and the Shipping to the order.



	[bookmark: _Hlk177547775]Add Discount and Shipping Charge
	[image: Add Discount and Shipping Charge]



	[bookmark: _Hlk177547776]Discount and Shipping amounts shown
	[image: Discount and Shipping amounts shown]



[bookmark: _Hlk177553689][bookmark: _Toc172537333][bookmark: _Toc177550925]
Enter Your Electronic Signature

	[bookmark: _Hlk177547777]Print PO
	The PO will print automatically once you submit the PO. The PO can print on both Windows printers and VistA printers. You can select a different printer by either clicking Windows Printer or selecting a VistA Printer from the dropdown list.



	[bookmark: _Hlk177547778]Signature
	Click the Submit Order button on the Policy Panel. Enter your Electronic Signature and click the Send PO button.



	[bookmark: _Hlk177547779]Enter Your Electronic Signature
	[image: Prepare to send the Purchase Order window]



	[bookmark: _Hlk177547780]Complete order
	Click the OK button on the Confirmation window as shown below. This window displays the current status of the PO as either Pending or Complete.



	[bookmark: _Hlk177547781]Confirmation Window
	[image: Screenshot of Prosthetics VistA Suite Confirmation message]



	[bookmark: _Hlk177547782]Insufficient Funds
	If your purchase card does not have adequate funds to cover the purchase order, you will get the message below. You can get more funds allocated to the purchase card and continue the process.



	[bookmark: _Hlk177547783]Insufficient Funds Window
	[image: Screenshot of Prosthetics VistA Suite Insufficient Funds message]



[bookmark: _Hlk177553699][bookmark: _Toc172537334][bookmark: _Toc177550926]
Post CPRS Note

	[bookmark: _Hlk177547784]Close the order
	[bookmark: _Hlk177553700]Click the Post CPRS Note button on the Policy Panel when you have entered all the necessary information for the item you are ordering. The Post Note to CPRS pop-up window displays as shown below.

NOTE: By posting your note in this new method, you have automatically linked your transaction to the consult and created your patient care encounter. No further linking is necessary! 



	[bookmark: _Hlk177547785]Post Note to CPRS
	[image: Screenshot of Post Note to CPRS window]



	[bookmark: _Hlk177547786]Post Complete
	[bookmark: _Hlk177553702]You have three checkboxes to choose a selection for your note-to-be: 1) Post Complete, 2) Post Initial and 3) Post Other. Last, click the Post Note button.

[bookmark: _Hlk177553703]Click the Post Complete checkbox (if applicable), and enter a note in the free-text box area (optional) which has unlimited amount of space to enter a note. This checkbox places the transaction from a PENDING status to a CLOSED status.

[bookmark: _Hlk177553704]Click the OK button to process the completion. Continue to the next page.

NOTE: When you select Post Complete an encounter is created.



	[bookmark: _Hlk177547787]Post Initial and Post Other
	If you select the Post Initial checkbox, this places the transaction from an OPEN status to a PENDING status. The Post Other checkbox will put the transaction in a PENDING status if it is in an OPEN status or will keep it at PENDING if that is the current status.



[bookmark: _Hlk177553707]Continued on next page
[bookmark: _Hlk177553709][bookmark: _Hlk177553708]
Post CPRS Note, Continued

	[bookmark: _Hlk177547788]Complete order
	[bookmark: _Hlk177553710]When you have completed the process to posting the CPRS note, you will receive the following two pop-up messages. If you selected the Post Complete checkbox, the first pop-up displays as shown with the Closed status for the suspense entry.

Click the OK button to finalize the order.



	[bookmark: _Hlk177547789]Closed Suspense
	[image: Screenshot of Prosthetics VistA Suite showing Closed Suspense message]



	[bookmark: _Hlk177547790]Post Initial
	When you click the Post Initial checkbox, the status of the suspense entry changes from Open to Pending status. The popup window will display as shown below.



	[bookmark: _Hlk177547791]Post Initial Popup window
	[image: Screenshot of Prosthetics VistA Suite showing Pending suspense message]



[bookmark: _Hlk177553714]Continued on next page
[bookmark: _Hlk177553716][bookmark: _Hlk177553715]
 Post CPRS Note, Continued

	[bookmark: _Hlk177547792]Done column
	[bookmark: _Hlk177553717]The Purchase Order Control window returns after you have completed the purchase order creation process. Notice that the Done column displays “Yes” in it.
 
[bookmark: _Hlk177553718]The status of the transaction will be updated from Open to Pending or from Pending to Closed. 

WARNING: If you click the Refresh Button, the Done column will refresh and the transactions that you have completed will disappear from the list as they now have a CLOSED status. 



	[bookmark: _Hlk177547793]Purchase Order Control window
	[image: Purchase Order Control window]



[bookmark: _Toc89754795][bookmark: _Toc24938081][bookmark: _Toc89754797]
[bookmark: _Toc172537335][bookmark: _Toc177550927][bookmark: _Hlk177553719]Chapter 10 - Closing and Exiting
[bookmark: _Toc89754796][bookmark: _Toc172537336][bookmark: _Toc177550928][bookmark: _Hlk177553720]Exit the Purchase Order Control Window

	[bookmark: _Hlk177547794]Exit the Application
	You can exit the application by first clicking the Menu button on the Purchase Order Control window. Then click the Close button on the Main Prosthetics window: When the Confirmation window displays, click the OK button to exit.



	[bookmark: _Hlk177547795]Confirmation window
	[image: Screenshot of confirmation message]



	[bookmark: _Hlk177547796]Cancel button
	If you click the Cancel button, you will remain in the application and can continue to work.



[bookmark: _Hlk177553726][bookmark: _Toc172537337][bookmark: _Toc177550929]
Sample Printout

	[bookmark: _Hlk177547797]Reprint PO
	Below is a reprint of the PO number: 0U7820.



	[bookmark: _Hlk177547798]Purchase order reprint option
	[bookmark: _Hlk177553729]Select Transaction or Patient Name: 0U7820 2-15-2005PROSpatient,one Y EYEGLASSES-PRES
[bookmark: _Hlk177553730]Would you like to print the Privacy Act Statement? Yes//  (Yes)
[bookmark: _Hlk177553731]Would you like to print a Patient Notification letter? No//  (No)
[bookmark: _Hlk177553732]DEVICE: HOME//  INCOMING TELNET  Right Margin: 80// 
          OMB Number 2900-0188     PO#: 0U7820




[bookmark: _Hlk177553733]    ***ORIGINAL COPY AND COMMERCIAL INVOICE MUST BE SUBMITTED***
[bookmark: _Hlk177553734]        TO THE VAMC PROSTHETIC ACTIVITY LISTED BELOW
[bookmark: _Hlk177553735]_______________________________________________________________________________
[bookmark: _Hlk177553736]Department of Veterans Affairs|Prosthetic Authorization for Items or Services
[bookmark: _Hlk177553737]-------------------------------------------------------------------------------
[bookmark: _Hlk177553738]1. Name and Address of Vendor      2. Name and Address of VA Facility
[bookmark: _Hlk177553739]   INVACARE              DVAMC BAY PINES 516/121 (516/121)
[bookmark: _Hlk177553740]   899 CLEVELAND ST          PROSTHETIC & SENSORY AIDS SERVICE
[bookmark: _Hlk177553741]   P O BOX 4028            BAY PINES, FL 33744
[bookmark: _Hlk177553742]   ELYRIA,OH 44036
[bookmark: _Hlk177553743]   800-642-8262            727-398-9345
[bookmark: _Hlk177553744]-------------------------------------------------------------------------------
[bookmark: _Hlk177553745]3. Veterans Name (Last, First, MI)   4. Date of Authorization
[bookmark: _Hlk177553746]   PROSpatient,one              FEB 15, 2005
[bookmark: _Hlk177553747]-------------------------------------------------------------------------------
[bookmark: _Hlk177553748]5. Veterans Address           6. Date Required
[bookmark: _Hlk177553749]   9 E ORANGE ST              MAR 17, 2005
[bookmark: _Hlk177553750]   SERIA LEONE,LOUISIANA 12345    ----------------------------------------
[bookmark: _Hlk177553751]                    9. Authority For Issuance CFR 17.115
[bookmark: _Hlk177553752]   304-288-3401             CHARGE MEDICAL APPROPRIATION
[bookmark: _Hlk177553753]-------------------------------------------------------------------------------
[bookmark: _Hlk177553754]7. Claim Number SS           8. ID #: 4800 (Used to be full SSN.)
[bookmark: _Hlk177553755]-------------------------------------------------------------------------------
[bookmark: _Hlk177553756]10. Statistical Data     11. FOB Point  12. Discount  13. Delivery Time
[bookmark: _Hlk177553757]SC/IP               ORIGIN     % 12       30 Days
[bookmark: _Hlk177553758]               --------------------------------------------------
[bookmark: _Hlk177553759]               14. Delivery To: OTHER LOCATION AT THIS SITE
[bookmark: _Hlk177553760]-------------------------------------------------------------------------------
[bookmark: _Hlk177553761]         15. DESCRIPTION OF ITEMS OR SERVICES AUTHORIZED
[bookmark: _Hlk177553762]-------------------------------------------------------------------------------
[bookmark: _Hlk177553763]ITEM NUMBER      DESCRIPTION        QUANTITY UNIT UNIT  AMOUNT
[bookmark: _Hlk177553764]                         ORDERED     PRICE
[bookmark: _Hlk177553765]-------------------------------------------------------------------------------
[bookmark: _Hlk177553766]#1. EYEGLASSES                     1   EA  25.00  25.00 

[bookmark: _Hlk177553767]  Serial Number: 48DJ47DK39  Lot #: 12

[bookmark: _Hlk177553768]  Model: 2A  Make: INVACARE
[bookmark: _Hlk177553769]-------------------------------------------------------------------------------
[bookmark: _Hlk177553770]16. Contract Number: GS-00F-8355A(MAS)            Subtotal:  25.00 
[bookmark: _Hlk177553771]  ACCT.#: 95150      Discount $ 3.00 Shipping: 24.00 Total $  46.00 
[bookmark: _Hlk177553773][bookmark: _Hlk177553772]
-------------------------------------------------------------------------------
[bookmark: _Hlk177553774]17. Signature of      18. DATE  19. Signature and Title of   20. Date
[bookmark: _Hlk177553775]   Requesting Official        Contracting/Accountable Officer
[bookmark: _Hlk177553776]   PROSuser,one          PROSuser,one
[bookmark: _Hlk177553777]-------------------------------------------------------------------------------
[bookmark: _Hlk177553778]             Order and Receipt Action
[bookmark: _Hlk177553779]-------------------------------------------------------------------------------
[bookmark: _Hlk177553780]21. Order Number 22. Exp Date    23. Date Item Received  24. Date Delivered
[bookmark: _Hlk177553781]4716360100064653  (Purchase Order Number and Expiration Date added.)
[bookmark: _Hlk177553782]-------------------------------------------------------------------------------
[bookmark: _Hlk177553783]25. The articles or services listed herein have been received, or rendered
[bookmark: _Hlk177553784]ordered in the quantity and quality specified originally or as shown by
[bookmark: _Hlk177553785]authenticated changes, except as noted.

[bookmark: _Hlk177553786]                    Signature of Veteran or VA Official
[bookmark: _Hlk177553787]------------------------------------------------------------------------------- 
[bookmark: _Hlk177553788]   Acct. Symbol 516-0U7820
[bookmark: _Hlk177553789]-------------------------------------------------------------------------------
[bookmark: _Hlk177553790]                          ADP Form 10-2421PC APR 1991

[bookmark: _Hlk177553791]CONTINUATION OF PURCHASE CARD ORDER NUMBER: 0U7820           PAGE 2
[bookmark: _Hlk177553792]_______________________________________________________________________________
[bookmark: _Hlk177553793]Department of Veterans Affairs|Prosthetic Authorization for Items or Services
[bookmark: _Hlk177553794]-------------------------------------------------------------------------------
[bookmark: _Hlk177553795]1. Name and Address of Vendor      2. Name and Address of VA Facility
[bookmark: _Hlk177553796]   INVACARE              DVAMC BAY PINES 516/121 (516/121)
[bookmark: _Hlk177553797]   899 CLEVELAND ST          PROSTHETIC & SENSORY AIDS SERVICE
[bookmark: _Hlk177553798]   P O BOX 4028            BAY PINES, FL 33744
[bookmark: _Hlk177553799]   ELYRIA,OH 44036
[bookmark: _Hlk177553800]   800-642-8262            727-398-9345
[bookmark: _Hlk177553801]-------------------------------------------------------------------------------
[bookmark: _Hlk177553802]3. Veterans Name (Last, First, MI)   4. Date of Authorization
[bookmark: _Hlk177553803]   LXYF,ZLUQDY A              FEB 15, 2005
[bookmark: _Hlk177553804]-------------------------------------------------------------------------------
[bookmark: _Hlk177553805]         15. DESCRIPTION OF ITEMS OR SERVICES AUTHORIZED
[bookmark: _Hlk177553806]-------------------------------------------------------------------------------
[bookmark: _Hlk177553807]ITEM NUMBER      DESCRIPTION        QUANTITY UNIT UNIT  AMOUNT
[bookmark: _Hlk177553808]                         ORDERED     PRICE
[bookmark: _Hlk177553809]-------------------------------------------------------------------------------
[bookmark: _Hlk177553810]Eyeglasses, Prescription

[bookmark: _Toc24938072]
[bookmark: _Toc172537338][bookmark: _Toc177550930][bookmark: _Hlk177553811][bookmark: _Toc172537339]Section 2: NPPD Detail Display
[bookmark: _Toc24938073][bookmark: _Toc172537340][bookmark: _Toc177550931][bookmark: _Hlk177553812]Overview

	[bookmark: _Hlk177547799]Introduction
	[bookmark: _Hlk177553813]This section covers the National Prosthetic Patient Database (NPPD) Detail Display feature. 

[bookmark: _Hlk177553814]Prosthetics users will be able to do the following with this patch:

· [bookmark: _Hlk177553815]Search for data and display data by a range of dates.
· [bookmark: _Hlk177553816]Sort and rearrange the view; display data in a custom view.
· [bookmark: _Hlk177553817]Print the display.
· Convert the display into a Microsoft Excel file (for more complex sorting capabilities).



	[bookmark: _Hlk177547800]Data displayed
	[bookmark: _Hlk177553818]The data that is displayed on this window includes the following:

· [bookmark: _Hlk177553819]Site
· [bookmark: _Hlk177553820]Date (Suspense entry date)
· [bookmark: _Hlk177553821]Type of transaction (I=Initial/New and X=Repair)
· [bookmark: _Hlk177553822]Form type (Stock Issue, Purchase Card, 2237, Other)
· [bookmark: _Hlk177553823]Patient name
· [bookmark: _Hlk177553824]Social Security Number
· [bookmark: _Hlk177553825]IEN
· [bookmark: _Hlk177553826]Brief description
· [bookmark: _Hlk177553827]HCPCS code and description
· [bookmark: _Hlk177553828]NPPD code
· [bookmark: _Hlk177553829]Initiator name
· [bookmark: _Hlk177553830]Suspense Initial Action date
· [bookmark: _Hlk177553831]Cost
· [bookmark: _Hlk177553832]Quantity
· [bookmark: _Hlk177553833]VA or Commercial
· [bookmark: _Hlk177553834]Vendor name
· Grouper number (from AMIS)



[bookmark: _Hlk177553835][bookmark: _Toc24938077][bookmark: _Toc172537341][bookmark: _Toc177550932]
Enter a Date Range

	[bookmark: _Hlk177547801]Date/Calendars
	[bookmark: _Hlk177553836]After you have successfully signed on to VistA and the NPPD Detail Display window appears, you must select the date range that you want to view. 

[bookmark: _Hlk177553837]Enter a Beginning Date and an Ending Date by clicking on the drop-down list boxes next to the respective fields. A calendar displays as shown below. 

[bookmark: _Hlk177553838]You can also click the File menu and the Select Beginning Date or Select Ending Date option.

[image: Screenshot of NPPD Detail Display File menu options]

Shortcut: Press the <Ctrl> key + <B> key for the Beginning Date and the 
<Ctrl> key + <E> key for the Ending Date to display the respective calendars.



	[bookmark: _Hlk177547802]Calendar for date range selection
	[image: Calendar for date range selection]



[bookmark: _Hlk177553839]Continued on next page
[bookmark: _Hlk177553841][bookmark: _Hlk177553840]
Enter a Date Range, Continued

	[bookmark: _Hlk177547803]Selecting a date range
	The calendars display with the current date circled in red shown at the bottom of the calendar. You can accept the current date by clicking on it. You can also change the date by the following methods:



	[bookmark: _Hlk177553842][bookmark: _Hlk177547804]Change the…
	Description

	[bookmark: _Hlk177553843]Day
	Click on the actual day of the week in the calendar.

	[bookmark: _Hlk177553844]Month
	Click on the month at the top of the calendar to display a list of all months and select one from there. You can decrease or increase one month at a time by clicking the left or right arrows.

	[bookmark: _Hlk177553845]Year
	Click on the year and an up and down arrow button displays for you to increase or decrease the year.



	[bookmark: _Hlk177547805]Number of Day Restrictions
	You are restricted to a date range of less than 100 days. If you select a date range outside of this 100 day parameter, the following dialog message box displays:



	[bookmark: _Hlk177547806]Date Range Message box
	[image: Screenshot of Date Range message box]



	[bookmark: _Hlk177547807]Start Date before End Date
	If you accidentally entered an incorrect date range, you will receive a warning message. For instance, if you enter a start date that is after the end date, the message below will display. Click the OK button and reselect your date range.



	[bookmark: _Hlk177547808]Start/End Date Message
	[image: Screenshot of Start/End date message]


[bookmark: _Hlk177553846][bookmark: _Toc24938078][bookmark: _Toc172537342][bookmark: _Toc177550933]
Display the Data

	[bookmark: _Hlk177547809]Display the data
	[bookmark: _Hlk177553847]Once you have selected the date ranges, click the Display button to reveal the data within that date range. (You can also click the File Menu and the Display option.)

Shortcut: Press the <Ctrl> key + <D> key.



	[bookmark: _Hlk177547810]Changing the display of the data…
	[bookmark: _Hlk177553848]You can manipulate the layout of the view in the NPPD Detail Display window for both viewing as well as printing purposes. 

[bookmark: _Hlk177553849]You can manipulate the view of the data as follows:

· [bookmark: _Hlk177553850]To move a column, click and drag on a column header to another location. 
· [bookmark: _Hlk177553851]To enlarge a column, click and drag a cell border.
· [bookmark: _Hlk177553852]To sort on any column, click on the header to sort it in ascending order. 
· If you click on the same column again, it will sort it in descending order.



	[bookmark: _Hlk177547811]NPPD Detail Display
	[image: NPPD Detail Display]



	[bookmark: _Hlk177547812]Patient confidentiality
	The Patient column and the SSN column have been shortened due to patient name and SSN confidentiality issues in documentation. 



[bookmark: _Toc172537343][bookmark: _Toc177550934][bookmark: _Hlk177553853][bookmark: _Toc24938079]Select Custom Data

	[bookmark: _Hlk177547813]Custom Data
	[bookmark: _Hlk177553854]The Select custom data? drop-down lists allow you to select new columns to display. They also would convert into a Microsoft Excel file. These are optional prompts as you are not required to select any options. This is the main file for prosthetic purchasing transactions. This file is also the permanent record for the patient VAF 10-2319 of items issued to the veteran.

[bookmark: _Hlk177553855]This list gives you the option to add information that was entered during the purchase order creation process to your NPPD Detail Report. For instance, if you added a Waiver or Excluded, you can view that data here.

Note: Custom data will display in the column to the right and you will have to scroll to the right to view it. If you do not see the new column, click the Display button. 



	Select Custom Data
	[image: Select Custom Data drop-down lists]



	[bookmark: _Hlk177547815]MS Excel
	If you selected custom data and convert it to an MS Excel file (using the Excel button), you will view the custom data on the Excel spreadsheet as you scroll to the right.


[bookmark: _Hlk177553856]Select Custom Data, Continued

	[bookmark: _Hlk177547816]Data fields
	Below is a list of the Custom Data fields and a description of each.



[bookmark: _Hlk177553857]01	ENTRY DATE
[bookmark: _Hlk177553858]This is the date that the transaction was entered into the system. It may or may not be the same as the request date. 

[bookmark: _Hlk177553859]02	PATIENT NAME 
[bookmark: _Hlk177553860]This is the name of the patient that this transaction is for. The name is a pointer to the PROSTHETIC PATIENT file which has the same internal entry number as the main patient database. 

[bookmark: _Hlk177553861]1	DATE ITEM ADDED TO PO AFTER CREATION
[bookmark: _Hlk177553862]This field is the date the appliance issue or repair was requested by the patient. It may or may not be the same as the entry date or the delivery date. This depends on how quickly the transactions take place. 

[bookmark: _Hlk177553863]2	TYPE OF TRANSACTION
[bookmark: _Hlk177553864]This set of codes will tell what kind of transaction this request is. The possibilities all fall under the VAF 10-7306a listings except for the repair. 

[bookmark: _Hlk177553865]4	ITEM
[bookmark: _Hlk177553866]This field is a pointer to the master item list of possible appliances. The master list is set up so that appliances fall into groups which are the types of appliances. 

[bookmark: _Hlk177553867]4.1	HCPCS
[bookmark: _Hlk177553868]Health Care Financing Administration Common Procedure Coding System (HCPCS). 
[bookmark: _Hlk177553869]This field should have the HCPCS code for the Item you are selecting. HCPCS is a uniform method for healthcare providers and medical suppliers to report professional services, procedures and supplies. 

[bookmark: _Hlk177553870]4.2	VENDOR TRACKING NUMBER
[bookmark: _Hlk177553871]This field is the Vendor's internal unique tracking number. Some of the small vendors are not automated with VISA, and this tracking number is used to reference this transaction. This tracking number is based on the item, and can be as simple as the vendors item number, or elaborate as the vendors transaction number. This data will be used in the reconciliation process. 

[bookmark: _Hlk177553872]4.3	BANK AUTHORIZATION NUMBER
[bookmark: _Hlk177553873]This six digit number is the authorization number VISA gives to the vendor for guaranteed payment. This number is used in the reconciliation process. 
[bookmark: _Hlk177553874]
[bookmark: _Hlk177553875]4.4	ICD9 CODE 
[bookmark: _Hlk177553876]Repository for CPRS diagnosis. From the message protocol in Consult Tracking. Standardized Prosthetics HCPCS. 

[bookmark: _Hlk177553877]4.6	STOCK ISSUE
[bookmark: _Hlk177553878]This is a pointer to file #661.2. 

[bookmark: _Hlk177553879]Continued on next page
[bookmark: _Hlk177553881][bookmark: _Hlk177553880]
 Select Custom Data, Continued

[bookmark: _Hlk177553882]4.7	CPT MODIFIER
[bookmark: _Hlk177553883]CPT Modifiers in a comma delimited format, consistent with the HCFA published manuals. 

[bookmark: _Hlk177553884]4.8	DATE CPT MODIFIER EXTRACTED
[bookmark: _Hlk177553885]This is the date the patient record extracted for billing. This date is also being used to trigger a mail message to billing if the PSAS HCPCS is edited and changed after the extraction has been ran. 

[bookmark: _Hlk177553886]4.9	HCPCS-ICD9 CODING FLAG
[bookmark: _Hlk177553887]This field is used to determine the current code set versioning of a transaction. 

[bookmark: _Hlk177553888]4.91	CODING FLAG DATE 
[bookmark: _Hlk177553889]This is the date associated with field number 4.9. The date the coding flag was set. 

[bookmark: _Hlk177553890]5	QTY
[bookmark: _Hlk177553891]This is the number of units that was issued or repaired for this transaction. 

[bookmark: _Hlk177553892]6	SHIP/DEL 
[bookmark: _Hlk177553893]This is the charge associated with shipping. 

[bookmark: _Hlk177553894]6.5	PICKUP/DEL
[bookmark: _Hlk177553895]This field is a set of codes to identify pickup/delivery charges on VAF 10-2319. 

[bookmark: _Hlk177553896]7	VENDOR
[bookmark: _Hlk177553897]The vendor is a pointer to IFCAP's VENDOR file and is the name of the company from which this appliance was or is to be purchased. The vendor may or may not be the same as the manufacturer. Therefore, manufacturers should also be listed in this file as vendors if you are going to be purchasing directly from the manufacturer. 

[bookmark: _Hlk177553898]8	STATION
[bookmark: _Hlk177553899]The station is the Veterans Affairs site where this transaction is to come to completion. It is the station that is ultimately responsible for the issue and payment for the prosthetic device. This is the station reporting the workload. 

[bookmark: _Hlk177553900]8.1	SUSPENSE DATE 
[bookmark: _Hlk177553901]This is suspense date (.01 field). 

[bookmark: _Hlk177553902]8.11	SUSPENSE STATION
[bookmark: _Hlk177553903]This refers to the consulting station. 
[bookmark: _Hlk177553904]
[bookmark: _Hlk177553905]8.12	PCE 
[bookmark: _Hlk177553906]This field is pointer to (Patient Encounter). When an entry is created in PCE a pointer is being set. 

[bookmark: _Hlk177553907]8.13	DATE SENT TO PCE
[bookmark: _Hlk177553908]This is the date last sent or edited in PCE. If PCE is deleted this field should be deleted. 

[bookmark: _Hlk177553909]Continued on next page
[bookmark: _Hlk177553911][bookmark: _Hlk177553910]
 Select Custom Data, Continued
 
[bookmark: _Hlk177553912]8.14	SUSPENSE STATUS 
[bookmark: _Hlk177553913]This is the suspense status of the patient 2319 record. If the status is complete, a suspense link was established. If the status is incomplete, there is no suspense link to the patient 2319 record. 

[bookmark: _Hlk177553914]8.2	DATE RX WRITTEN
[bookmark: _Hlk177553915]This is the date the prescription was written. 

[bookmark: _Hlk177553916]8.3	INITIAL ACTION DATE 
[bookmark: _Hlk177553917]This field is the date when an initial action was entered in suspense. 

[bookmark: _Hlk177553918]8.4	COMPLETION DATE
[bookmark: _Hlk177553919]This is the date the suspense was completed. 

[bookmark: _Hlk177553920]8.5	TYPE OF REQUEST
[bookmark: _Hlk177553921]This field could either be ROUTINE PROSTHETICS, EYEGLASS, CONTACT LENS, OXYGEN, MANUAL NONCPRS or CLOTHING ALLOWANCE. 

[bookmark: _Hlk177553922]8.6	SUSPENSE REQUESTOR
[bookmark: _Hlk177553923]This is a pointer to file #200, the person requesting the suspense as it appears in file #668. 

[bookmark: _Hlk177553924]8.61	CONSULT REQUEST SERVICE 4
[bookmark: _Hlk177553925]A service/section of a suspense requestor that initiated a consult for Prosthetics item. This free text entry is a service/section name of SERVICE/SECTION. 

[bookmark: _Hlk177553926]8.7	PROVISIONAL DIAGNOSIS 
[bookmark: _Hlk177553927]This is a free text diagnosis as it appears in suspense file. 

[bookmark: _Hlk177553928]8.8	SUSPENSE ICD9 
[bookmark: _Hlk177553929]This is the code at the time suspense was created. 

[bookmark: _Hlk177553930]8.9	CONSULT
[bookmark: _Hlk177553931]This is a pointer to Consult file. 

[bookmark: _Hlk177553932]9	SERIAL NBR 
[bookmark: _Hlk177553933]This is the serial number of the issued or repaired appliance. If the serial number is longer than 20 characters, use the FIRST 20 characters. 

[bookmark: _Hlk177553934]9.1	PRODUCT DESCRIPTION
[bookmark: _Hlk177553935]The manufacture product description to be used for recalls. 
[bookmark: _Hlk177553936]
[bookmark: _Hlk177553937]9.2	PRODUCT MODEL
[bookmark: _Hlk177553938]The manufacture product model number to be used for recalls. 

[bookmark: _Hlk177553939]Continued on next page
[bookmark: _Hlk177553941][bookmark: _Hlk177553940]
 Select Custom Data, Continued
 
[bookmark: _Hlk177553942]10	DELIVERY DATE 
[bookmark: _Hlk177553943]This is the date that the appliance was delivered and accepted by the patient. This date, under certain circumstances, may be a date that the appliance was mailed to the patient. It may or may not be the same as the transaction date and/or the request date. 

[bookmark: _Hlk177553944]11	FORM REQUESTED ON
[bookmark: _Hlk177553945]The FORM REQUESTED ON is based on current VA regulations. The system makes no checks to be sure that the form entered from the set of codes is within these regulations. 

[bookmark: _Hlk177553946]'1' FOR PSC
[bookmark: _Hlk177553947]'2' FOR 2421
[bookmark: _Hlk177553948]'3' FOR 2237
[bookmark: _Hlk177553949]'4' FOR 2529-3
[bookmark: _Hlk177553950]'5' FOR 2529-7
[bookmark: _Hlk177553951]'6' FOR 2474
[bookmark: _Hlk177553952]'7' FOR 2431
[bookmark: _Hlk177553953]'8' FOR 2914
[bookmark: _Hlk177553954]'9' FOR OTHER
[bookmark: _Hlk177553955]'10' FOR 2520
[bookmark: _Hlk177553956]'11' FOR STOCK ISSUE
[bookmark: _Hlk177553957]'12' FOR INVENTORY ISSUE
[bookmark: _Hlk177553958]'13' FOR HISTORICAL DATA
[bookmark: _Hlk177553959]'14' FOR VISA
[bookmark: _Hlk177553960]'15' FOR LAB ISSUE-3

[bookmark: _Hlk177553961]12	SOURCE 
[bookmark: _Hlk177553962]This set of codes denotes which two possible sources were used for the acquisition of the appliance. The sources are grouped into either VA sources or commercial sources. 

[bookmark: _Hlk177553963]13	ACTION
[bookmark: _Hlk177553964]The action taken on this transaction is noted here. The set of codes is self explanatory; however, the inactive action is used to indicate that the appliance is no longer being followed by VA. 
[bookmark: _Hlk177553965]QTY:
[bookmark: _Hlk177553966]'1' FOR LOAN
[bookmark: _Hlk177553967]'2' FOR CONDEMNED
[bookmark: _Hlk177553968]'3' FOR RETURNED
[bookmark: _Hlk177553969]'4' FOR INACTIVE
[bookmark: _Hlk177553970]'5' FOR LOST

[bookmark: _Hlk177553971]14	TOTAL COST 
[bookmark: _Hlk177553972]This field contains the total cost of the transaction. 

[bookmark: _Hlk177553973]Continued on next page
[bookmark: _Hlk177553975][bookmark: _Hlk177553974]
 Select Custom Data, Continued
 
[bookmark: _Hlk177553976]15	HISTORICAL DATA
[bookmark: _Hlk177553977]If this field contains an asterisk (*), then this transaction has been counted by the AMIS option, or is considered to be a historical transaction. 

[bookmark: _Hlk177553978]16	REMARKS 
[bookmark: _Hlk177553979]A free-text field used to indicate any additional information that is needed for this entry. For Purchasing Transactions this field will contain the remarks for the individual item, and the close-out remarks added together. 

[bookmark: _Hlk177553980]17	RETURNED STATUS
[bookmark: _Hlk177553981]The status of the appliance upon return to the veteran. This notes what action was taken by the repair depot or station upon the completion of repairs. 
[bookmark: _Hlk177553982]'1' FOR RETURNED
[bookmark: _Hlk177553983]'2' FOR CONDEMNED
[bookmark: _Hlk177553984]'3' FOR CANCELLED
[bookmark: _Hlk177553985]'4' FOR TURNED-IN
[bookmark: _Hlk177553986]'5' FOR LOST
[bookmark: _Hlk177553987]'6' FOR BROKEN

[bookmark: _Hlk177553988]17.5	RETURN STATUS DATE
[bookmark: _Hlk177553989]This is the date upon which the return status was determined and carried out if the item was returned to the veteran. 

[bookmark: _Hlk177553990]18	*STATUS FLAG
[bookmark: _Hlk177553991]The status of the patient is entered here so the service can determine if the patient is being followed, dropped, transferred, or canceled by this station. 

[bookmark: _Hlk177553992]21	LOT NUMBER 
[bookmark: _Hlk177553993]This field stores the lot number of the item being furnished to the patient. Enter the manufacturer's lot number, if known. 

[bookmark: _Hlk177553994]22	*PRODUCT LINE 
[bookmark: _Hlk177553995]Set of codes that contain information for Hearing Aid transactions. 
[bookmark: _Hlk177553996]'1' FOR HEARING AIDS
[bookmark: _Hlk177553997]'2' FOR BATTERIES
[bookmark: _Hlk177553998]'3' FOR OTHER

[bookmark: _Hlk177553999]23	TRANSACTION
[bookmark: _Hlk177554000]This is the IFCAP transaction number from VAF 4-1358 or VAF 2237. A temporary Transaction number for a VAF 10-2529-3 may also be entered. 

[bookmark: _Hlk177554001]24	DESCRIPTION
[bookmark: _Hlk177554002]This is a detailed description of the item/service supplied. 

[bookmark: _Hlk177554003]Continued on next page
[bookmark: _Hlk177554005][bookmark: _Hlk177554004]
 Select Custom Data, Continued

[bookmark: _Hlk177554006]25	DELIVER TO
[bookmark: _Hlk177554007]Delivery location that will print on VAF 10-2421 to show the vendor where the item will be delivered. 

[bookmark: _Hlk177554008]27	INITIATOR
[bookmark: _Hlk177554009]This is the person who created the transaction. 

[bookmark: _Hlk177554010]28	EXTENDED DESCRIPTION
[bookmark: _Hlk177554011]This is the extended information from purchasing and also from posting of VAF 2237s. 

[bookmark: _Hlk177554012]29	INVENTORY POINT 
[bookmark: _Hlk177554013]This is the inventory point for this transaction and is a pointer to the GENERIC INVENTORY. 

[bookmark: _Hlk177554014]31	BILL DATE
[bookmark: _Hlk177554015]This is the DATE/TIME the bill is created. 

[bookmark: _Hlk177554016]32	BILL STATUS
[bookmark: _Hlk177554017]This is the status of a bill in relation to Integrated Billing. 
[bookmark: _Hlk177554018]'1' FOR ENTERED/NOT REVIEWED
[bookmark: _Hlk177554019]'2 ' FOR REVIEWED
[bookmark: _Hlk177554020]'3' FOR AUTHORIZED
[bookmark: _Hlk177554021]'4' FOR PRINTED
[bookmark: _Hlk177554022]'5' FOR TRANSMITTED
[bookmark: _Hlk177554023]'7' FOR CANCELLED
[bookmark: _Hlk177554024]'0' FOR CLOSED

[bookmark: _Hlk177554025]33	BILL IEN
[bookmark: _Hlk177554026]This is the bill IEN in file #399. 

[bookmark: _Hlk177554027]35	USER WHO EDIT
[bookmark: _Hlk177554028]User who edited the 2319 record using option ED2. This field will only be populated when the Total Cost field has been changed. 

[bookmark: _Hlk177554029]36	DATE EDITED
[bookmark: _Hlk177554030]This is the date the Total Cost field has been changed using option ED2. 

[bookmark: _Hlk177554031]37	HCPCS/ITEM
[bookmark: _Hlk177554032]This is the PIP HCPCS unique item.

[bookmark: _Hlk177554033]38	HCPCS/ITEM DESCRIPTION
[bookmark: _Hlk177554034]This is the description of an Item or Appliance kept by local site.
[bookmark: _Hlk177554035]This field is updated during the STOCK ISSUE options. 

[bookmark: _Hlk177554036]Continued on next page
[bookmark: _Hlk177554038][bookmark: _Hlk177554037]
 Select Custom Data, Continued

[bookmark: _Hlk177554039]38.1	EXCLUDE/WAIVER
[bookmark: _Hlk177554040]This field determines if the item is EXCLUDED or Waiver off of a National Contract.
[bookmark: _Hlk177554041]'E' FOR EXCLUDED
[bookmark: _Hlk177554042]'W' FOR WAIVER

[bookmark: _Hlk177554043]38.7	CONTRACT # 
[bookmark: _Hlk177554044]This field stores the Contract Number. 

[bookmark: _Hlk177554045]40	REQUESTING STATION
[bookmark: _Hlk177554046]This is the station requesting services or appliances. 

[bookmark: _Hlk177554047]45	TOTAL LABOR HOURS
[bookmark: _Hlk177554048]This is the number of hours spent on the job. This field is only populated via routines. 

[bookmark: _Hlk177554049]46	TOTAL LABOR COST
[bookmark: _Hlk177554050]The total cost of the labor to perform this job. 

[bookmark: _Hlk177554051]47	TOTAL MATERIAL COST
[bookmark: _Hlk177554052]The total cost of all the materials to perform the job. 

[bookmark: _Hlk177554053]48	TOTAL LAB COST
[bookmark: _Hlk177554054]The Prosthetic Laboratory Total Cost calculated by AMIS. 

[bookmark: _Hlk177554055]50	COMPLETION DATE
[bookmark: _Hlk177554056]The date the job was completed. 

[bookmark: _Hlk177554057]51	LAB REMARKS
[bookmark: _Hlk177554058]A free-text field used to indicate any additional Laboratory information that is needed for this entry. Since the field is only 40 characters in length, use meaningful abbreviations where possible. 

[bookmark: _Hlk177554059]52	AMIS NEW CODE 
[bookmark: _Hlk177554060]This field is set when AMIS is generated. It is the New Worksheet AMIS code. 

[bookmark: _Hlk177554061]60	AMIS DATE
[bookmark: _Hlk177554062]The date AMIS was run and the item was picked up and counted. 

[bookmark: _Hlk177554063]62	PATIENT CATEGORY
[bookmark: _Hlk177554064]This is the Prosthetic Patient Category used for counting AMIS. 
[bookmark: _Hlk177554065]'1' FOR SC/OP
[bookmark: _Hlk177554066]'2' FOR SC
[bookmark: _Hlk177554067]'3' FOR NSC
[bookmark: _Hlk177554068]'4' FOR NSC/OP

[bookmark: _Hlk177554069]Continued on next page
[bookmark: _Hlk177554071][bookmark: _Hlk177554070]
 Select Custom Data, Continued

[bookmark: _Hlk177554072]63	SPECIAL CATEGORY
[bookmark: _Hlk177554073]If the patient is NSC/OP, then this field must also be set. SPECIAL CATEGORY is also used in counting AMIS. 
[bookmark: _Hlk177554074]'1' FOR SPECIAL LEGISLATION
[bookmark: _Hlk177554075]'2' FOR A&A
[bookmark: _Hlk177554076]'3' FOR PHC
[bookmark: _Hlk177554077]'4' FOR ELIGIBILITY REFORM

[bookmark: _Hlk177554078]64	ADMIN REPAIR AMIS CODE AM 
[bookmark: _Hlk177554079]This field will be set when AMIS is generated for the Repair Worksheets. 

[bookmark: _Hlk177554080]68	AMIS GROUPER
[bookmark: _Hlk177554081]This is used in AMIS calculations. This field should never be changed through FileMan! 

[bookmark: _Hlk177554082]69	SOURCE OF PROCUREMENT LB
[bookmark: _Hlk177554083]The source from which the Purchasing Agent is ordering the needed equipment. The sources one may choose from are limited. 
[bookmark: _Hlk177554084]'O' FOR ORTHOTIC LAB
[bookmark: _Hlk177554085]'R' FOR RESTORATION LAB
[bookmark: _Hlk177554086]'S' FOR SHOE LAST CLINIC
[bookmark: _Hlk177554087]'W' FOR WHEELCHAIR REPAIR SHOP
[bookmark: _Hlk177554088]'N' FOR NATIONAL FOOT CENTER
[bookmark: _Hlk177554089]'D' FOR DENVER DISTRIBUTION CENTER

[bookmark: _Hlk177554090]70	RECEIVING STATION
[bookmark: _Hlk177554091]This field contains the institution that will receive the VAF 10-2529-3 request for processing. 

[bookmark: _Hlk177554092]71	WORK ORDER NUMBER
[bookmark: _Hlk177554093]Work Order Number (STA-FY-QTR-TYPE OF LAB-NUMBER) for items processed in the Prosthetic Laboratory. 

[bookmark: _Hlk177554094]72	2529-3 
[bookmark: _Hlk177554095]VAF 10-2529-3 information will be displayed if the VAF 10-2319 item is associated with a Denver Distribution Center, National Foot Center, or Prosthetics Lab request. 

[bookmark: _Hlk177554096]73	LAB AMIS DATE
[bookmark: _Hlk177554097]Last date the Lab AMIS was run. 

[bookmark: _Hlk177554098]74	ORTHOTICS LAB CODE
[bookmark: _Hlk177554099]Contains the Orthotic Lab New Code. 

[bookmark: _Hlk177554100]75	ORTHOTICS LAB REPAIR CODE LBA
[bookmark: _Hlk177554101]Contains the Orthotic Lab Repair Code. 

[bookmark: _Hlk177554102]Continued on next page
[bookmark: _Hlk177554104][bookmark: _Hlk177554103]
 Select Custom Data, Continued
 
[bookmark: _Hlk177554105]76	RESTORATION LAB CODE LBA
[bookmark: _Hlk177554106]Contains the Restoration Lab New Code. 

[bookmark: _Hlk177554107]77	RESTORATIONS LAB REPAIR CODE LBA
[bookmark: _Hlk177554108]Contains the Restoration Lab Repair Code. 

[bookmark: _Hlk177554109]78	UNIT OF ISSUE 
[bookmark: _Hlk177554110]This is the unit by which items/services are issued (e.g., each, pair, box, case, etc.). 

[bookmark: _Hlk177554111]79	AMIS FLAG
[bookmark: _Hlk177554112]Contains the status if the Item will not count on the Administrative AMIS. 

[bookmark: _Hlk177554113]80	WORK FOR OTHER STATION LB
[bookmark: _Hlk177554114]Contains the Status if the Job Performed will display as work performed for another station. 
[bookmark: _Hlk177554115]'1' FOR YES

[bookmark: _Hlk177554116]81	NO ADMIN COUNT 
[bookmark: _Hlk177554117]This field will be set if the Item will not count on the Administrative AMIS or the Orthotic Laboratory AMIS. 
[bookmark: _Hlk177554118]'1' FOR NO COUNT

[bookmark: _Hlk177554119]82	NO LAB COUNT 
[bookmark: _Hlk177554120]Field will be set if there is no AMIS Count for AMIS. 
[bookmark: _Hlk177554121]'1' FOR NO COUNT

[bookmark: _Hlk177554122]83	BACKLOG DATE
[bookmark: _Hlk177554123]This field will contain the date that the entry was created. This entry will be a backlog entry until it has been completed. All backlog data must show up on the Laboratory or Restoration AMIS Count. 

[bookmark: _Hlk177554124]89	HISTORICAL ITEM
[bookmark: _Hlk177554125]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554126]90	HISTORICAL STATION
[bookmark: _Hlk177554127]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554128]91	HISTORICAL VENDOR
[bookmark: _Hlk177554129]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554130]92	HISTORICAL VENDOR PHONE HSTV
[bookmark: _Hlk177554131]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554132]Continued on next page
[bookmark: _Hlk177554134][bookmark: _Hlk177554133]
 Select Custom Data, Continued

[bookmark: _Hlk177554135]93	HISTORICAL STREET ADD 
[bookmark: _Hlk177554136]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554137]94	HISTORICAL CITY 
[bookmark: _Hlk177554138]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554139]95	HISTORICAL STATE 
[bookmark: _Hlk177554140]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554141]96	HISTORICAL ZIP
[bookmark: _Hlk177554142]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 

[bookmark: _Hlk177554143]97	HISTORICAL RECORD
[bookmark: _Hlk177554144]This field is used for the consolidation sites, will contain the data that has been merged from a legacy system. This field is populated by the RMPRJ routine that is not exported. 


[bookmark: _Toc172537344]

[bookmark: _Toc177550935][bookmark: _Hlk177554145]Print the NPPD Detail

	[bookmark: _Hlk177547817]Print the data
	[bookmark: _Hlk177554146]You can print the NPPD Detail Display data. Click the Print button to send this data to your local printer, and click OK on the Print dialog box. (You can also click the File Menu and the Print option.)

[bookmark: _Hlk177554147]Shortcut: Press the <Ctrl> key + <P> key.

[bookmark: _Hlk177554148]The layout of the print will be the same as the display.

Note: You can select a printer to print the NPPD detail. 



	[bookmark: _Hlk177547818]Change to Landscape
	Recommendation: You should change the format of the printout from Portrait to Landscape to print all the columns on the same page.  



	[bookmark: _Hlk177547819]Steps
	To change the print format, follow these steps:



	[bookmark: _Hlk177554149][bookmark: _Hlk177547820]Step
	Action

	[bookmark: _Hlk177554150]1
	Click the Print button on the NPPD Detail Display window. 

	[bookmark: _Hlk177554151]2
	[bookmark: _Hlk177554152]Click the Properties button (to the right of the Name field) on the Print dialog box. 

Shortcut: Press the <Alt> key + <P> key.

	[bookmark: _Hlk177554153]3
	Continue to the next page.



	[bookmark: _Hlk177547821]Print dialog box
	[image: Screenshot of Print dialog box]


[bookmark: _Hlk177554155][bookmark: _Hlk177554154]
Print the NPPD Detail, Continued

	[bookmark: _Hlk177547822]Layout Tab
	You can change the format of the printout from the standard Portrait format to Landscape on the Layout tab. 



	[bookmark: _Hlk177547823]Steps (continued)
	To continue to change to the Landscape format, follow these steps:



	[bookmark: _Hlk177554156][bookmark: _Hlk177547824]Step
	Action

	[bookmark: _Hlk177554157]4
	Click the Layout tab on the Properties dialog box (usually shown as a default view). 

	[bookmark: _Hlk177554158]5
	[bookmark: _Hlk177554159]Click the Landscape radio button to change the format. 

Shortcut: Press the <Alt> key + <L> key.

	[bookmark: _Hlk177554160]6
	Click OK or press <Enter.>



	[bookmark: _Hlk177547825]Landscape Radio button
	[image:  Screenshot of Landscape orientation radio button]



	[bookmark: _Hlk177547826]Last step
	When you return to the Print dialog box, click OK again, and it will print your output. You can print multiple copies if necessary. 



[bookmark: _Hlk177554161][bookmark: _Toc172537345][bookmark: _Toc177550936][bookmark: _Toc44299366]
Save as an Excel File

	[bookmark: _Hlk177547827]Excel Button
	[bookmark: _Hlk177554162]Click the Excel button on the NPPD Detail Display window to launch Excel and display the current data. (You can also click the File menu and select the Excel option.)

[bookmark: _Hlk177554163]Shortcut: Press the <Alt> key + <X> key to launch MS Excel.

[bookmark: _Hlk177554164]Note: This feature creates a temporary Excel .CSV file in the folder selected. The default folder is C:\NPPDDownload (which is automatically created). The file name is based on the date range.

[bookmark: _Hlk177554165]Example: Jul 02, 2006_Aug 10, 2006.csv

[bookmark: _Hlk177554166]Prior to the display, you are notified that the information about to be exported may contain Patient Identifiable Information. 




	[bookmark: _Hlk177547828]Steps
	To export data to Excel:



	[bookmark: _Hlk177554167][bookmark: _Hlk177547829]Step
	Action

	[bookmark: _Hlk177554168]1
	[bookmark: _Hlk177554169]Click the Excel button on the NPPD Detail Display window. 

Shortcut: Press the <Alt> key + <X> key. 

	[bookmark: _Hlk177554170]2
	Click the OK button on the security reminder.

	[bookmark: _Hlk177554171]3
	Continue to the Select Directory window.


 
	[bookmark: _Hlk177547830]Security Reminder
	[image: Security Reminder popup]





	[bookmark: _Hlk177554172][bookmark: _Hlk177547831]Step
	Action

	[bookmark: _Hlk177554173]4
	Navigate to the desired directory and select OK .(Click Cancel to exit or Help to view the help pages associated with this functionality) 


[bookmark: _Hlk177554174]
	[bookmark: _Hlk177547832]Select Directory
	[image: Screenshot of directory selection window]



	[bookmark: _Hlk177554175][bookmark: _Hlk177547833]Step
	Action

	[bookmark: _Hlk177554176]5
	Navigate to a secure location where the temporary Excel (.csv) file will be stored and then select OK . Excel will open and display the data. 




	[bookmark: _Hlk177547834]MS Excel data
	[image: File name based on date range]





	[bookmark: _Hlk177554177][bookmark: _Hlk177547835]Step
	Action

	[bookmark: _Hlk177554178]6
	[bookmark: _Hlk177554179]This is only a temporary file so if you wish to save the data you must select File, then Save As, then change the name of the file.

Note: To save the file, you must change the filename from the default. If you accept the default file name, it will be deleted when you close the NPPD window.



	[bookmark: _Hlk177547836]
	

	[bookmark: _Hlk177554180][bookmark: _Hlk172534523]Temp file location
	[bookmark: _Hlk177554181]Should you wish to check the location of the temp file, it displays on the NPPD Detail Display window right above the Excel button.

[image: Temp file location]


	
	

	[bookmark: _Hlk177554182]**Note**
	You will be unable to export another report to Excel or navigate away from the NPPD Detail Display window until the current Excel (.csv) file is closed. Attempting to do so without first closing the file will result in one of the following errors depending on what action has taken place. If you do save a file with Patient Identifiable Info in it, don’t forget to delete it when you no longer need it. 



	[bookmark: _Hlk177547839]Attempting to Open another report with temp file still open
	[image: Screenshot of error message warning to close temporary Excel files before continuing]



	[bookmark: _Hlk177547840]Attempting to navigate away from the NPPD Detail Display window with temp file still open
	[image: Screenshot of error message warning to close temporary Excel files before navigating from this form]




[bookmark: _Hlk177554183][bookmark: _Toc172537346][bookmark: _Toc177550937]
Exiting the NPPD Detail Display Window

	[bookmark: _Hlk177547841]Exit the Window
	You can exit the application by first clicking the Menu button on the NPPD Detail Display window. This closes the NPPD Detail Display window.



	[bookmark: _Hlk177547842]NPPD Detail Display “Menu” button
	[image: NPPD Detail Display Menu button]



	[bookmark: _Hlk177547843]Exit the Application
	Then click the Close button on the Prosthetics Main Menu window:





	[bookmark: _Hlk177547844]
	



	[bookmark: _Hlk177547845]Main Menu “Close” button
	[image: Prosthetics Suite Main Menu]



	[bookmark: _Hlk177547846]Confirmation window
	Click OK on the confirmation window to close the Prosthetics VistA Suite. 



	[bookmark: _Hlk177547847]
	[image: Screenshot of Confirmation window]



	[bookmark: _Hlk177547848]Cancel button
	If you click the Cancel button, you will remain in the application and can continue to work.
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[bookmark: _Hlk177554184]
[bookmark: _Toc172537347][bookmark: _Toc177550938][bookmark: _Hlk177554185][bookmark: _Toc172537348]Section 3: Automated Delayed Order Report (DOR)
[bookmark: _Toc44299367][bookmark: _Toc172537349][bookmark: _Toc177550939][bookmark: _Hlk177554186]Overview

	[bookmark: _Hlk177547849]Introduction
	[bookmark: _Hlk177554187]The Delayed Order Report (DOR) User Manual corresponds to Patch RMPR*3*59. This patch provides Prosthetics GUI (graphical user interface) windows for the Delayed Order Report (DOR) feature. 

[bookmark: _Hlk177554188]Note: Using this feature requires basic MS Windows skills.

[bookmark: _Hlk177554189]Prosthetics users can do the following with this patch:

· [bookmark: _Hlk177554190]Search for and display manual suspense entries/electronic consult (CPRS order) data by one or all sites

· [bookmark: _Hlk177554191]Display data using one or multiple statuses (Open, Pending, Cancelled or Closed)

· [bookmark: _Hlk177554192]Use a starting date for Closed and Cancelled records to display data

· [bookmark: _Hlk177554193]Sort and rearrange the view; display data in a custom view

· [bookmark: _Hlk177554194]Print the display

· Convert the display into a Microsoft Excel file (for more sorting capabilities)



	[bookmark: _Hlk177547850]Working Days
	A delayed order is counted in Working days not Calendar days. This does NOT include Saturdays and Sundays or Holidays!!!



	[bookmark: _Hlk177547851]Record Status
	[bookmark: _Hlk177554195]The Status column shows the following status types:

1. [bookmark: _Hlk177554196]Open
2. [bookmark: _Hlk177554197]Pending
3. [bookmark: _Hlk177554198]Closed
4. Cancelled


[bookmark: _Hlk177554200][bookmark: _Hlk177554199]
Overview, Continued

	[bookmark: _Hlk177547853]Status cycle
	[bookmark: _Hlk177554201]The Initial Action Date displays the date of the first action taken on the suspense entry/electronic consult (CPRS order) record. This changes the status from OPEN to PENDING. An order remains in PENDING status until it is fulfilled and then changes to a CLOSED status.

[bookmark: _Hlk177554202]Note: The status can change from OPEN to CLOSED if the order has been fulfilled upon the initial action.

[bookmark: _Hlk177554203]Keep in mind that when creating the first action note, the status changes from OPEN to PENDING and when creating the second or additional action note(s), the status remains PENDING. Only when a record is completed does the status change to CLOSED.

When a complete note is posted, all action has taken place for a requested Prosthetic item or service. When you post the complete note, the status on the record changes from PENDING (if action has previously taken place on the request) or OPEN to a CLOSED status.


 
	[bookmark: _Hlk177547854]Work Days, not Calendar Days
	[bookmark: _Hlk177554204]The Delayed Order Report displays the number of “Work“ days (not Calendar days) from the original date the order was entered as an electronic consult or a suspense entry to the day it is completed. A “Work” day is defined as Monday through Friday.

Note: The calculation subtracts Saturdays and Sundays and Holidays from the number of days the order was entered, even if a CPRS order was written over a weekend. Holidays are NOT counted. 



[bookmark: _Hlk177554205][bookmark: _Toc44299368][bookmark: _Toc172537350][bookmark: _Toc177550940]
Display the DOR Data
[bookmark: _Toc44299369][bookmark: _Toc172537351][bookmark: _Toc177550941][bookmark: _Hlk177554206]Introduction

	[bookmark: _Hlk177547855]General steps to view DOR Data
	[bookmark: _Hlk177554207]To utilize the Delayed Order Report (DOR) data, here is a general set of steps to display DOR data as follows:

1. [bookmark: _Hlk177554208]Select ALL sites by checking the “Or…All Sites” checkbox (or you can select a specific site from the drop down list).
2. [bookmark: _Hlk177554209]Enter a Starting Date (defaults to the current date).
3. [bookmark: _Hlk177554210]Select a Status if you want to change the default statuses. The default statuses are set to Open, Pending, and Closed.
4. [bookmark: _Hlk177554211]Enter the SSN range of the patient display (mandatory).
5. Click the Display button.



	[bookmark: _Hlk177547856]Description
	The Description is a free-text field that is manually entered with approximately 15 characters in length. If you can’t view the entire description, you can expand the column by clicking and dragging the borderline to a wider position.



	[bookmark: _Hlk177547857]Data displayed
	[bookmark: _Hlk177554212]The data that is displayed with this GUI feature includes the following: 

[bookmark: _Hlk177554213]Grid Columns:
· [bookmark: _Hlk177554214]Site
· [bookmark: _Hlk177554215]Delayed column (Yes or No)
· [bookmark: _Hlk177554216]Status of the order
· [bookmark: _Hlk177554217]Type of Order – Manual Suspense or Routine (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders)
· [bookmark: _Hlk177554218]Station number
· [bookmark: _Hlk177554219]Create Date (Suspense entry date)
· [bookmark: _Hlk177554220]First Action Date – Date that the order was put into PENDING status
· [bookmark: _Hlk177554221]Number of Days that the order has been delayed including columns for: 0-5, 6-9, 10-29, 30-90, and 90+ columns
· [bookmark: _Hlk177554222]Link information – linked message(s) to the order record
· [bookmark: _Hlk177554223]Brief description
· [bookmark: _Hlk177554224]Patient name
· [bookmark: _Hlk177554225]Social Security Number

[bookmark: _Hlk177554226]Fields:
[bookmark: _Hlk177554227]Selection Result Totals (near bottom of window) include:

· [bookmark: _Hlk177554228]Total records found
· [bookmark: _Hlk177554229]Total delayed records by calculation
· Percent delayed records by calculation



[bookmark: _Hlk177554230][bookmark: _Toc44299370][bookmark: _Toc172537352]
Select a Site(s)

	[bookmark: _Hlk177547858]Select Site
	The first thing you must do to view the DOR is to select a site for the records that you want to display. If you are a multi-site facility, you will be able to select the specific site you want to view via the drop down box. Recommendation: It is highly recommended that you select the “Or…All Sites” checkbox.



	[bookmark: _Hlk177547860]Steps
	To begin the process to display the DOR data, follow this first step:



	[bookmark: _Hlk177554231][bookmark: _Hlk177547861]Step
	Action

	[bookmark: _Hlk177554232]1
	Click the “Or…All Sites” checkbox to view ALL sites and CBOC data.



	[bookmark: _Hlk177547863]DOR window
	[image: Screenshot of DOR window]



	[bookmark: _Hlk177547865]Select “ALL Sites”
	If you want to view all available suspense entries/electronic consult orders including Community Based Outpatient Clinics (CBOC) data, click the All Sites checkbox instead of selecting your specific site from the Site drop-down list box. This ensures that the display will include all sites. For example, the Kenosha, Wisconsin CBOC will not display when the Milwaukee site is selected only. These records display when the All Sites checkbox is selected. 



[bookmark: _Hlk177554233][bookmark: _Toc44299371][bookmark: _Toc172537353][bookmark: _Toc177550942]
Select a Starting Date

	[bookmark: _Hlk177547866]Date/Calendar
	Note the Starting Date defaults to the current date. You can change this date. Enter a Starting Date by clicking on the drop-down list box. A calendar displays with the current date circled in red and shown at the bottom of the calendar. You can accept the current date by clicking on it. 



	[bookmark: _Hlk177547867]Steps
	To continue to display the DOR data, follow this step:



	[bookmark: _Hlk177554234][bookmark: _Hlk177547869]Step
	Action

	[bookmark: _Hlk177554235]2
	Enter a Starting Date (defaults to the current date).



	[bookmark: _Hlk177547871]Date
	You can change the date by the following methods:



	[bookmark: _Hlk177554236][bookmark: _Hlk177547872]Change the…
	Description

	[bookmark: _Hlk177554237]Day
	Click on the actual day of the week in the calendar.

	[bookmark: _Hlk177554238]Month
	Click on the month at the top of the calendar to display a list of all months and select one. Or you can decrease or increase one month at a time by clicking the left or right arrows.

	[bookmark: _Hlk177554239]Year
	Click on the year and an up and down arrow button displays for you to increase or decrease the year.



	[bookmark: _Hlk177547876]Starting date calendar
	[image: Screenshot of DOR showing calendar]



[bookmark: _Hlk177554240][bookmark: _Toc44299372][bookmark: _Toc172537354][bookmark: _Toc177550943]
Select a Status

	[bookmark: _Hlk177547878]Status
	You can view Open, Pending, Closed or Canceled records by clicking the checkbox for one or all of these options. The default statuses that are already checked are: Open, Pending and Closed. You can click in these boxes to uncheck any status.



	[bookmark: _Hlk177547879]Steps
	To continue to display the DOR data, follow this step:



	[bookmark: _Hlk177554241][bookmark: _Hlk177547880]Step
	Action

	[bookmark: _Hlk177554242]3
	Select a Status if you want to change the default statuses. 



	[bookmark: _Hlk177547883]Status Scenarios
	[bookmark: _Hlk177554243]There are a number of combinations that you can choose including the following status scenarios:

[bookmark: _Hlk177554244]Scenario 1: If you select the Open and Pending statuses, you will view all suspense records/electronic consult records (CPRS orders) available with a status of Open and Pending. 

[bookmark: _Hlk177554245]Scenario 2: The Starting Date field works with the Closed and Canceled statuses. If you check either one of these statuses, you can then select the Starting Date to display these records. (The Starting Date field that you select plus Closed Delayed records for that period does NOT affect the Open and Pending status record display.) 

Scenario 3: If you select all four statuses, you will view ALL Open and Pending records. You will also view the Closed and Canceled records beginning with the Starting Date you select ONLY.


 
[bookmark: _Hlk177554246][bookmark: _Toc44299373][bookmark: _Toc172537355][bookmark: _Toc177550944]
Select the SSN Range

	[bookmark: _Hlk177547884]SSN fields
	[bookmark: _Hlk177554247]You must have an SSN range to view DOR data. There is a Starting SSN and an Ending SSN field box. This is a range of patient Social Security Numbers by the last two digits. When you enter a range, it will display electronic consults or manual suspense entries within that range. 

[bookmark: _Hlk177554248]If your workload is categorized by the SSN for a specific Purchasing Agent, then you can display entries that are assigned by one Purchasing Agent at a time.

Note: Enter a range of 00 to 99 to view all Purchasing Agents’ SSNs for all patients.



	[bookmark: _Hlk177547885]Steps
	To continue to display the DOR data, follow this step:



	[bookmark: _Hlk177554249][bookmark: _Hlk177547886]Step
	Action

	[bookmark: _Hlk177554250]4
	Enter the SSN range of the patient display (mandatory).



	[bookmark: _Hlk177547888]SSN range
	[image: Screenshot of DOR showing SSN range]



[bookmark: _Hlk177554251][bookmark: _Toc44299374][bookmark: _Toc172537356][bookmark: _Toc177550945]
Display the Data

	[bookmark: _Hlk177547889]Data display
	[bookmark: _Hlk177554252]The data displayed are manual suspense and all other consult entries. You’ll notice columns with a breakdown of days of 0-5, 6-9, 10-29, 30-89 and 90+ columns. 

These columns display the total number of days old by category within the breakdown of the columns. It does NOT display the total number of instances of records (manual suspense entries or electronic consults via CPRS orders). 



	[bookmark: _Hlk177547890]Steps
	To continue to display the DOR data, follow this step:


 
	[bookmark: _Hlk177554253][bookmark: _Hlk177547891]Step
	Action

	[bookmark: _Hlk177554254]5
	[bookmark: _Hlk177554255]Once you have the desired criteria, click the Display button. (You can also double click a record to view the Request window.)
Shortcut: Press the <Alt> key + <D> key.



	[bookmark: _Hlk177547893]Sizing and Sorting columns
	[bookmark: _Hlk177554256]Columns are sizable on this window, but not movable. To resize a column, you can place the cursor on the column header borderline until you can view the double-headed arrow. Then click and drag the column until it is the size you want. 

To sort the columns, click the column header and the data will redisplay in ascending or descending order. Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.



	[bookmark: _Hlk177547894]Delayed Order Report window
	[image: Screenshot of DOR showing delayed order report window]



[bookmark: _Hlk177554257]Continued on next page
[bookmark: _Hlk177554259][bookmark: _Hlk177554258]
Select a Site(s), Continued

	[bookmark: _Hlk177547895]Menu, Refresh and Clear buttons
	The Menu button returns you to the Prosthetics Main Menu window where you can open additional applications at the same time. The Refresh button resets (recalls) the data if you had made some column sizing changes. It is the same as clicking the Display button again. You can use the Clear button to blank out the window and start over with new display criteria. 



	[bookmark: _Hlk177547897]Column titles
	Below are the header titles of each column and a description of each.



	[bookmark: _Hlk177554260][bookmark: _Hlk177547898]Column
	Description

	[bookmark: _Hlk177554261]Dlyd
	The Delayed column will display either a Yes or No as to whether the record is delayed or not. You can sort on this column by all “Yes” records or all “No” records by clicking on the column.

	[bookmark: _Hlk177554262]Status
	The Status of the record is either Open, Pending, Closed or Cancelled. Records with an Open status are shown in blue.

	[bookmark: _Hlk177554263]Type
	This is the Type of record - Manual Suspense entry or Routine Consult (electronic orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders).

	[bookmark: _Hlk177554264]Station
	This is the Station Identifying number.

	[bookmark: _Hlk177554265]Create
	The Create date is the date that the record was created.

	[bookmark: _Hlk177554266]1st Action
	The First Action date is the date that initial action was taken on the request and the status changed from Open to Pending.

	[bookmark: _Hlk177554267]0-5
	The number of days (0-5) that an order record is not delayed.

	[bookmark: _Hlk177554268]6-9; 10-29; 30-89; 90+
	[bookmark: _Hlk177554269]These columns of number ranges designate the number of Workdays within these ranges that a request has been delayed. This does NOT include Saturdays and Sundays nor Holidays. This also designates that the record is in a Pending status. Any record over 5 days is highlighted in red with yellow numbers.

Note: The numbers listed in each row for a record designate the number of days NOT the number of record instances. 

	[bookmark: _Hlk177554270]Lnk
	[bookmark: _Hlk177554271]The Link column designates how many items that were linked to that record. It could be a zero or a number. 

Note that if the status is Closed, and there is a zero in the Link column, then those records were never linked.

	[bookmark: _Hlk177554272]Description
	This is the description of the request.

	[bookmark: _Hlk177554273]Patient
	The patient name is displayed.

	[bookmark: _Hlk177554274]SSN
	The Social Security Number for the patient is displayed.



	[bookmark: _Hlk177547910]Yellow and Red fields
	[bookmark: _Hlk177554275]Records that have a delayed date beyond 5 days will have the number of days in yellow and the block will be highlighted in red.

Records with 0-5 days will have the number shown in bold print.



[bookmark: _Hlk177554276][bookmark: _Toc44299375][bookmark: _Toc172537357][bookmark: _Toc177550946]
View DOR Calculation Detail

	[bookmark: _Hlk177547911]DOR Detail button
	You can view the DOR calculation detail for the range of consults and manual suspense entries that you displayed. When you select the DOR Detail button, it doesn’t matter what status is checked because the calculation looks at all the Open, Pending and Closed records from the starting date you selected.



	[bookmark: _Hlk177547912]Number of MANUALS
	You can view the total number of Manual suspense entries that are in Open, Pending or Closed status. Those in the 6-9 or higher columns show the ones that are Delayed.



	[bookmark: _Hlk177547913]Number of CONSULTS
	You can view the total number of electronic Consults (that were not entered manually) that are in Open, Pending or Closed status and have not had any action taken on them. Those in the 6-9 or higher columns show the ones that are Delayed.



	[bookmark: _Hlk177547914]SUB TOTAL
	The SUB TOTAL row totals the number of Manual suspense entries + the total number of all other consults.



	DOR Calculation Detail window
	[image: Screenshot of DOR calculation detail window]



	[bookmark: _Hlk177547917]Minus PENDING
	[bookmark: _Hlk177554277]This row displays the number of consults that have had an initial action taken on it (starting with the date you selected in the calendar for the starting date which is shown here by 1/1/2003) and put into a Pending status. 

This number is subtracted from the subtotal for the Total Delayed row below that. 


[bookmark: _Hlk177554279][bookmark: _Hlk177554278]
Select a Site(s), Continued

	[bookmark: _Hlk177547918]TOTAL DELAYED
	The TOTAL DELAYED is calculation that adds the total number of Manual Suspense records + the total number of all other consults and subtracts the number of consults in a Pending status (Pending from before the Start Date selected).



	DOR Calculation Detail window
	[image: Screenshot of DOR calculation detail window]



	[bookmark: _Hlk177547921]Total of Sub Total
	The Total of the Sub Total field includes: 1) the total from the Sub Total above (third row), 2) all totals of Manual Suspense entries and 3) all other electronic consults.



	[bookmark: _Hlk177547922]Minus Total Pending 
	The next row shows the calculation for the Total consults minus the Pending consults from the starting date that you selected. 



	[bookmark: _Hlk177547923]TOTAL DELAYED
	[bookmark: _Hlk177554280]The TOTAL DELAYED field is shown. 

This displays the Total Delayed from the grid above (any greater than 5 days delayed) divided by (the result of the total Sub Total minus Total Pending as of 1/1/03) and multiplied by 100. This is the percentage delayed. 



	[bookmark: _Hlk177547925]Percent Delayed
	The final calculations above, this equals the Percent Delayed (shown as 95.37%).



[bookmark: _Hlk177554281]Continued on next page
[bookmark: _Hlk177554283][bookmark: _Hlk177554282]
Select a Site(s), Continued

	[bookmark: _Hlk177547926]Scenarios below
	The scenarios below describe different timelines when orders are received at different times of the month and if they are delayed. Then it will explain which month’s Calculation Report where the data will appear.



	[bookmark: _Hlk177547927]Scenario 1
	An order is received on Tuesday, June 3rd and is changed to Pending or Closed status on Friday, 6/6. This is not a delayed order and would appear in the June Calculation Report as an order received.



	[bookmark: _Hlk177547929]Scenario 2
	An order is received on Tuesday, 6/3 and is changed to Pending or Closed on Wednesday, 6/20. This is a delayed order and would be included in the June Calculation Report as a delayed order.



	[bookmark: _Hlk177547930]Scenario 3
	An order is received on Thursday, 6/26 and is changed to Pending or Closed on Tuesday, 7/15. This was not a delayed order in June; however the order is included in the June Calculation Report, because it was received in June. Since it took greater than 5 days to change it to Pending or Closed, it would also be included in the July report as a delayed order and would be included in the calculations.



	[bookmark: _Hlk177547931]Scenario 4
	An order is received on Thursday, 6/26 and changed to Pending or Closed on Monday, August 4th. This is not a delayed order in June; however, the order is included in the June Calculation Report, because it was received in June. Since it took greater than 5 days to change it to Pending or Closed, it would be included in both the July and August report as a delayed order and would also be included in the calculations.



[bookmark: _Hlk177554284]Continued on next page
[bookmark: _Hlk177554286][bookmark: _Hlk177554285]
Select a Site(s), Continued

	[bookmark: _Hlk177547933]Print button
	[bookmark: _Hlk177554287]You can print the DOR Calculation Detail data by clicking the Print button. A Print Preview pane will display that allows you to zoom in, scroll forward/ backward, print, save the data, or open/load a new report. 

Click the Close button to return to the DOR Calculation Detail window.



	[bookmark: _Hlk177547934]Print Preview
	[image: Screenshot of Print Preview window]



[bookmark: _Hlk177554288][bookmark: _Toc44299376][bookmark: _Toc172537358][bookmark: _Toc177550947]
View Pending Calculations

	[bookmark: _Hlk177547935]Pending Calc Button
	Click on the Pending Calc button on the DOR window and the window displays based on the selection criteria of this window.



	[bookmark: _Hlk177547936]Pending status consults
	[bookmark: _Hlk177554289]The Pending Calculations window displays the total number of Workdays with the total number of Pending records since an initial action was taken on it. These records are categorized into columns by the number of Workdays it has remained in a Pending status. 

The calculation used to display these Pending status records is from the First Action date (not from Creation Date) to the current date. This is a tool to help managers monitor their consults and manual suspense entries that have been Pending for an extended period of time. 



	[bookmark: _Hlk177547938]Pending Calculations
	[image: Screenshot of Pending Calculations]



	[bookmark: _Hlk177547939]Print button
	The Print button allows you to print the Pending Action Calculations and will display the Print dialog box.



	[bookmark: _Hlk177547941]Excel button
	[bookmark: _Hlk177554290]You can send this data to MS Excel by clicking the Excel button. It will launch the application and display the data at the same time. (You can also click the File menu, click Excel, then select the Send - Request Grid option.)

For more information on saving data as an Excel file, see “  PAG  Purge Aged Purchasing Transactions
  FCLN  RMPR file cleansing for field lengths
,” later in this chapter.



	[bookmark: _Hlk177547942]Close button
	[bookmark: _Hlk177554291]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Toc24185572][bookmark: _Toc44299377][bookmark: _Toc172537359]

[bookmark: _Toc177550948][bookmark: _Hlk177554292]View 2319 Information
[bookmark: _Toc24185573][bookmark: _Toc44299378][bookmark: _Toc172537360][bookmark: _Toc177550949][bookmark: _Hlk177554293]View 2319 – Patient Demographics

	[bookmark: _Hlk177547943]Introduction
	[bookmark: _Hlk177554294]The View 2319 button displays the 10-2319 Prosthetic patient records. The title bar displays the patient name and SSN. Here are the windows of information that you can view from the patient’s 2319:

1. [bookmark: _Hlk177554295]Patient Demographics
2. [bookmark: _Hlk177554296]Clinic Enrollments/Correspondence
3. [bookmark: _Hlk177554297]Entitlement Info
4. [bookmark: _Hlk177554298]Appliance Transactions
5. [bookmark: _Hlk177554299]Auto Adaptive Info
6. [bookmark: _Hlk177554300]Critical Comments
7. [bookmark: _Hlk177554301]HISA Information
8. [bookmark: _Hlk177554302]Home Oxygen Items

Note: Use the <Alt> key and the number to toggle to different tabs.



	[bookmark: _Hlk177547944]Demographics data
	You can view the patient demographics for the veteran. This includes: Name (in red if deceased with Date of Death listed above the Date of Birth and the age field will not display), address, next of kin, emergency contact information, veteran benefits and eligibility (former Prisoner of War (highlighted in blue if “Yes”), Aid & Attendance, service connected, non-service connected, etc.).



	[bookmark: _Hlk177547945]1. Patient Demographics window
	[image: Patient Demographics window]



[bookmark: _Hlk177554303][bookmark: _Toc24185574][bookmark: _Toc44299379][bookmark: _Toc172537361][bookmark: _Toc177550950]
View 2319 - Clinic Enrollments/Correspondence

	[bookmark: _Hlk177547946]Window description
	[bookmark: _Hlk177554304]This second tab details clinic enrollments and correspondence for the veteran. This includes the following: the last movement actions (i.e., hospital admissions and discharges), clinic enrollments, pending appointments and correspondence letters. 

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.



	[bookmark: _Hlk177547947]2. Clinic Enrollments/ Correspondence
	[image: Clinic Enrollments/ Correspondence]



	[bookmark: _Hlk177547948]Exit
	[bookmark: _Hlk177554305]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554306][bookmark: _Toc24185575][bookmark: _Toc44299380][bookmark: _Toc172537362][bookmark: _Toc177550951]
View 2319 - Entitlement Information

	[bookmark: _Hlk177547949]Window description
	The third tab details entitlement and loan information for the veteran. This includes the following: PSC Issue Card, clothing allowance, items on loan, and items returned.



	[bookmark: _Hlk177547951]3. Entitlement Info
	[image: Screenshot of Entitlement Info]



	[bookmark: _Hlk177547952]Exit
	[bookmark: _Hlk177554307]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Toc24185576][bookmark: _Toc44299381][bookmark: _Toc172537363][bookmark: _Toc177550952]
View 2319 – Appliance Transactions

	[bookmark: _Hlk177547953]Appliance Transactions
	[bookmark: _Hlk177554308]The Appliance Transactions tab of the View 2319 window displays all transaction history for a veteran. The Date column is the date of the PO. Columns are re-sizable on this window (not movable). The total records found displays at the bottom.

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.



	[bookmark: _Hlk177547954]Steps
	To view the Appliance Transactions detail, follow these steps:



	[bookmark: _Hlk177554309][bookmark: _Hlk177547955]Step
	Action

	[bookmark: _Hlk177554310]1
	Select a transaction by clicking on it to highlight it.

	[bookmark: _Hlk177554311]2
	Click the View Detail button below to display the appliance details. (You can also double click a record to view the details.)



	[bookmark: _Hlk177547958]4. Appliance Transactions
	[image: Screenshot of Appliance Transactions]



	[bookmark: _Hlk177547959]Exit
	[bookmark: _Hlk177554312]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.


[bookmark: _Hlk177554313]
	[bookmark: _Hlk177547960]Steps
	To continue to view the Appliance Transactions detail, follow these steps:



	[bookmark: _Hlk177554314][bookmark: _Hlk177547961]Step
	Action

	[bookmark: _Hlk177554315]3
	The Transaction Detail window is shown below.

	[bookmark: _Hlk177554316]4
	Click the Close button to return to the Appliance Transaction window.



	[bookmark: _Hlk177547964]Appliance Transaction Detail
	[image: Screenshot of Appliance Transaction Details]



	[bookmark: _Hlk177547965]Exit
	[bookmark: _Hlk177554317]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554318][bookmark: _Toc24185577][bookmark: _Toc44299382][bookmark: _Toc172537364][bookmark: _Toc177550953]
View 2319 – Auto Adaptive Info

	[bookmark: _Hlk177547966]Window description
	The fifth tab details the Auto Adaptive information. 



	[bookmark: _Hlk177547968]5. Auto Adaptive Info
	[image: Auto Adaptive Info]



	[bookmark: _Hlk177547969]Exit
	[bookmark: _Hlk177554319]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554320][bookmark: _Toc24185578][bookmark: _Toc44299383][bookmark: _Toc172537365][bookmark: _Toc177550954]
View 2319 - Critical Comments

	[bookmark: _Hlk177547970]Window description
	The sixth tab details any critical comments recorded for the veteran.



	[bookmark: _Hlk177547971]6. Critical Comments
	[image: Screenshot of Critical Comments]



	[bookmark: _Hlk177547972]Exit
	[bookmark: _Hlk177554321]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554322][bookmark: _Toc24185579][bookmark: _Toc44299384][bookmark: _Toc172537366][bookmark: _Toc177550955]
View 2319 – View HISA Information

	[bookmark: _Hlk177547973]Window description
	[bookmark: _Hlk177554323]The seventh tab details the HISA (Home Improvement Structural Alteration) information including the date, quantity, item, type, vendor, station number, serial, HCPCS Code and cost of the item ordered.

[bookmark: _Hlk177554324]Note: “HISA Information” is the new name for this window; it used to be “Add/Edit Disability Codes.”

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.



	[bookmark: _Hlk177554325][bookmark: _Hlk177547974]Step
	Action

	[bookmark: _Hlk177554326]1
	Select a transaction by clicking on it to highlight it.

	[bookmark: _Hlk177554327]2
	Click the View Detail button below to display the HISA information details. (You can also double click a record to view the details.)



	[bookmark: _Hlk177547978]7. HISA Information
	[image: Screenshot of HISA Information]



	[bookmark: _Hlk177547979]Exit
	[bookmark: _Hlk177554328]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.


[bookmark: _Hlk177554329][bookmark: _Toc24185580][bookmark: _Toc44299385][bookmark: _Toc172537367][bookmark: _Toc177550956]
View 2319 – Home Oxygen

	[bookmark: _Hlk177547980]Window description
	[bookmark: _Hlk177554330]The eighth tab details the Home Oxygen information including the date, quantity, item, type, vendor, station, serial, HCPCS Code, and total cost of the item(s).

Note: Due to some records not having a 1st Action date, sorting by this column will not sort in date order.



	[bookmark: _Hlk177554331][bookmark: _Hlk177547981]Step
	Action

	[bookmark: _Hlk177554332]1
	Select a transaction by clicking on it to highlight it.

	[bookmark: _Hlk177554333]2
	Click the View Detail button below to display the Home Oxygen information details. (You can also double click a record to view the details.)



	[bookmark: _Hlk177547984]8. Home Oxygen
	[image: Screenshot of Home Oxygen]



	[bookmark: _Hlk177547985]Exit
	[bookmark: _Hlk177554334]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



	[bookmark: _Hlk177547986]View Detail
	When you select a record and click the View Detail button, the following window displays as shown on the next page


[bookmark: _Hlk177554335]
	[bookmark: _Hlk177547987]View Detail button
	After clicking the View Detail button on the Home Oxygen window, the following window displays for the patient.



	[bookmark: _Hlk177547988]Transaction Detail window
	[image: Screenshot of Transaction Detail window]



	[bookmark: _Hlk177547990]Close button
	[bookmark: _Hlk177554336]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554337][bookmark: _Toc44299386][bookmark: _Toc172537368][bookmark: _Toc177550957]
View and Manage the DOR
[bookmark: _Toc44299387][bookmark: _Toc172537369][bookmark: _Toc177550958][bookmark: _Hlk177554338]View CPRS

	[bookmark: _Hlk177547991]Function description
	The View CPRS button from the DOR window allows you to view all the consult data on the View CPRS window as shown below. This is the same data as in the electronic Consult - Suspense (SU) Menu feature where you can enter CD for the CPRS Display. 



	[bookmark: _Hlk177547992]View CPRS window
	[image: Screenshot of View CPRS window]



	[bookmark: _Hlk177547993]Close button
	[bookmark: _Hlk177554339]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554340][bookmark: _Toc44299388][bookmark: _Toc172537370]
View Request

	[bookmark: _Hlk177547994]Function description
	[bookmark: _Hlk177554341]When you click the View Request button on the DOR window, the View Request window displays as shown below. This provides the display of the manual suspense entry for the patient.

Note: You can also double click on a record in the DOR window grid to display this View Request window.



	[bookmark: _Hlk177547995]View Request window
	[image: Screenshot of VIew Request window]



	[bookmark: _Hlk177547996]Close button
	[bookmark: _Hlk177554342]To exit, click the Close button or the [image: Close button icon] button in the top right-hand corner.



[bookmark: _Hlk177554343][bookmark: _Toc172537371][bookmark: _Toc177550959]
Save as an Excel File

	[bookmark: _Hlk177547998]Excel Button
	[bookmark: _Hlk177554344]Click the Excel button on the Delayed Order Report window to launch Excel and display the current data. (You can also click the File menu, click Excel, then select the Send - Request Grid option.)

[bookmark: _Hlk177554345]Shortcut: Press the <Alt> key + <X> key to launch MS Excel.

[bookmark: _Hlk177554346]Note: This feature creates a temporary Excel .CSV file in the folder selected. The default folder is C:\NPPDDownload (which is automatically created). The file name is based on the number of selected sites and the SSN range.

[bookmark: _Hlk177554347]Examples: DOR_1_00_33.csv means 1 site was selected for SSN range 00-33.
[bookmark: _Hlk177554348]        DOR_ALL_34_99.csv means All Sites were selected for SSN range 34-99.

[bookmark: _Hlk177554349]Prior to the display, you are notified that the information about to be exported may contain Patient Identifiable Information. 




	[bookmark: _Hlk177547999]Steps
	To export data to Excel:



	[bookmark: _Hlk177554350][bookmark: _Hlk177548000]Step
	Action

	[bookmark: _Hlk177554351]1
	[bookmark: _Hlk177554352]Click the Excel button on the Delayed Order Report window. 

Shortcut: Press the <Alt> key + <X> key. 

	[bookmark: _Hlk177554353]2
	Click the OK button on the security reminder.

	[bookmark: _Hlk177554354]3
	Continue to the Select Directory window.



	[bookmark: _Hlk177548004]Security Reminder
	[image: Security Reminder popup]




	[bookmark: _Hlk177554355][bookmark: _Hlk177548005]Step
	Action

	[bookmark: _Hlk177554356]4
	Navigate to the desired directory and select OK .(Click Cancel to exit or Help to view the help pages associated with this functionality) 


[bookmark: _Hlk177554357]
	[bookmark: _Hlk177548007]Select Directory
	 [image: Screenshot of Select Directory window]



	[bookmark: _Hlk177554358][bookmark: _Hlk177548008]Step
	Action

	[bookmark: _Hlk177554359]5
	Navigate to a secure location where the temporary Excel (.csv) file will be stored and then select OK . Excel will open and display the data. 




	[bookmark: _Hlk177548010]MS Excel data
	[image: Screenshot of MS Excel data]




[bookmark: _Hlk177554360]
	[bookmark: _Hlk177554361][bookmark: _Hlk177548011]Step
	Action

	[bookmark: _Hlk177554362]6
	[bookmark: _Hlk177554363]This is only a temporary file so if you wish to save the data you must select File, then Save As, then change the name of the file.

Note: To save the file, you must change the filename from the default. If you accept the default file name, it will be deleted when you close the DOR window. 



	[bookmark: _Hlk172535052][bookmark: _Hlk177548013]Temp file location
	[bookmark: _Hlk177554364]Should you wish to check the location of the temp file, it displays on the DOR window right below the Print button.

[image: Temp file location]


	[bookmark: _Hlk177554365]**Note**
	
You will be unable to export another report to Excel or navigate away from the DOR window until the current Excel (.csv) file is closed. Attempting to do so without first closing the file will result in one of the following errors depending on what action has taken place. If you do save a file with Patient Identifiable Info in it, don’t forget to delete it when you no longer need it. 



	[bookmark: _Hlk177548015]Attempting to Open another report with temp file still open
	[image: Screenshot of error message warning to close temporary Excel files before continuing]



	[bookmark: _Hlk177548016]Attempting to navigate away from the DOR window with temp file still open
	[image: Screenshot of error message warning to close temporary Excel files before navigating from form]



[bookmark: _Hlk177554366][bookmark: _Toc44299390][bookmark: _Toc172537372][bookmark: _Toc177550960]
Print the DOR

	[bookmark: _Hlk177548017]Print the DOR data
	[bookmark: _Hlk177554367]You can print the DOR data using the Print button to send this data to your local printer. You can also click the File Menu and the Print-Request Grid option, and the Print dialog box displays. The layout of the print will be the same as the display. 

[bookmark: _Hlk177554368]Shortcut: Press the <Alt> key + <P> key.

Note: You can select a different printer that you have setup to print the detail. 



	[bookmark: _Hlk177548019]Landscape default
	When printing grids, the default is set to print in the Landscape format and then returns the printer to the prior state. 



	[bookmark: _Hlk177548020]Steps
	To print the DOR, follow these steps:



	[bookmark: _Hlk177554369][bookmark: _Hlk177548021]Step
	Action

	[bookmark: _Hlk177554370]1
	Click the Print button on the DOR window. 

	[bookmark: _Hlk177554371]2
	The Print dialog box displays.

	[bookmark: _Hlk177554372]3
	Click the Properties button (to the right of the Name field) on the Print dialog box if you want to change the page orientation of the printout. (Optional)

	[bookmark: _Hlk177554373]4
	Click the OK button.



	[bookmark: _Hlk177548026]Print dialog box
	[image: Screenshot of print dialog box]


[bookmark: _Hlk177554375][bookmark: _Toc89754772][bookmark: _Toc172537373][bookmark: _Toc177550961]
Exiting the DOR Window

	[bookmark: _Hlk177548027]Exit the Window
	You can exit the application by first clicking the Menu button on the Delayed Order Report window. This closes the DOR window.



	[bookmark: _Hlk177548028]DOR “Menu” button
	[image: DOR window Menu button]



	[bookmark: _Hlk177548029]Exit the Application
	Then click the Close button on the Prosthetics Main Menu window:





	[bookmark: _Hlk177548030]
	



	[bookmark: _Hlk177548032]Main Menu “Close” button
	[image: Prosthetics Suite Main Menu]



	[bookmark: _Hlk177548033]Confirmation window
	Click OK on the confirmation window to close the Prosthetics VistA Suite. 



	[bookmark: _Hlk177548034]
	[image: Screenshot ofConfirmation window]



	[bookmark: _Hlk177548035]Cancel button
	If you click the Cancel button, you will remain in the application and can continue to work.
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[bookmark: _Toc172537374][bookmark: _Toc177550962][bookmark: _Hlk177554385][bookmark: _Toc172537375]Section 4: View Prosthetics Billing Information
[bookmark: _Toc89754773][bookmark: _Toc172537376][bookmark: _Toc177550963][bookmark: _Hlk177554387]Overview

	[bookmark: _Hlk177548036]Introduction
	[bookmark: _Hlk177554388]This View Prosthetics Billing Information User Manual is for Patch RMPR*3*96. This patch provides Prosthetics GUI (graphical user interface) windows for the View Prosthetics Billing Information feature. 

[bookmark: _Hlk177554389]The Prosthetics and Billing users will be able to do the following with this patch:

· [bookmark: _Hlk177554390]Search for data and display data by a range of dates.
· [bookmark: _Hlk177554391]Sort and rearrange the view; display data in a custom view.
· [bookmark: _Hlk177554392]Print the display.
· Convert the display into a MS Excel file (for complex sorting features).



	[bookmark: _Hlk177548037]Audience
	[bookmark: _Hlk177554393]These Release Notes are geared towards two audiences. The VistA Sign-on window will appear with different functions according to which type of user is accessing the Billing information. The two audiences for this document and the VistA Sign-on window include:

· [bookmark: _Hlk177554394]Billing users – Section 1
· Prosthetics users – Section 2



	[bookmark: _Hlk177548038]Data displayed
	[bookmark: _Hlk177554398]The data that is displayed on the View Prosthetics Billing Information window includes the following:

· [bookmark: _Hlk177554399]Site
· [bookmark: _Hlk177554400]Create Date
· [bookmark: _Hlk177554401]Delivery Date
· [bookmark: _Hlk177554402]Patient name
· [bookmark: _Hlk177554403]Social Security Number
· [bookmark: _Hlk177554404]Insurance
· [bookmark: _Hlk177554405]Coding Errors
· [bookmark: _Hlk177554406]Item Description
· [bookmark: _Hlk177554407]Quantity
· [bookmark: _Hlk177554408]Total Cost
· [bookmark: _Hlk177554409]HCPCS
· [bookmark: _Hlk177554410]HCPCS Description
· [bookmark: _Hlk177554411]ICD9
· ICD9 Description



[bookmark: _Toc89754774]
[bookmark: _Toc172537377][bookmark: _Toc177550964][bookmark: _Hlk177554412]Chapter 1 - For Billing Users
[bookmark: _Toc89754775][bookmark: _Toc172537378][bookmark: _Toc177550965][bookmark: _Hlk177554413]Billing Main Menu Window

	[bookmark: _Hlk177548040]Billing Main windows
	[bookmark: _Hlk177554414]Below is the Prosthetics Main Menu window where Billing users can first sign-on to VistA (using the VistA Sign-On button) and then access the View Prosthetics Billing Information window. The Billing users will see a “green dollar sign” icon on the desktop to select the Prosthetics feature. 

Note: Please see the Prosthetics Main Menu User Manual for more detail information regarding VistA Sign-On instructions.



	[bookmark: _Hlk177548041]Prosthetics Main Menu
	[image: Screenshot of Prosthetics main menu]



	[bookmark: _Hlk177548042]Billing button
	Click the View Prosthetics Billing Information button and proceed to Chapter 3.



[bookmark: _Toc89754776][bookmark: _Toc172537379]

[bookmark: _Toc177550966][bookmark: _Hlk177554415]Chapter 2 – For Prosthetics Users
[bookmark: _Toc89754777][bookmark: _Toc172537380][bookmark: _Toc177550967][bookmark: _Hlk177554417]Prosthetics Main Menu Window

	[bookmark: _Hlk177548043]Prosthetics Main Menu Window
	[bookmark: _Hlk177554418]The Prosthetics Main Menu window is also where Prosthetics users can sign-on to VistA and then access the View Prosthetics Billing Information window. These users also have access to other Prosthetics features. 

Note: To access this application, you will double click on the Prosthetics VistA Suite (medicine bag) icon on desktop. Please see the Prosthetics Main Menu User Manual for more detailed VistA Sign-on instructions.



	[bookmark: _Hlk177548045]Billing button 
	Click the View Prosthetics Billing Information button and proceed to the next page.



[bookmark: _Toc89754778]
[bookmark: _Toc172537381][bookmark: _Toc177550968][bookmark: _Hlk177554421]Chapter 3 – View Billing Information Package
[bookmark: _Toc89754779][bookmark: _Toc172537382][bookmark: _Toc177550969][bookmark: _Hlk177554422]View Billing Information Window

	[bookmark: _Hlk177548046]Purpose
	You can view Prosthetics billing information, insurance information and disability information for specific veteran using the View Prosthetics Billing Information window.



	[bookmark: _Hlk177548047]View Prosthetics Billing Information main window
	[image: Screenshot of Prosthetics billing information main window]



	[bookmark: _Hlk177548048]Menu button
	The Menu button will close the View Prosthetic Billing Information window and return you to the Prosthetics Main Menu window.



[bookmark: _Hlk177554428][bookmark: _Toc89754780][bookmark: _Toc172537383][bookmark: _Toc177550970]
Enter a Date Range

	[bookmark: _Hlk177548049]Date/ Calendars
	[bookmark: _Hlk177554430]After you have successfully signed on to VistA, and the View Prosthetic Billing Information window appears, you must select the date range that you want to view. 
[bookmark: _Hlk177554431]Enter a Beginning Date and an Ending Date by clicking on the drop-down list boxes next to the respective fields. A calendar displays as shown below. 

[bookmark: _Hlk177554432]Note: The software will sort by the Create Date field of the Prosthetics Purchase Order or Stock Issue. It does not sort by the Delivery Date field (the date paid).

[image: Screenshot of Prosthetics Billing Information File menu options]

Shortcut: Press the <Ctrl> key + <B> key for the Beginning Date and the 
<Ctrl> key + <E> key for the Ending Date to display the respective calendars. You can also click the File Menu and the Select Beginning Date or Select Ending Date option from the list.



	[bookmark: _Hlk177548050]Calendar for date range selection
	[image: Screenshot of Calendar for date range selection]



[bookmark: _Hlk177554434]Continued on next page
[bookmark: _Hlk177554437][bookmark: _Hlk177554436]
View Request, Continued

	[bookmark: _Hlk177548051]Selecting a date range
	The calendars display with the current date circled in red shown at the bottom of the calendar. You can accept the current date by clicking on it. You can also change the date by the following methods:



	[bookmark: _Hlk177554439][bookmark: _Hlk177548052]Change the…
	Description

	[bookmark: _Hlk177554440]Day
	Click on the actual day of the week in the calendar.

	[bookmark: _Hlk177554441]Month
	Click on the month at the top of the calendar to display a list of all months and select one from there. You can decrease or increase one month at a time by clicking the left or right arrows.

	[bookmark: _Hlk177554443]Year
	Click on the year and an up and down arrow button displays for you to increase or decrease the year.



	[bookmark: _Hlk177548056]Number of Day Restrictions
	You are restricted to a date range of less than 100 days. If you select a date range outside of this 100 day parameter, the following dialog message box displays:



	[bookmark: _Hlk177548057]Date Range Message box
	[image: Screenshot of date range message box warning that user has selected a date range of more than 100 days]



	[bookmark: _Hlk177548058]Start Date before End Date
	If you accidentally entered an incorrect date range, you will receive a warning message. For instance, if you enter a start date that is after the end date, the message below will display. Click the OK button and reselect your date range.



	[bookmark: _Hlk177548059]Start/End Date Message
	[image: Screenshot of start date before end date message]



[bookmark: _Hlk177554450][bookmark: _Toc89754781][bookmark: _Toc172537384][bookmark: _Toc177550971]
Display the Prosthetics Data

	[bookmark: _Hlk177548061]Display the data
	[bookmark: _Hlk177554452]Once you have selected the date ranges, click the Display button to reveal the data within that date range. (You can also click the File Menu and the Display option.) 
[bookmark: _Hlk177554453]A progress bar activates, and the button name changes to “Searching” while the system is retrieving records. (A long date range may result in a long search time.)

[bookmark: _Hlk177554454]Recommendation: The larger the date range selected, the greater time it will take to search, sort, and display the data. We recommend that you sort by a short date range (5-10 days) and perform the sort early in the morning or later in the day when your VistA system is less active. 

Shortcut: Press the <Ctrl> key + <D> key.



	[bookmark: _Hlk177548062]View Prosthetics Billing Information
	[image: View Prosthetics Billing Information]



[bookmark: _Hlk177554456][bookmark: _Toc172537385][bookmark: _Toc177550972]
Change Data Display

	[bookmark: _Hlk177548063]Changing the display of the data…
	[bookmark: _Hlk177554458]You can manipulate the layout of the view in the View Prosthetics Billing Information window for both viewing as well as printing purposes as follows:. 

· [bookmark: _Hlk177554459]To enlarge a column, click and drag a cell border.
· [bookmark: _Hlk177554460]To sort on any column, click on the header to sort it in ascending order. 
· If you click on the same column again, it will sort it in descending order.



	[bookmark: _Hlk177548064]Refresh data
	[bookmark: _Hlk177554461]If you have changed the sort order, you can refresh your data by clicking the Display button again. 

Note: Refresh does not reset any column resizing that has been done.



[bookmark: _Hlk177554463][bookmark: _Toc172537386][bookmark: _Toc177550973]
View Column Descriptions - Site, Dates and Patient Data

	[bookmark: _Hlk177548065]Site
	The Site column displays the VA facility where the veteran was treated and where the Prosthetics transaction was created.



	[bookmark: _Hlk177548066]Create Date
	The Create Date is the date the transaction (Purchase Order or Stock Issue) was created and posted to the Prosthetic veteran’s record (2319).



	[bookmark: _Hlk177548067]Delivery Date
	[bookmark: _Hlk177554468]If the Delivery Date field is blank, this indicates that Prosthetics has NOT paid the item; therefore an assumption is made that the veteran may not have received the item. 

The Delivery Date is not the date the veteran received the item; it is technically the date the Purchase Order was closed or the date the Stock Issue transaction was posted to the 2319.



	[bookmark: _Hlk177548069]Patient
	The Patient column contains the veteran’s last name and first name. Only Non-Service Connected transactions display for the requested date range. 



	[bookmark: _Hlk177548070]SSN
	The SSN column displays the patient’s Social Security Number (SSN).



	[bookmark: _Hlk177548071]Column Headers
	[image: Screenshot of Column Headers]



[bookmark: _Hlk177554474][bookmark: _Toc89754784][bookmark: _Toc172537387][bookmark: _Toc177550974]
View Column Description - Insurance Information

	[bookmark: _Hlk177548072]Insurance for a patient
	[bookmark: _Hlk177554475]The Insurance column displays health insurance information from the patient’s VistA record. 

[bookmark: _Hlk177554476]If there is no health insurance information in the patient’s VistA record, it displays “Nothing Found” in the Insurance column. 

If health insurance displays, then the most recent insurance entered into the patient’s VistA record will display.



	[bookmark: _Hlk177548073]Insurance column
	[image: Screenshot of Insurance column]



	[bookmark: _Hlk177548075]Asterisk
	[bookmark: _Hlk177554479]If there is an asterisk (*) in the Insurance column, this indicates that there is more than one insurance listed for the patient. If there is no asterisk (*), then there is only ONE insurance listed for the patient in the VistA record.

Click on that line item to display the insurance information in the box below. 



	[bookmark: _Hlk177548076]Sorting Tip
	You can sort on the column headers within the Insurance Information box to group items together for easier review. For instance, you can click on the Effective date column or Expires date column headers, and this will group items for reviewing the most recent insurance.



	[bookmark: _Hlk177548077]Effective date column sorted
	[image: Screenshot of Effective date column sorted]


[bookmark: _Hlk177554484][bookmark: _Toc89754785][bookmark: _Toc172537388][bookmark: _Toc177550975]
View Column Descriptions - Coding Errors

	[bookmark: _Hlk177548078]Coding Errors
	[bookmark: _Hlk177554486]The Coding Errors column is to alert Billing users of a possible error. Errors could be any of the following:

· [bookmark: _Hlk177554487]Inactive HCPCS
· [bookmark: _Hlk177554488]Inactive ICD-9 codes
· [bookmark: _Hlk177554489]Use of VA unique HCPCS codes. 

[bookmark: _Hlk177554490]The Coding Errors column checks the HCPCS code to see if it was valid at the time of service, and if not, then the word “HCPCS” is shown in red as well as the “HCPCS Description” is shown in red. This also applies to the inactive ICD9 Codes.

Example: If there is a red HCPCS displayed in the HCPCS column, then the Coding Errors column will display “Alert HCPCS” for Prosthetics or Billing users. This will provide a mechanism to alert users to review this billing information. 



	[bookmark: _Hlk177548079]Coding Column
	[image: Screenshot of Coding Column]



	[bookmark: _Hlk177548080]Sorting Tip
	You can sort on the Coding Errors column by clicking the column header to group items for review.




[bookmark: _Hlk177554494][bookmark: _Toc89754786][bookmark: _Toc172537389][bookmark: _Toc177550976]
View Column Descriptions - Item Information

	[bookmark: _Hlk177548081]Item definition
	The Item column displays an Item or appliance kept in the Pros Master Item file. This column displays the IFCAP Item description of the Item issued to the Veteran.



	[bookmark: _Hlk177548083]~R~ in the Item column
	[bookmark: _Hlk177554497]An “~R~” displayed in the Item column represents a Repair item. The HCPCS Description column should explain what was being repaired. 

[bookmark: _Hlk177554498]The Item column is the “Brief Description” entry that is printed on the purchase order transaction and appears on the 2319 record. The Brief Description is entered to define the item.

Tip: You can sort on the Item column by clicking the column header to group items to review all Repair items together.



	[bookmark: _Hlk177548084]Item column sorted – Repair items grouped together
	[image: Item column sorted – Repair items grouped together]



[bookmark: _Hlk177554501][bookmark: _Toc89754787][bookmark: _Toc172537390][bookmark: _Toc177550977]
View Column Descriptions - Quantity and Total Cost Data

	[bookmark: _Hlk177548085]Qty column
	[bookmark: _Hlk177554502]The Quantity column provides the number issued of that Item to the veteran. This is the quantity based on purchasing (not units). 

Note: For Home Oxygen, it is a payment unit not a billing unit.



	[bookmark: _Hlk177548086]Column headers
	[image: Screenshot Column Headers]



	[bookmark: _Hlk177548087]Total Cost column
	The Total Cost column represents the cost of the issue.



[bookmark: _Hlk177554508][bookmark: _Toc89754788][bookmark: _Toc172537391][bookmark: _Toc177550978]
View Column Descriptions - HCPCS and HCPCS Description Data

	[bookmark: _Hlk177548088]HCPCS definition
	The HCPCS acronym stands for Healthcare Financing Administration Common Procedure Coding System. The HCPCS code represents an item or service. The Prosthetics staff selects the HCPCS code when the transaction was created.



	[bookmark: _Hlk177548089]Red HCPCS
	[bookmark: _Hlk177554511]If the HCPC Code and HCPCS Description in the HCPCS and HPCPS Description columns are red, that represents a HCPCS Code that has a coding error as defined by an Inactive HCPCS.

This provides an alert to Prosthetics and Billing users as this will affect billing information.



	[bookmark: _Hlk177548091]Column headers
	[image: Screenshot of Column headers]



	[bookmark: _Hlk177548092]Asterisk in HCPCS column and Calculation Flag
	[bookmark: _Hlk177554514]If there is an asterisk in the HCPCS column, this indicates that there is a calculation flag. 

A calculation flag determines whether or not a HCPCS is used as a Main Component to display the entire cost of a purchase, when multiple items within the purchase make up a whole (e.g., when purchasing a limb or surgical implants). 



[bookmark: _Hlk177554517][bookmark: _Toc89754789][bookmark: _Toc172537392][bookmark: _Toc177550979]
View Column Descriptions - ICD9 and ICD9 Description

	[bookmark: _Hlk177548093]ICD9 definition
	[bookmark: _Hlk177554518]International Classification of Diseases (Ninth Revision) -A coding system designed by WHO, (World Health Organization). ICD-9-CM is the official system of assigning codes to diagnoses and procedures associated with hospital utilization in the United States. 

The ICD –9 is used to code and classify mortality data from death certificates. VOLUMES 1-2 contain diagnosis and procedures. VOLUME 3 is used for statistical, research and re-imbursement purposes.



	[bookmark: _Hlk177548094]Column headers
	[image: Screenshot of Column headers]



	[bookmark: _Hlk177548096]ICD9 Code Selection
	This code is selected by the prescribing clinician when the Prosthetic consult is created. 



[bookmark: _Hlk177554523][bookmark: _Toc89754790][bookmark: _Toc172537393][bookmark: _Toc177550980]
View Column Descriptions - Disability Information

	[bookmark: _Hlk177548097]Disability Information
	[bookmark: _Hlk177554525]If the patient has disability information, it will automatically be displayed in the Disability Information box in the bottom of the window. 

If a patient is selected without any disability information, the Disability Information box at the bottom of the window will display “Nothing Found.”



	[bookmark: _Hlk177548098]Disability sample
	[image: Screenshot of Disability information]



[bookmark: _Toc89754791][bookmark: _Toc172537394]

[bookmark: _Toc177550981][bookmark: _Hlk177554528]Chapter 4 - Printing
[bookmark: _Toc89754792][bookmark: _Toc172537395][bookmark: _Toc177550982][bookmark: _Hlk177554529]Print the View Prosthetics Billing Information Window

	[bookmark: _Hlk177548099]Print the data
	[bookmark: _Hlk177554530]You can print the View Prosthetics Billing Information data after you have finished your sort by column heading. Click the Print button to send this information to your local printer, and click OK on the Print dialog box. (You can also click the File Menu and the Print option.)

Note: The layout of the print will be the same as the display. You can select a specific printer to print the View Prosthetics Billing Information window. 



	[bookmark: _Hlk177548100]Change to Landscape
	Recommendation: You should change the format of the printout from Portrait to Landscape to print all the columns on the same page.  



	[bookmark: _Hlk177548101]Steps
	To change the print format, follow these steps:



	[bookmark: _Hlk177554535][bookmark: _Hlk177548103]Step
	Action

	[bookmark: _Hlk177554536]1
	Click the Print button on the View Prosthetics Billing Information window. 

	[bookmark: _Hlk177554538]2
	[bookmark: _Hlk177554539]Click the Properties button (to the right of the Name field) on the Print dialog box. Continue to the next page.

Shortcut: Press the <Alt> key + <P> key.



	[bookmark: _Hlk177548105]Print dialog box
	[image: Screenshot of print dialog box]


[bookmark: _Hlk177554542][bookmark: _Hlk177554541]
View Request, Continued

	[bookmark: _Hlk177548106]Layout Tab
	You can change the format of the printout from the standard Portrait format to Landscape on the Layout tab. 



	[bookmark: _Hlk177548107]Steps (continued)
	To continue to change to the Landscape format, follow these steps:



	[bookmark: _Hlk177554546][bookmark: _Hlk177548109]Step
	Action

	[bookmark: _Hlk177554548]3
	Click the Layout tab on the Properties dialog box (usually shown as a default view). 

	[bookmark: _Hlk177554549]4
	[bookmark: _Hlk177554550]Click the Landscape radio button to change the format. 

Shortcut: Press the <Alt> key + <L> key.

	[bookmark: _Hlk177554551]5
	Click OK or press <Enter.>



	[bookmark: _Hlk177548112]Landscape Radio button
	[image: Screenshot of landscape orientation radio button]



	[bookmark: _Hlk177548114]Last step
	When you return to the Print dialog box, click OK again, and it will print your output. You can print multiple copies if necessary. 


[bookmark: _Toc89754793]

[bookmark: _Toc172537396][bookmark: _Toc177550983][bookmark: _Hlk177554555]Chapter 5 – Saving
[bookmark: _Toc172537397][bookmark: _Toc177550984][bookmark: _Hlk177554556]Save as an Excel File

	[bookmark: _Hlk177548115]Excel Button
	[bookmark: _Hlk177554558]Click the Excel button on the View Prosthetics Billing Information window to launch Excel and display the current data. (You can also click the File menu and select the Excel option.)

[bookmark: _Hlk177554559]Shortcut: Press the <Alt> key + <X> key to launch MS Excel.

[bookmark: _Hlk177554560]Note: This feature creates a temporary Excel .CSV file in the folder selected. The default folder is C:\ViewBillingDownload (which is automatically created). The file name is based on the date range.

[bookmark: _Hlk177554561]Example: Jul 02, 2006_Aug 10, 2006.csv

[bookmark: _Hlk177554562]Prior to the display, you are notified that the information about to be exported may contain Patient Identifiable Information. 




	[bookmark: _Hlk177548116]Steps
	To export data to Excel:



	[bookmark: _Hlk177554564][bookmark: _Hlk177548117]Step
	Action

	[bookmark: _Hlk177554565]1
	[bookmark: _Hlk177554566]Click the Excel button on the View Prosthetics Billing Information window. 

Shortcut: Press the <Alt> key + <X> key. 

	[bookmark: _Hlk177554567]2
	Click the OK button on the security reminder.

	[bookmark: _Hlk177554568]3
	Continue to the Select Directory window.



	[bookmark: _Hlk177548121]Security Reminder
	[image: Security Reminder popup]




	[bookmark: _Hlk177554570][bookmark: _Hlk177548122]Step
	Action

	[bookmark: _Hlk177554572]4
	Navigate to the desired directory and select OK .(Click Cancel to exit or Help to view the help pages associated with this functionality) 



	[bookmark: _Hlk177548124]Select Directory
	 [image: Screenshot of directory selection window]



	[bookmark: _Hlk177554575][bookmark: _Hlk177548125]Step
	Action

	[bookmark: _Hlk177554577]5
	Navigate to a secure location where the temporary Excel (.csv) file will be stored and then select OK . Excel will open and display the data. 




	[bookmark: _Hlk177548127]MS Excel data
	[image: File name based on the date range]






	[bookmark: _Hlk177554581][bookmark: _Hlk177548128]Step
	Action

	[bookmark: _Hlk177554582]6
	[bookmark: _Hlk177554583]This is only a temporary file so if you wish to save the data you must select File, then Save As, then change the name of the file.

Note: To save the file, you must change the filename from the default. If you accept the default file name, it will be deleted when you close the NPPD window.



	[bookmark: _Hlk177554585][bookmark: _Hlk177548130]Temp file location
	[bookmark: _Hlk177554586]Should you wish to check the location of the temp file, it displays on the View Prosthetic Billing window right above the Excel button.

[image: Screenshot of Temp file location]


	[bookmark: _Hlk177554587]
**Note**
	
You will be unable to export another report to Excel or navigate away from the View Prosthetic Billing Information window until the current Excel (.csv) file is closed. Attempting to do so without first closing the file will result in one of the following errors depending on what action has taken place. If you do save a file with Patient Identifiable Info in it, don’t forget to delete it when you no longer need it. 



	[bookmark: _Hlk177548132]Attempting to Open another report with temp file still open
	[image: Screenshot of error message warning to close temporary Excel files before continuing]



	[bookmark: _Hlk177548134]Attempting to navigate away from the View Prosthetic Billing Information window with temp file still open
	[image: Error message warning to close temporary Excel files before navigating from form]



[bookmark: _Hlk177554591][bookmark: _Toc172537398][bookmark: _Toc177550985]
AutoFilter

	[bookmark: _Hlk177548135]AutoFilter
	[bookmark: _Hlk177554593]The AutoFilter feature can limit what is displayed for your view which can be printed for reports. Filtering is a quick and easy way to find and work with a subset of data in a list. A filtered list displays only the rows that meet the criteria you specify for a column. 

[bookmark: _Hlk177554594]Steps: On the Data menu, point to Filter, and then click AutoFilter.

[bookmark: _Hlk177554595]When you use the AutoFilter command, arrows appear to the right of the column labels in the filtered list. 

Note: Unlike sorting, filtering does not rearrange a list. Filtering temporarily hides rows you do not want displayed. When Excel filters rows, you can edit, format, chart, and print your list subset without rearranging or moving it.




[bookmark: _Toc172537399][bookmark: _Toc177550986][bookmark: _Hlk177554596]Chapter 6 - Closing and Exiting
[bookmark: _Toc172537400][bookmark: _Toc177550987][bookmark: _Hlk177554597]Exiting the View Prosthetic Billing Information Window

	[bookmark: _Hlk177548136]Exit the Window
	You can exit the application by first clicking the Menu button on the View Prosthetic Billing Information window. This closes the View Prosthetic Billing Information window.



	[bookmark: _Hlk177548137]View Prosthetic Billing Information “Menu” button
	[image: View Prosthetic Billing Information window]



	[bookmark: _Hlk177548138]Exit the Application
	Then click the Close button on the Prosthetics Main Menu window:





	[bookmark: _Hlk177548139]
	



	[bookmark: _Hlk177548140]Main Menu “Close” button
	[image: Prosthetics Suite Main Menu]



	[bookmark: _Hlk177548142]Confirmation window
	Click OK on the confirmation window to close the Prosthetics VistA Suite. 



	[bookmark: _Hlk177548143]
	[image: Screenshot of Confirmation window]



	[bookmark: _Hlk177548144]Cancel button
	If you click the Cancel button, you will remain in the application and can continue to work.




October 2024	2	Prosthetics VistA Suite (GUI)
User Manual
[bookmark: _Toc172537401][bookmark: _Toc177550988][bookmark: _Hlk177554624][bookmark: _Toc172537402]Section 5: Creating a Lab Work Order
[bookmark: _Toc172537403][bookmark: _Toc177550989][bookmark: _Hlk177554626]Overview

	[bookmark: _Hlk177548145]
	[bookmark: _Hlk177554627]The Create application allows you to create an Orthotics Lab Work order (OWL). You may now Complete and Cancel a work order from the Graphical User Interface (GUI). The Create application also allows you view information associated with the current work order, such as 2319 information, CPRS data, and the initial Request. 
The Create application is accessed from the Purchase Order Control window. 



	[bookmark: _Hlk177548146]Accessing the Create Lab Work Order window
	[bookmark: _Hlk177554629]To access the Create Lab Work Order window from the Purchase Order Control window, do the following:

1. [bookmark: _Hlk177554630]Highlight a work order in the Purchase Order Control listview. 

[bookmark: _Hlk177554631]Note 1: The patient must be defined in the PROSTHETICS PATIENT FILE. If you select a patient who is not already defined, a popup message alerts you to this fact. (Click OK to clear the popup window.) Use the AP – Add/Edit Patient to Prosthetics option to correct this issue. 

[bookmark: _Hlk177554632]Note 2: A work order that displays LAB in the Type column has already been used to create a lab order and may not be reused for that purpose. 

2. [bookmark: _Hlk177554633]Click the Create OWL button. The Create Lab Work Order window displays.

[image: Create OWL button]



	[bookmark: _Hlk177548147]Create Lab Work Order window
	[bookmark: _Hlk177554635]The Create Lab Work Order window shown below displays the name and SSN of the patient that was highlighted on the Purchase Control window when you clicked the Create OWL button. 

[bookmark: _Hlk177554636]The name and SSN display in blue letters in the upper-left corner of the screen. The Create Date displays in a yellow field in the upper-right corner. 

[bookmark: _Hlk177554637]You will create a Lab Work Order from this window for a specific patient. 

Note: On this screen, a field with a yellow background cannot be directly edited. The field value defaults in, sometimes as a result of another selection you’ve made.



	[bookmark: _Hlk177548148]Create Lab Order window
	[image: Create Lab Order window]



	[bookmark: _Hlk177548149]Quitting Work
	[bookmark: _Hlk177554640]If you need to stop working at any point during the workflow, click the Quit Work button in the lower-right corner of the window. You will return to the Purchase Order Control window. 

[image: Quit Work button]



[bookmark: _Hlk177554642][bookmark: _Toc172537404][bookmark: _Toc177550990]
Selecting a Lab Type

	[bookmark: _Hlk177548151]Lab Type
	[bookmark: _Hlk177554644]The first step to creating a Lab Order is to select a Lab Type. Below the patient SSN there are four radio buttons that correspond to the following lab types: 

· [bookmark: _Hlk177554645]Orthotics/Prosthetics
· [bookmark: _Hlk177554646]Optical
· [bookmark: _Hlk177554647]Restoration
· [bookmark: _Hlk177554648]Wheelchair

Click one of the Lab Type radio buttons, then mouse click or press <Tab> to go to the next field.



	[bookmark: _Hlk177548152]Lab Type radio buttons
	[image: Lab Type radio buttons]



[bookmark: _Hlk177554649][bookmark: _Toc172537405][bookmark: _Toc177550991]
Selecting Stations

	[bookmark: _Hlk177548153]NPPD Station
	[bookmark: _Hlk177554651]The National Prosthetic Patient Database (NPPD) is a dynamic, comprehensive national database used to collect information on the disabled population’s use of prosthetic, orthotic, and sensory aids. This information allows for statistical analysis and oversight of the VA Prosthetic Service. The NPPD compiles prosthetic data recorded at each VHA facility, or station.

[bookmark: _Hlk177554652]Click the NPPD Station drop-down arrow to display a list of stations for you to select one. A shortcut is to enter a partial spelling of the NPPD Station and click the drop-down arrow (or press the <TAB> key) to select one beginning with the criteria that you entered.

[bookmark: _Hlk177554653]Once a station has been selected, the station name displays next to the NPPD Station label and the site number displays in the yellow field to the right.

Note: For a user at a station which does its own OWL, the NPPD Station, Receiving Station, and Requesting Station will all be the same.



	[bookmark: _Hlk177548154]NPPD Station drop-down list
	[image: Station drop-down lists]



	[bookmark: _Hlk177548155]Receiving Station
	Enter a partial spelling of the Receiving Station and click the drop-down arrow (or press the <TAB> key) to select an item beginning with the characters you entered. The Receiving Station is the institution that will receive the VAF 10-2529-3 request for processing.



	[bookmark: _Hlk177548156]Requesting Station
	Enter a partial spelling of the Requesting Station and click the drop-down arrow (or press the <TAB> key) to select an item beginning with the characters you entered. The Requesting Station is the station requesting the services or appliances.



[bookmark: _Hlk177554659][bookmark: _Toc172537406][bookmark: _Toc177550992]
Patient Category and Type of Transaction

	[bookmark: _Hlk177548158]Patient Category
	[bookmark: _Hlk177554661]The next step is to select a Patient Category. To the right of the patient SSN there are two radio buttons that correspond to the following patient categories: 

· [bookmark: _Hlk177554662]SC (service connected)
· [bookmark: _Hlk177554663]NSC (non-service connected)

[bookmark: _Hlk177554664]Click one of the Patient Category radio buttons.

[bookmark: _Hlk177554665]Shortcut: Press the <Tab> key to move focus to the Patient Category area, then use the arrow keys to select a Patient Category.

[bookmark: _Hlk177554666]For your reference, a listview to the right of the Patient Category area displays disabilities on record for the current patient. This listview displays the following three columns:

· [bookmark: _Hlk177554667]Disability
· [bookmark: _Hlk177554668]% (percentage of disability)
· [bookmark: _Hlk177554669]SC (service connected – yes or no)

[bookmark: _Hlk177554670]The SC column displays YES if the disability is service connected and NO if otherwise. 

You may sort this display by clicking any one of the column headings. 



	[bookmark: _Hlk177548159]Patient Category area
	[image: Patient Category area]



	[bookmark: _Hlk177548160]Type of Transaction
	[bookmark: _Hlk177554671]Below the Patient Category area there are two radio buttons that correspond to the following transaction types: 

· [bookmark: _Hlk177554672]New / Replace
· [bookmark: _Hlk177554673]Repair / Service 

[bookmark: _Hlk177554674]Click one of the Type of Transaction radio buttons.

Shortcut: Press the <Tab> key to move focus to the Type of Transaction area, then use the arrow keys to select a Type of Transaction.



[bookmark: _Hlk177554675][bookmark: _Toc172537407][bookmark: _Toc177550993]
Primary Item Information

	[bookmark: _Hlk177548161]Billing Item
	Enter a partial spelling of the Billing Item and click the drop-down arrow (or press the <Tab> key) to select an item beginning with the characters you entered.



	[bookmark: _Hlk177548162]HCPCS
	Enter a partial spelling of the HCPCS code or description and click the drop-down arrow (or press the <Tab> key) to select a code containing the characters that you entered.



	[bookmark: _Hlk177548163]CPT Modifier
	[bookmark: _Hlk177554678]Below the HCPCS field there are four radio buttons that correspond to the following CPT Modifiers: 

· [bookmark: _Hlk177554679]Left
· [bookmark: _Hlk177554680]Right
· [bookmark: _Hlk177554681]Both
· [bookmark: _Hlk177554682]N/A

[bookmark: _Hlk177554683]Click the applicable CPT Modifier radio button. 

Shortcut: Press the <Tab> key to move focus to the CPT Modifier area, then use the arrow keys to select a CPT Modifier.



	[bookmark: _Hlk177548165]Extended Description
	To enter a longer description of the item, click the Extended Desc. button. The OWL Extended Description window shown below displays. You can type a free-text extended description of an unlimited maximum number of characters. Click the OK button to close the window. 



	[bookmark: _Hlk177548166]Extended Description window
	[image: Extended Description window]



	[bookmark: _Hlk177548167]Unit of Issue 
	[bookmark: _Hlk177554685]The Unit of Issue is 1 by default and cannot be changed.

Note: Any field on this screen with a yellow background is for display only and cannot be modified.



	[bookmark: _Hlk177548168]Quantity
	The quantity defaults to 1 and cannot be changed.



[bookmark: _Hlk177554689][bookmark: _Toc172537408][bookmark: _Toc177550994]
Changing the Date Required

	[bookmark: _Hlk177548169]Change Date Required
	[bookmark: _Hlk177554690]Today’s date defaults into the Date Required field. To select a different date, click the Change Date Required button. 

Note: You may only select today’s date or a future date. 



	[bookmark: _Hlk177548170]Please select a new Date Required
	[image: Please select a new Date Required window]



[bookmark: _Hlk177554693][bookmark: _Toc172537409][bookmark: _Toc177550995]
Changing the Print Location

	[bookmark: _Hlk177548171]Request Receipt
	Once you submit the lab work order, a request receipt will print automatically to the printer specified in the Print Location field. 



	[bookmark: _Hlk177548172]Print Location area
	[image: Print Location area]



	[bookmark: _Hlk177548173]Change Print Location
	[bookmark: _Hlk177554697]To change the printer, click the Change Print Location button, located near the lower-left corner of the window.

The Please Select a Printer window displays.



	[bookmark: _Hlk177548174]Please Select a Printer window
	[image: Please Select a Printer window]



	[bookmark: _Hlk177548176]Select Printer Type
	[bookmark: _Hlk177554701]You may select one of the following three printer types:

· [bookmark: _Hlk177554702]A Window Printer
· [bookmark: _Hlk177554703]A VistA Printer of your choice
· [bookmark: _Hlk177554704]The Default VistA Printer
[bookmark: _Hlk177554705]Note: The default VistA printer is defined in file 669.9 PROSTHETICS SITE PARAMETER.
[bookmark: _Hlk177554706]Depending on the Lab Type you chose when the OWL was created, the VistA printer is defined in the following field:
· [bookmark: _Hlk177554707]Optical - 26 - EYE CLINIC LAB DEVICE
· [bookmark: _Hlk177554708]Orthotics/Prosthetics - 27 - ORTHOTIC LAB DEVICE
· [bookmark: _Hlk177554709]Restoration - 28 - RESTORATION CLINIC DEVICE
· Wheelchair - 30 - WHEELCHAIR REPAIR SHOP DEVICE



	[bookmark: _Hlk177548177]Windows Printer
	[bookmark: _Hlk177554710]To select a Windows printer, click the Windows Printer button in the Change Print Location area. The Windows Print dialog displays. 

Select the desired printer from the Name dropdown, then click OK.



	[bookmark: _Hlk177548178]Windows Printer selection window
	[image: Windows Printer selection window]



	[bookmark: _Hlk177548179]Default VistA Printer
	[bookmark: _Hlk177554712]To print to the Default VistA Printer, click the Default VistA Printer button, then click OK.

[bookmark: _Hlk177554713]Notes: The Default VistA Printer is the default print location, so you don’t have to do anything unless you’ve already changed the printer before. The default VistA printer is defined in file 669.9 PROSTHETICS SITE PARAMETER.

[bookmark: _Hlk177554714]Depending on the Lab Type you chose when the OWL was created, the VistA printer is defined in the following field:
· [bookmark: _Hlk177554715]Optical - 26 - EYE CLINIC LAB DEVICE
· [bookmark: _Hlk177554716]Orthotics/Prosthetics - 27 - ORTHOTIC LAB DEVICE
· [bookmark: _Hlk177554717]Restoration - 28 - RESTORATION CLINIC DEVICE
· Wheelchair - 30 - WHEELCHAIR REPAIR SHOP DEVICE



	[bookmark: _Hlk177548180]Choose a VistA Printer
	To select a particular VistA Printer, choose a from the VistA Printer dropdown list, then click OK.



	[bookmark: _Hlk177548181]VistA Printer dropdown list
	[image: VistA Printer dropdown]



	[bookmark: _Hlk177548182]Selected Printer
	After you click OK, the name of the selected printer displays in the Print Location field.



	[bookmark: _Hlk177548183]Print Location area
	[image: Print Location area]


[bookmark: _Hlk177554721][bookmark: _Toc172537410][bookmark: _Toc177550996]
Viewing Additional Information

	[bookmark: _Hlk177548184]
	[bookmark: _Hlk177554723]The lower-left corner of the Create Lab Work Order screen contains the following three buttons:

· [bookmark: _Hlk177554724]2319
· [bookmark: _Hlk177554725]CPRS
· [bookmark: _Hlk177554726]Request

These buttons, described briefly below, function just as they do on the Purchase Order Control window. For more information, see Section 1 of this manual.



	[bookmark: _Hlk177548186]2319 button
	[bookmark: _Hlk177554727]To view all eight tabs of 2319 data for a patient, click the 2319 button.

For more information, see Chapter 4 in Section 1 of this manual.



	[bookmark: _Hlk177548187]CPRS button
	[bookmark: _Hlk177554729]To view the CPRS record for a patient, click the CPRS button.

For more information, see Chapter 5 in Section 1 of this manual.



	[bookmark: _Hlk177548189]Request button
	[bookmark: _Hlk177554731]To view the request (if information is available for this patient), click the Request button.

For more information, see Chapter 6 of Section 1 of this manual.



[bookmark: _Hlk177554733][bookmark: _Toc172537411][bookmark: _Toc177550997]
Submitting the Lab Work Order

	[bookmark: _Hlk177548190]Create Lab Work Order button
	[bookmark: _Hlk177554735]To submit the Lab Work Order, click the Create Lab Work Order button, in the lower-right corner of the Create Lab Work Order window.

[image: Create Lab Work Order button]

The request receipt will print to the printer specified in the Print Location area.




[bookmark: _Toc172537412][bookmark: _Toc177550998][bookmark: _Hlk177554736][bookmark: _Toc172537413]Section 6: Orthotic Lab & Work Order
[bookmark: _Toc172537414][bookmark: _Toc177550999][bookmark: _Hlk177554738]Overview

	[bookmark: _Hlk177548191]Accessing the Orthotics Work Order and Lab window
	[bookmark: _Hlk177554740]The OWL window is accessible from two different locations: 

[bookmark: _Hlk177554741]Method 1 – Accessing OWL from the Prosthetics Main Menu

[bookmark: _Hlk177554742]At the Prosthetics Main Menu, click the Orthotic Lab & Work Order button. The OWL window displays. 

[image: Main Menu Orthotic Lab & Work Order button]

[bookmark: _Hlk177554743]Method 2 – Accessing OWL from the Purchase Control window

[image: Purchase Order Control window]

At the Purchase Order Control window, click the OWL. button. The OWL window displays.





[bookmark: _Hlk177554744]
	[bookmark: _Hlk177548192]Orthotics Work Order and Lab window
	[image: Orthotics Work Order and Lab window]



	[bookmark: _Hlk177548194]Quitting Work
	[bookmark: _Hlk177554747]If you need to stop working at any point during the workflow, click the Close button in the lower-right corner of the window. You will return to the Main Menu. 

[image: Close button icon]



[bookmark: _Hlk177554749][bookmark: _Toc172537415][bookmark: _Toc177551000]
Orthotic Lab & Work Order Window Areas

	[bookmark: _Hlk177548195]Seven Major window areas
	[bookmark: _Hlk177554750]The OWL window contains seven major areas where you can view information or enter data. These areas are described below.

· [bookmark: _Hlk177554751]Title bar
· [bookmark: _Hlk177554752]Menu bar
· [bookmark: _Hlk177554753]Work Orders listview
· [bookmark: _Hlk177554754]HCPCS area
· [bookmark: _Hlk177554755]Command Buttons
· [bookmark: _Hlk177554756]HCPCS Materials area
· HCPCS Labor area



[bookmark: _Toc172537416][bookmark: _Toc177551001][bookmark: _Hlk177554757]Title Bar

	[bookmark: _Hlk177548196]Title Bar
	[image: Title bar screenshot]

[bookmark: _Hlk177554758]The title bar runs along the top edge of the OWL window. Its default color is blue and it contains the name of the application. 

The three buttons at the far right of the title bar allow you to minimize, maximize/restore, and close the window.



[bookmark: _Hlk177554759][bookmark: _Toc172537417][bookmark: _Toc177551002]
Menu Bar

	[bookmark: _Hlk177548197]Menu Bar
	[image: Title bar screenshot]

[bookmark: _Hlk177554760]The menu bar lies below the title bar. The OWL title bar contains eight options: File, Select & Display, View, Work Order, HCPCS, Materials, Labor, and Help. Click an option on the menu bar to list all the operations you can perform from within that menu. Click the desired option to execute a specific function. 

Each menu option and its corresponding suboptions display as listed below:



	[bookmark: _Hlk177548199]File menu
	[bookmark: _Hlk177554762]The following options are available from the File menu:

· [bookmark: _Hlk177554763]Print OWL: Print the selected lab work order. 
· Exit: Save current data and close the OWL window.



	[bookmark: _Hlk177548200]Select & Display menu
	[bookmark: _Hlk177554765]The following options are available from the Select & Display menu:

· [bookmark: _Hlk177554766]Pending Assignment: Toggle Pending Assignment box checked/unchecked. Check box to display lab work orders not assigned to a tech.
· [bookmark: _Hlk177554767]Assigned: Toggle Assigned box checked/unchecked. Check box to display lab work orders assigned to a tech.
· [bookmark: _Hlk177554768]Completed: Toggle Completed box checked/unchecked. Check box to display lab work orders with a Completed status. 
· [bookmark: _Hlk177554769]Cancelled: Toggle Cancelled box checked/unchecked. Check box to display lab work orders with a Cancelled status.
· [bookmark: _Hlk177554770]Display/Refresh: Refresh the Work Orders Listview display.

For more information on using the Work Orders listview, see “Filtering the Work Orders Listview,” Filtering_the_Work_Orders_Listvlater in this chapter.



	[bookmark: _Hlk177548201]View menu
	[bookmark: _Hlk177554771]The following options are available from the View menu:

· [bookmark: _Hlk177554772]View 2319: Display 2319 information for the selected lab work order. 
· [bookmark: _Hlk177554773]View CPRS: Display CPRS information for the selected lab work order. 
· View Request: Display request information for the selected lab work order. 





	[bookmark: _Hlk177548202]Work Order menu
	[bookmark: _Hlk177554775]The following options are available from the Work Order menu: 

· [bookmark: _Hlk177554776]OWL Detail: Display lab work order detail. 
· [bookmark: _Hlk177554777]Assign Tech: Assign a technician to the selected lab work order. 
· [bookmark: _Hlk177554778]Complete OWL: Complete the selected work order. 
· [bookmark: _Hlk177554779]Cancel OWL: Cancel the selected work order. 
· Print OWL: Display the Print Lab Work Order dialog. 



	[bookmark: _Hlk177548203]HCPCS menu
	[bookmark: _Hlk177554780]The following options are available from the HCPCS menu:

· [bookmark: _Hlk177554781]Detail / Edit: Display OWL Material dialog. 
· Add HCPCS: Add secondary HCPCS items. 



	[bookmark: _Hlk177548205]Materials menu
	[bookmark: _Hlk177554782]The following options are available from the Materials menu:

· [bookmark: _Hlk177554783]Detail / Edit: View/edit the selected HCPCS materials. 
· Add Material: Add secondary HCPCS materials.



	[bookmark: _Hlk177548206]Labor menu
	[bookmark: _Hlk177554784]The following options are available from the Labor menu:

· [bookmark: _Hlk177554785]Detail / Edit: View/edit the selected HCPCS labor.
· Add Labor: Add labor hours for HCPCS item. 



	[bookmark: _Hlk177548207]Help menu
	[bookmark: _Hlk177554787]The following options are available from the Help menu:

· [bookmark: _Hlk177554788]Contents: Display this online Help file.
· About: Display Prosthetics VistA Suite version # and compilation date.



[bookmark: _Hlk177554789][bookmark: _Toc172537418][bookmark: _Toc177551003]
Work Orders Listview

	[bookmark: _Hlk177548208]Work Orders Listview
	[bookmark: _Hlk177554790]Use this area of the screen to view, filter, and sort work orders. It contains four checkboxes, a command button, a sortable listview, and a display of the total number of work orders. 

For more information, see the “Filtering Lab Work Orders” section on page 181 of this manual. 



	[bookmark: _Hlk177548209]Work Orders Listview
	[image: Work Orders listview]



[bookmark: _Hlk177554793][bookmark: _Toc172537419][bookmark: _Toc177551004]
HCPCS Area

	[bookmark: _Hlk177548210]Overview
	[bookmark: _Hlk177554795]Use this area of the screen to add, edit, and delete HCPCS items. It contains a sortable listview and two buttons. 

[bookmark: _Hlk177554796]The total number of HCPCS items and the total cost of HCPCS for the selected work order display below the listview. 

For more information, see the “Managing HCPCS Items” section on page 184 of this manual.



	[bookmark: _Hlk177548211]HCPCS Area
	[image: Screenshot of HCPCS area]



	[bookmark: _Hlk177548212]HCPCS Listview
	[bookmark: _Hlk177554798]The following list provides an overview of some of the main features of the HCPCS listview:

· [bookmark: _Hlk177554799]The number following the HCPCS for Work Order label matches the Lab Work Order (LWO) Number of the row highlighted above in the Work Orders listview.
· [bookmark: _Hlk177554800]The primary HCPCS item is indicated by a YES in the Pri column of the HCPCS listview. This HCPCS code matches the code selected when the work order was created. 
· [bookmark: _Hlk177554801]Click the Detail/Edit button to view or edit the item highlighted in the HCPCS listview. The OWL HCPCS window displays. You can edit all fields on t he OWL HCPCS window except Qty, Unit of Issue, and Total Cost. (See Editing a HCPCS Item.) 
· Click Add HCPCS to add secondary HCPCS items to the work order. (See “Adding a HCPCS Item.”)



[bookmark: _Hlk177554803][bookmark: _Toc172537420][bookmark: _Toc177551005]
Command Buttons Area

	[bookmark: _Hlk177548214]Command buttons area
	[bookmark: _Hlk177554805]A command button is a large button which, when clicked, executes a command. The Command Buttons area contains the following eight buttons:

· [bookmark: _Hlk177554806]OWL Detail
· [bookmark: _Hlk177554807]2319
· [bookmark: _Hlk177554808]CPRS
· [bookmark: _Hlk177554809]Request
· [bookmark: _Hlk177554810]Assign Tech
· [bookmark: _Hlk177554811]Complete OWL
· [bookmark: _Hlk177554812]Cancel OWL
· [bookmark: _Hlk177554813]Print OWL

[bookmark: _Hlk177554814]Their functions are described in the Workflows section starting on page 181 of this manual.. For more information, see the following sections:

· [bookmark: _Hlk177554815]Managing Lab Technicians (page 182)
· [bookmark: _Hlk177554816]Printing the OWL (page 193)
· [bookmark: _Hlk177554817]Completing the OWL (page 194)
· [bookmark: _Hlk177554818]Cancelling the OWL (page 195)
· Closing the OWL (page 196)



	[bookmark: _Hlk177548215]Command buttons
	[image: Screenshot of Command buttons]



	[bookmark: _Hlk177548216]OWL Detail button
	Click the OWL Detail button to display information about the work order currently highlighted in the Work Order listview. 





[bookmark: _Hlk177554819]
	[bookmark: _Hlk177548217]OWL Detail
	[image: OWL Lab Work Order Detail]

The information on this screen is for display only and cannot be modified from this screen.



[bookmark: _Hlk177554820][bookmark: _Toc172537421][bookmark: _Toc177551006]
HCPCS Materials Area

	[bookmark: _Hlk177548218]HCPCS Materials Area
	[bookmark: _Hlk177554821]Use this area of the screen to add, edit, and delete materials related to HCPCS items. It contains a sortable listview and two buttons. 

[bookmark: _Hlk177554822]The total number of Material Entries and the total cost of materials for the selected HCPCS item display below the listview. 

For more information, see the “HCPCS Materials” section on page 187 of this manual.



	[bookmark: _Hlk177548219]HCPCS Materials Area
	[image: HCPCS Materials Area]



[bookmark: _Toc172537422][bookmark: _Toc177551007][bookmark: _Hlk177554823]HCPCS Labor Area

	[bookmark: _Hlk177548220]HCPCS Labor Area
	[bookmark: _Hlk177554825]Use this area of the screen to add, edit, and delete labor related to HCPCS items. It contains a sortable listview and two buttons. 

[bookmark: _Hlk177554826]The total number of Labor Entries and the total cost of labor for the selected HCPCS item display below the listview. 

For more information, see the section “HCPCS Labor.”



	[bookmark: _Hlk177548221]HCPCS Labor Area
	[image: HCPCS Labor Area]



[bookmark: _Hlk177554829][bookmark: _Toc172537423][bookmark: _Toc177551008]
Workflows
[bookmark: _Toc172537424][bookmark: _Toc177551009][bookmark: _Hlk177554830]Filtering Lab Work Orders

	[bookmark: _Hlk177548223]Work Orders listview checkboxes
	Four checkboxes allow you to filter the Work Orders listview. The Pending Assignment and Assigned checkboxes are checked by default.



	[bookmark: _Hlk177548224]Work Orders listview
	[image: Work Orders listview]



	[bookmark: _Hlk177548225]Workflow
	[bookmark: _Hlk177554835]To filter the Work Orders listview, do the following:

1. [bookmark: _Hlk177554836]Check the desired boxes:

· [bookmark: _Hlk177554837]Pending Assignment: Display work orders with a Status of PENDING ASSIGNMENT (i.e., work orders with no Assigned Tech). 
· [bookmark: _Hlk177554838]Assigned: Display work orders with a Status of ASSIGNED TO TECHNICIAN.
· [bookmark: _Hlk177554839]Completed: Display work orders with a Status of COMPLETED. 
· [bookmark: _Hlk177554840]Cancelled: Display work orders with a Status of CANCELLED.

[bookmark: _Hlk177554841]The four checkboxes work in various combinations. Checking more than one checkbox displays the selected results connected by the Boolean operator OR. For example, if you check the boxes Assigned and Cancelled, then click Display/Refresh, the listview displays work orders with a Status of ASSIGNED TO TECHNICIAN or CANCELLED. 

2. [bookmark: _Hlk177554842]Click Display/Refresh.

[image: Display/Refresh button]

Notes: This listview only displays completed and cancelled work orders that were created in GUI OWL. 
Work orders created in roll & scroll will not display here.



[bookmark: _Hlk177554843][bookmark: _Toc172537425][bookmark: _Toc177551010]
Managing Lab Technicians

	[bookmark: _Hlk177548226]Assigning a Tech
	[bookmark: _Hlk177554844]To assign a technician to a work order that is pending assignment, do the following:

1. [bookmark: _Hlk177554845]Highlight a work order with a status of Pending Assignment, then click the Assign Tech command button. The Assign Technician window displays.

[image: Assign Technician window]

2. [bookmark: _Hlk177554846]Type a few characters of the tech’s name, then press <Tab> or click the down arrow button to display names drop-down list. Select a name. 
3. [bookmark: _Hlk177554847]Click Assign. The Assign Technician window closes and the Work Orders listview displays the chosen tech’s name in the Assigned Tech column.

Note: Because the listview automatically refreshes after you click Assign, the Assigned box must be checked for you to see the work order with the newly-assigned tech. If the Assigned box is not checked, the work order disappears from the listview. To see it, check the Assigned box, then click Display/Refresh.



	[bookmark: _Hlk177548228]Editing a Tech
	[bookmark: _Hlk177554848]To change the technician on a work order that already has an assigned tech, do the following:

1. [bookmark: _Hlk177554849]Highlight the work order with an Assigned Tech, then click the Assign Tech command button. A popup window displays the following confirmation message: “This Work Order has already been assigned. Do you wish to change the assignment?”
2. [bookmark: _Hlk177554850]Click Yes to close the popup. The Assign Technician window displays. 

[image: Assign Technician window]

3. [bookmark: _Hlk177554851]Type a few characters of the tech’s name, then press <Tab> or click the down arrow button to display names drop-down list. Select a new name from the drop-down list.
4. Click Assign. The Assign Technician window closes and the Work Orders listview displays the chosen tech’s name in the Assigned Tech column.



[bookmark: _Hlk177554852][bookmark: _Toc172537426][bookmark: _Toc177551011]
Managing HCPCS Items

	[bookmark: _Hlk177554855][bookmark: _Hlk177548229]Adding a HCPCS Item
	[bookmark: _Hlk177554856]To add a secondary HCPCS item, do the following:

1. [bookmark: _Hlk177554857]Click the Add HCPCS button to add an additional HCPCS item. The OWL HCPCS Add On Item window displays.

[image: OWL HCPCS Add On Item window (add)]

2. [bookmark: _Hlk177554858]Type a few characters in the Billing Item dropdown list, then press <Tab> to select a Billing Item from the dropdown list.
3. [bookmark: _Hlk177554859]Type a few characters in the HCPCS dropdown list, then press <Tab> to select a HCPCS code.
4. [bookmark: _Hlk177554860]Optionally check the Hi-Tech Item checkbox. 

[bookmark: _Hlk177554861]Note: Hi-Tech items are HCPCS that are flagged by the user to be using high technology. The list of Hi-Tech items is provided by VACO and DVG. To obtain the latest list of approved Hi-Tech items, contact the Prosthetics and Clinical Logistics Office (10FP).

5. [bookmark: _Hlk177554862]Select the appropriate CPT Modifier radio button. This is required. 
6. [bookmark: _Hlk177554863]Optionally enter a brief description in the Brief Desc field. 
7. [bookmark: _Hlk177554864]The Qty field defaults to 1 and cannot be modified.
8. [bookmark: _Hlk177554865]The Unit of Issue defaults to EA (each) and cannot be edited. 
9. [bookmark: _Hlk177554866]The Total cost defaults and cannot be edited.
10. [bookmark: _Hlk177554867]Optionally enter a Serial Number. 
11. [bookmark: _Hlk177554868]Optionally type or paste text into the Extended Description field. 
12. Click the Quit button to close the Add On Item window without saving changes, or click Add. After you click Add, the Add On Item window closes and the HCPCS item is added to the HCPCS listview.





	[bookmark: _Hlk177548230]Editing a HCPCS Item
	[bookmark: _Hlk177554869]To edit a HCPCS item, do the following:

1. [bookmark: _Hlk177554870]Highlight the row of the HCPCS item to be edited, then click Detail/Edit. The OWL HCPCS window displays. 

[image: OWL HCPCS Add On Item window (edit)]

2. [bookmark: _Hlk177554871]You can edit the data in all fields except for the following three:

· [bookmark: _Hlk177554872]Qty
· [bookmark: _Hlk177554873]Unit of Issue
· [bookmark: _Hlk177554874]Total Cost

3. [bookmark: _Hlk177554875]To finish the workflow, click one of the following buttons:

· [bookmark: _Hlk177554876]Click Update to save all changes and close the OWL HCPCS window. 
· [bookmark: _Hlk177554877]Click Quit to discard changes and close the OWL HCPCS window. 
· [bookmark: _Hlk177554878]Click Delete to remove this HCPCS item from the work order. 

Note: The Delete button is disabled for the Primary HCPCS item, which can be edited but not deleted.





[bookmark: _Hlk177554879]
	[bookmark: _Hlk177548231]Deleting a HCPCS Item
	[bookmark: _Hlk177554880]To delete a HCPCS item from the work order, do the following:

1. [bookmark: _Hlk177554881]Highlight the HCPCS item in the HCPCS listview on the OWL window, then click Detail/Edit. The Add On Item window displays. 

[bookmark: _Hlk177554882]Note: The Delete button is disabled for Primary HCPCS items. You may only delete Add-On HCPCS items this way. 

[image: OWL HCPCS Add On Item window (delete)]

2. [bookmark: _Hlk177554883]Click Delete. A popup window asked you to confirm the deletion.
3. Click Yes. The HCPCS item is removed from the HCPCS listview.



[bookmark: _Hlk177554884][bookmark: _Toc172537427][bookmark: _Toc177551012]
HCPCS Materials

	[bookmark: _Hlk177548233]Adding Materials for a HCPCS Item
	[bookmark: _Hlk177554885]To add materials for a HCPCS item, do the following:

1. [bookmark: _Hlk177554886]Highlight an item in the HCPCS listview. 
2. [bookmark: _Hlk177554887]Click the Add Material button. The OWL Material window displays.

[image: OWL Material window (add)]

3. [bookmark: _Hlk177554888]Type a few letters in the Material field, then press <Tab> and select a material from the drop-down list. Examples: Velcro, plaster, rivets, leather.

[bookmark: _Hlk177554889]Note: The material must be loaded in the local item file or it won’t display in the drop-down list.

4. [bookmark: _Hlk177554890]Enter a quantity in the Qty field.
5. [bookmark: _Hlk177554891]Specify a Unit of Issue.
6. [bookmark: _Hlk177554892]Enter a Cost.
7. [bookmark: _Hlk177554893]Optionally enter a Serial Number. 
8. [bookmark: _Hlk177554894]Optionally select a Vendor. 
9. [bookmark: _Hlk177554895]Optionally enter Remarks. 
10. Click Add. The OWL Materials window closes and the material is added to the Materials listview. Any cost is added to the Cost field.





[bookmark: _Hlk177554896]
	[bookmark: _Hlk177548234]Updating Materials for a HCPCS Item
	[bookmark: _Hlk177554897]To edit materials for a HCPCS item, do the following:

1. [bookmark: _Hlk177554898]Highlight a row in the Materials listview, then click Detail/Edit. The OWL Material window displays. 

[image: OWL Material window (edit)]

2. [bookmark: _Hlk177554899]You can edit the data in any field on this window. 
3. [bookmark: _Hlk177554900]To finish the workflow, click one of the following buttons:
4. [bookmark: _Hlk177554901]Click Update to save all changes and close the OWL Material window. 
5. [bookmark: _Hlk177554902]Click Quit to discard changes and return to the OWL window. 
6. Click Delete to remove this material from the HCPCS item. 





[bookmark: _Hlk177554903]
	[bookmark: _Hlk177548235]Deleting Materials for a HCPCS Item
	[bookmark: _Hlk177554904]To delete material from a HCPCS item, do the following:

1. [bookmark: _Hlk177554905]Highlight a row in the Materials listview, then click Detail/Edit. The OWL Material window displays.

[image: OWL Material window (delete)]

2. [bookmark: _Hlk177554906]Click Delete. A confirmation pop-up window displays. 
3. Click Yes to delete the material. The OWL Material window closes and the material is removed from the listview.



[bookmark: _Hlk177554907][bookmark: _Toc172537428][bookmark: _Toc177551013]
HCPCS Labor

	[bookmark: _Hlk177548236]Adding labor
	[bookmark: _Hlk177554908]To add labor costs to a HCPCS item, do the following:

1. [bookmark: _Hlk177554909]Highlight an item from the HCPCS listview, then click Add Labor. The OWL Labor window displays.

[image: OWL Labor window (add)]

2. [bookmark: _Hlk177554910]Type the first few letters of a tech’s last name, press <Tab>, then select a technician from the drop-down list.

[bookmark: _Hlk177554911]Note: If only one tech name matches the letters you entered, that name is selected as soon as you press <Tab>, and your cursor focus moves to the Date field. 

3. [bookmark: _Hlk177554912]Optionally change the Date. 
4. [bookmark: _Hlk177554913]Enter the number of Hours.
5. [bookmark: _Hlk177554914]Enter the hourly Rate.
6. Click Add. The labor displays in the Labor for HCPCS listview and the labor cost is added to the Cost field.





[bookmark: _Hlk177554915]
	[bookmark: _Hlk177548237]Editing Labor
	[bookmark: _Hlk177554916]To edit labor costs for a HCPCS item, do the following:

1. [bookmark: _Hlk177554917]Highlight a row in the Labor listview, then click Detail/Edit. The OWL Labor window displays.

[image: OWL Labor window (edit)]

2. [bookmark: _Hlk177554918]Edit the information as desired. 

[bookmark: _Hlk177554919]Note: Once a technician has been added, you cannot change the tech the next time you return to edit HCPCS labor. To change the technician on HCPCS labor, you must delete the labor and add it back with the correct tech. 

3. Click Update. The OWL Labor window closes and changes are saved.





	[bookmark: _Hlk177548239]Deleting Labor
	[bookmark: _Hlk177554920]To delete labor costs for a HCPCS item, do the following:

1. [bookmark: _Hlk177554921]Highlight a row in the Labor listview, then click Detail/Edit. The OWL Labor window displays.

[image: OWL Labor window (delete)]

2. [bookmark: _Hlk177554922]Click Delete. A confirmation pop-up window displays. 
3. Click Yes to delete the labor. The OWL Labor window closes and the labor is removed from the listview.



[bookmark: _Hlk177554923][bookmark: _Toc172537429][bookmark: _Toc177551014]
Printing the OWL

	[bookmark: _Hlk177548240]Printing a Request Receipt
	[bookmark: _Hlk177554924]To print a lab work order, do the following:

1. [bookmark: _Hlk177554925]Highlight the desired lab work order in the Work Orders listview.
2. [bookmark: _Hlk177554926]Click the Print OWL button. The OWL Print Lab Work Order window displays. 

[image: OWL Print Lab Work Order window]

3. [bookmark: _Hlk177554927]The OWL will print on the printer listed in the Current Print Location field. To print to the default printer, skip to step 5. To change printers, continue with step 4. 
4. [bookmark: _Hlk177554928]This window provides three printer options: 

· [bookmark: _Hlk177554929]To select a Windows Printer, click the Windows Printer button. Select a printer from the Name drop-down list, then click OK. Proceed to step 5.
· [bookmark: _Hlk177554930]To select a VistA Printer other than the default, select a printer from the VistA Printer drop-down list. Proceed to step 5.
· [bookmark: _Hlk177554931]To select the default VistA Printer, click the Default VistA Printer button. Proceed to step 5.
Note: The default VistA printer is defined in file 669.9 PROSTHETICS SITE PARAMETER.
[bookmark: _Hlk177554932]Depending on the Lab Type you chose when the OWL was created, the VistA printer is defined in the following field:
· [bookmark: _Hlk177554933]Optical - 26 - EYE CLINIC LAB DEVICE
· [bookmark: _Hlk177554934]Orthotics/Prosthetics - 27 - ORTHOTIC LAB DEVICE
· [bookmark: _Hlk177554935]Restoration - 28 - RESTORATION CLINIC DEVICE
· [bookmark: _Hlk177554936]Wheelchair - 30 - WHEELCHAIR REPAIR SHOP DEVICE

5. Click Print Lab Work Order. The work order prints and the OWL Print Lab Work Order window closes.


[bookmark: _Hlk177554937][bookmark: _Toc172537430][bookmark: _Toc177551015]
Completing the OWL

	[bookmark: _Hlk177554938][bookmark: _Hlk177548241]Completing the OWL
	[bookmark: _Hlk177554939]To complete the OWL, do the following:

1. [bookmark: _Hlk177554940]Highlight the desired lab work order in the Work Orders listview. 
2. [bookmark: _Hlk177554941]Click the Complete OWL button. The OWL Complete window displays. This window displays the lab work order number, patient name, and patient SSN. It also informs you of the following three things:

· [bookmark: _Hlk177554942]You are about to COMPLETE this work order.
· [bookmark: _Hlk177554943]You are about to CLOSE the original consult.
· [bookmark: _Hlk177554944]This will prevent any further OWL activities or purchasing for this work order. 

[image: OWL Complete window]

3. [bookmark: _Hlk177554945]Optionally enter text in the Post note to CPRS field. 
4. [bookmark: _Hlk177554946]Click the Complete button to complete the work order and close the original consult. A Confirm window displays. 
5. [bookmark: _Hlk177554947]Click Yes to complete this work order. A Prosthetics VistA Suite window pops up to display the following information: 

· [bookmark: _Hlk177554948]Completed Suspense Action. 
· [bookmark: _Hlk177554949]Posted note to CPRS Consult. 
· [bookmark: _Hlk177554950]Suspense status has been updated to CLOSED.

6. Click OK to close the Prosthetics VistA Suite window.



[bookmark: _Hlk177554951][bookmark: _Toc172537431][bookmark: _Toc177551016]
Cancelling the OWL

	[bookmark: _Hlk177548242]Cancelling the OWL
	[bookmark: _Hlk177554952]To cancel an OWL lab work order, do the following:

1. [bookmark: _Hlk177554953]Highlight the desired lab work order in the Work Orders listview.
2. [bookmark: _Hlk177554954]Click the Cancel OWL button. The OWL Cancel window displays. (See image at the top of the next page.) This window displays the lab work order number, patient name, and patient SSN. It also informs you of the following three things:

· [bookmark: _Hlk177554955]You are about to CANCEL this work order.
· [bookmark: _Hlk177554956]You are about to CLOSE the original consult.
· [bookmark: _Hlk177554957]This will prevent any further OWL activities or purchasing for this work order.

3. [bookmark: _Hlk177554958]Optionally enter text in the Please enter a CPRS note about this cancellation field (such as a reason for the cancellation). 
4. [bookmark: _Hlk177554959]To create a clone of this consult, check the box following the question Do you wish to create a CLONE of this consult for future use? 
Note: You may wish to clone a consult in the event that you need to make another purchase on the closed consult. 
5. [bookmark: _Hlk177554960]Click the Cancel Work Order button. A confirmation window pops up to display the question Are you sure you wish to CANCEL this Work Order?
6. [bookmark: _Hlk177554961]Click Yes to cancel the work order. A Prosthetics VistA Suite window pops up to display the following information: 

· [bookmark: _Hlk177554962]Complete Suspense Action.
· [bookmark: _Hlk177554963]Posted note to CPRS Consult.
· [bookmark: _Hlk177554964]Suspense status has been updated to CANCELLED.

7. Click OK to close the Prosthetics VistA Suite window.



	[bookmark: _Hlk177548244]OWL Cancel window
	[image: OWL Cancel window]



[bookmark: _Toc172537432][bookmark: _Toc177551017][bookmark: _Hlk177554965]Closing the OWL

	[bookmark: _Hlk177548245]Closing the OWL
	[bookmark: _Hlk177554966]To exit the OWL window, click the Close button in the lower-right corner of the window. The OWL window closes and you return to the Prosthetics Main Menu. 

[image: Close button icon]



[bookmark: _Toc172537433]

[bookmark: _Toc177551018][bookmark: _Hlk177554967]Appendix A
[bookmark: _Toc89754798][bookmark: _Toc172537434][bookmark: _Toc177551019][bookmark: _Hlk177554968]Getting Help

	[bookmark: _Hlk177548246]F1 Key
	[bookmark: _Hlk177554969]Online Help can be accessed in three methods: 

1. [bookmark: _Hlk177554970]Click the Help Menu (located in the upper left corner of the menu bar) and the Contents option.
2. [bookmark: _Hlk177554971]Press the <F1> key.
3. Press the <Alt> key + <H> key. (This activates the Help Menu, not the Billing contents.)



	[bookmark: _Hlk177548247]Help Menu
	[image: Screenshot of help menu]




[bookmark: _Toc172537435][bookmark: _Toc44299392][bookmark: _Toc89754799][bookmark: _Toc24938082]

[bookmark: _Toc177551020][bookmark: _Hlk177554972]Appendix B
[bookmark: _Toc172537436][bookmark: _Toc177551021][bookmark: _Hlk177554973]Using the Menus

	[bookmark: _Hlk177548248]Menus
	[bookmark: _Hlk177554974]Below are the different menus and menu options that are available to be used instead of the corresponding buttons. You can use these menu options alternatively. 

The Help Menu is the only menu that does not have a corresponding button. This menu leads you to online help through the Contents option. The Section 508 option is described more in Appendix B. 



	[bookmark: _Hlk177548249]File Menu
	[image: Screenshot of File menu options]



	[bookmark: _Hlk177548250]Select and Display Menu
	[image: Screenshot of Select and Display menu options]



	[bookmark: _Hlk177548252]View Menu
	[image: Screenshot of View menu options]



	[bookmark: _Hlk177548253]Help Menu
	[image: Screenshot of Help menu options]



[bookmark: _Toc172537437][bookmark: _Toc177551022][bookmark: _Hlk177554987]Appendix C
[bookmark: _Toc89754800][bookmark: _Toc172537438][bookmark: _Toc177551023][bookmark: _Hlk177554988]Activate Section 508 Assistance

	[bookmark: _Hlk177548254]Introduction
	[bookmark: _Hlk177554989]You can change the colors of the screen to black/white, which is required for Section 508 requirements to be read by visually and hearing impaired veterans. 

This feature can be updated from the Help Menu. It provides a toggle to go back and forth between using the colors or the black/white screens depending on your needs.



	[bookmark: _Hlk177548255]Steps 
	To activate the Section 508 assistance, follow these steps:



	[bookmark: _Hlk177554992][bookmark: _Hlk177548256]Step
	Action

	[bookmark: _Hlk177554993]1
	[bookmark: _Hlk177554994]Click the Help Menu, and click the Section 508 option. 
[image: Screenshot of Help menu options]

Shortcut: Press the <Ctrl> key + <S> key.

	[bookmark: _Hlk177554995]2
	Click OK on the confirmation message dialog box as shown below.

	[bookmark: _Hlk177554996]3
	Click OK again to exit out of the system and restart to activate the changes.



	[bookmark: _Hlk177548260]Confirmation message
	[image: Screenshot of Confirmation message]
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B _|LOMA LIN 7/24/2008 | 25293 | SHNIXRU UXKHUS B66-07-4534 223035 E0243 PAD WATER CIRCULS00 K BUSTAMANTE
7 |LOMA LIN 8/3/2005 | 25293 DLQDTXYHAB  666-11-5402 223036 C5280%  INLAY DBL URETERA560 B NELSON,KEN
8 |LOMA LIN 8/3/2008 | 25293 WHYYHLR PLUUHY B66-17-2323 223037 L7366 BATTERY CHRGR 12300 D NELSON,KEN
9 |LOMA LIN 8/3/2008 | 25293 WLAADT CLZHT L B66-21-1225 223038 AdET2 RIB BELT 400 G NELSON,KEN
10 |LOMA LIN  8/3/2008 | 25293 BHYSXY LUSERU X666-03-3804 223039 D096 WHEEL ASSEM POV 100 D PROSTEST US
11 |LOMA LIN 8/10/2008 | WVISA  SXADTHUDJ | BBB-16-3736 223040 WHEELCH KDOS1 WHEEL LOCK ASSEI100 D BUSTAMANTE
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Please enter a range of dates to display

Select custom data ?

Youare logged onto Lomalinda.

Beginning Date: |[IEVIDETTHE

Enain D ETRNE]

T - R - [ Soicpiny

SHAAHL 666-12-£22314
BHUYIS, 666-22-122314
GUDHFY 66-11-C22314
GUDHFY 66-11-622314
BHUYIS, 666-22-122315

SDHALWIF 666-03-£22315
DHALVIF 666-03-£22315
GLULDT,66-10-222314
VHYYHLE 666-17-222314
XASH 666-05-222314
TEXZWT 666-15-422314
BLLIYHS: 666-03-£22314

WICHI6/12]2007 1
Lowa (7(2/2007 1
Lowa I6f1972007 1

2529-2NDHS¥,L666-11-322314

2525-2GUDHFY 66-11-622315

VISA _ GRDAGK 666-08-£2231 SERIEF L3380 SHOE CLUEY

L3010 FOOT LONGRS0 C PROS"JLIN 06,
L3010 FOOT LONG 500 A PROS"JLN 06
LS331#HIP DISART 200 G PROS"JLIN 06
DL10Z LACELOCK 500K PROS"JLN 06
DL10Z LACELOCK 500K PROS"JLN 06
L3380 SHOE LU PROSIN 23
DLI0Z LACELOCK 500K PROS'

K003 WHEELLOC 100D PROS"OCT 11
KO031 WHEEL LOC 100D PROS"JLN 05
LS331#HIP DISART 200 G PROS"JLN 06,
L3060 FOOT ARCHRS0 C PROSHOY 2
L3010 FOOT LONGRS0 C PROSJLN 04

51100 D PR

K0096 WHEEL ASSI 100D PROS"APR 21
PROS

LS311#KNEE DISAR200 G MART.JLN 19

Does not include SHIPPING CHARGES or HISTORICAL RECORDS

@ Horu

99a4785
9984785
9984787
99848790
99848791
soa4792
osa4793

99848942
Lot INVACARE984874
1 9984736

Sa9A7-07-3-1
Sa3A7-07-3-411]
Sa3A7-07-3-41]
Sa3A7-07-3-411]
S83A7-07-3-411]

605.07-3.0-
60507300

605.07-3:0-0

Total Records Found : 1
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PENDING 0sjoBf2001 08f22/2001 1 DESCRIPTION OF APPLIAN
PENDING MANUAL 0812912001 091912001 3 TESTINGRCE BoF 1
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